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This manual was written for use with the Eudora Prom software version 3.0.3. This manual and the Eudora Pro

software described in it are copyrighted, with all rights reserved. This manual and the Eudora Pro software may
not be copied, except as otherwise provided in your software license or as expressly permitted in writing by
QUALCOMM Incorporated.

The Eudora Software was written by Jeff Beckley, Adobe®, Acrobat®, and Acrobat Reader® are
Julia Blumin, Craig Lauer, Keith McIntyre, registered trademarks of Adobe Systems
Ben Ogdon, Christina Sahhar, Willie Sakai, and Incorporated.

Marwan Sinno. Copyright © 1992-1997 by . . .
QUALCOMM Incorporated. All rights reserved. McAfee Assocrates, Inc® and VrrusScan® are

p . registered trademarks of McAfee Associates, Inc.
The Stuth Engine components are Copyright ©

1990-97 Aladdin Systems, Inc. PGP® and Pretty Good® are registered trademarks
and Pretty Good PrivacyTM is a trademark of PGP,
Inc. Questions regarding the use and functionality of
this PGP software program should be directed to

Eudora® is a registered trademark 0f QUALCOMM QUALCOMM Incorporated. This PGP product is not

Windows® is a registered trademark of Microsoft
Corporation

Incorporated. eligible for support from Pretty Good Privacy, Inc.

ncorporated.
QUALCOMM® is a registered trademark and . .
registered service mark of QUALCOMM Stufflt® 1s a registered trademark and Stufflt
Incorporated. EngrneTM, AladdrnTM, and Aladdin Systems, Inc.TM

t d k f Al ddi S t I .
The Sentry Spelling-Checker Engine is copyright are ra ernar so a n ys ems, nc
© I993 by Wintertree Software Inc. All other trademarks and service marks are the

property of their respective owners.

Use of the Eudora software and other software and fonts accompanying your license (the "Software") and its
documentation are governed by the terms set forth in your license. Such use is at your sole risk. The Software
and its documentation (including this manual), and QUALCOMM's software maintenance and extended
maintenance, if applicable, are provided "AS IS" and without warranty of any kind and QUALCOMM
EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A

PARTICULAR PURPOSE AND AGAINST INFRINGEMENT. QUALCOMM DOES NOT WARRANT
THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS, OR
THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR

THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. FURTHERMORE, QUALCOMM DOES
NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF

THE USE OF THE SOFTWARE OR ITS DOCUMENTATION IN TERMS OF THEIR CORRECTNESS,
ACCURACY, RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR ADVICE

GIVEN BY QUALCOMM OR A QUALCOMM AUTHORIZED REPRESENTATIVE SHALL CREATE A
WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. SOME

JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE
EXCLUSION MAY NOT APPLY.

MS 266773

THIS DOCUMENT IS CONFIDENTIAL AND FILED UNDER SEAL

AREND|315569



THIS DOCUMENT IS CONFIDENTIAL AND FILED UNDER SEAL 

Case 1:13-cv-00919-LPS   Document 312-1   Filed 03/10/21   Page 4 of 199 PageID #: 29617Case 1:13-cv-OO919-LPS Document 312-1 Filed 03/10/21 Page 4 of 199 PageID #: 29617

UNDER NO CIRCUMSTANCES INCLUDING NEGLIGENCE, SHALL QUALCOMlVI, ITS LICENSORS
OR THEIR DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE FOR ANY INCIDENTAL,

SPECIAL OR CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS,
LOSS OF PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION AND THE

LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE OR ITS
DOCUMENTATION, EVEN IF QUALCOIVHVI OR A QUALCOMM AUTHORIZED REPRESENTATIVE
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOD/[E JURISDICTIONS DO NOT

ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL
DAMAGES SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY.

In no event shall QUALCOMMS total liability to you for all damages, losses, and causes of action (whether in
contract, tort, including negligence, or otherwise) exceed the amount paid for the Software and its
documentation.
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About the Name

Why the name “Eudora”?

When looking for a name for this new Post Office Protocol mail program,
we thought immediately of the title of the short story “Why I Live at the PO,”
and named the program after the author of the story, Eudora Welty.

“Why I Live at the PO.” can be found in a collection titledA Curtain of
Green (Harcourt Brace Jovanovich). Ms. Welty’s stories are funny, sad, and
fascinating; she’s surely one of the great American writers.

June 1997
80-47885—1
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Getting Started

System Requirements

To use the Eudora Pro electronic mail (e-mail) application (hereafter referred to as
Eudora), you must have the following:

IBM PC or compatible.

Microsoft Windows 3.1 for 16-bit version; Microsoft Windows 95 or Windows
NT 3.51 or later for 32-bit version.

Winsock 1.1 API compliant networking package (not needed for serial
connection),

A mail account with an Internet Service Provider or an Internet-style network.

Access to your mail account via a modem (9600 bps or higher recommended)
or Internet-style network connection.

Installing Eudora

Installing Eudora is simple, and requires very little input—just follow the
instructions below. If you are installing over a previous version of Eudora Pro or
Eudora Light, all of your messages, mailboxes, folders, and options will be
maintained.

To install Eudora, do the following:

1.

QUALCOMM Incorporated

Exit any applications you are running including toolbars, memory
management programs, screen savers, and v1rus protection programs.

If you are installing from CD-ROM, insert the CD-RM into the drive and
double-click on its icon. Then, double-click on Setup.exe.

If you are installing the Eudora Pro and Eudora Productivity ToolkitTM
bundle, the Eudora Installer screen is displayed. Click on the Eudora Pro icon
to continue. The Eudora Pro Welcome screen is then displayed.

If you are Eudora Pro and do not have the Eudora Productivity Toolkit, the
Eudora Installer screen is not displayed, and the Eudora Pro Welcome screen
is the first screen displayed.

THIS DOCUMENT IS CONFIDENTIAL AND FILED UNDER SEAL

13

MS 266784

AREND|315580



THIS DOCUMENT IS CONFIDENTIAL AND FILED UNDER SEAL 

Case 1:13-cv-00919-LPS   Document 312-1   Filed 03/10/21   Page 15 of 199 PageID #: 29628Case 1:13-cv-OO919-LPS Document 312-1 Filed 03/10/21 Page 15 of 199 PageID #: 29628

Getting Started Eudora User Manual

 
The Eudora Installer screen

4. Read the Welcome screen, then click Next. The Software License Agreement
is displayed.

5. Read the Software License Agreement and click Yes.

6. Enter your User Code, then click Next.

Your User Code is printed on the inside cover of this manual, or, if you are
part of a multi-user site, it should be provided to you by your company’s
e-mail administrator. If you purchased Eudora by electronic distribution, the
User Code is in the message you received when you purchased the product.

7. Specify a directory to install Eudora Pro, then click Next.

1 4 QUALCOMM Incorporated
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Note: lfyou are installing Eudora over your current version of
Eudora Pro or Eudora Light, select your current Eudora
directory. Ifyou are installing Eudorafor the first time, you
can select any directory you want.

8. Select the version of the software that you want to install, 16- or 32—bit.

Based on the operating system and connectivity software that you are
running, the Setup program recommends an appropriate version The 32-bit
software can be used with the 32-bit operating systems Windows 95 or
Windows NT 3.5 or later, but it also requires 32-bit connectivity software. If
you are using a 32-bit operating system but the Setup program recommends
the 16-bit version, it is probably because your connectivity software is 16-bit.

9. Verify that the displayed settings are correct, then click Next (or use the Back
button if you need to go back and make changes).

10. If you are installing from diskette, you are prompted to insert the additional
diskettes into drive A.

ll. Eudora is installed in the destination directory, and you are prompted for
whether or not you want to view the README file. Click Yes.

Uninstalling Eudora

You can uninstall Eudora by using the tools provided with your Windows
operating system. In Windows 95 or Windows NT 4.0, open the control panel,
double-click on Add/Remove Programs, select Eudora Pro, and click Remove.
In Windows 3.l or Windows NT 3.5.1, open the Eudora Pro program group from
within the Program Manager, then double-click on the Uninstall Eudora icon.

Opening and Configuring Eudora

After you have installed Eudora, double-click on its icon to open it. If you are
installing Eudora for the first time, the Getting Started Options are displayed.

To send and receive messages, you must have an account on a computer running a
PCP (Post Office Protocol) server, and access to a computer running an SMTP
(Simple Mail Transfer Protocol) server. Your incoming e-mail messages are
delivered to your PCP account, where Eudora picks them up and transfers them to
your PC. Your outgoing messages are sent to the SMTP server, which delivers
them to your recipients.

You have to provide basic information about your account, servers, and network
connection before you can send and rece1ve messages. To do this, use the Getting

QUALCOMM Incorporated 1 5
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Started Options (if this is not open, select Options... from the Tools menu and
click on the Getting Started category).

5 ending Mail

4

  
An example of Getting Started Options

In the POP account field, type your POP account name, an “@” sign, and the full
name of the computer. For example, if your assigned POP account name is
“j correa,” and the name of the computer where you receive e—mail is

“pop3.qualcomm.com” type “j correa@pop3.qualcommcom” in this field.

In the Real name field, type your real name. It is included in the From field of
your outgoing messages.

Your POP account may or may not be the same as your return address, which is
the address at which you normally receive e-mail. If your e—mail address is
different than your pop account, put the address in the Return Address field.

Specify a connection method. If you are using Eudora Via TCP/IP software (eg, a
direct network connection, SLIP, or PPP), select Winsock. If you are using
Eudora Via a Unix shell account, select Dialup. Most users will select Winsock.

1 6 QUALCOMM Incorporated
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If your POP and SMTP servers are on the same computer, you do not need to
specify an SMTP server. If they are not on the same computer, click on the Hosts
category and enter in the SMTP field the full name of the computer running the
SMTP server.

You are now ready to go. For detailed explanations of all of Eudora’s available
functions, see the appropriate chapters.

Quitting Eudora

To quit Eudora, select Exit from the File menu. If you have queued messages, or
timed messages due to be sent in the next 12 hours, you are given the option to
send them (see the section “Quitting with Queued Messages”).

The Trash mailbox is emptied if the Empty Trash when exiting option is on in
the Miscellaneous Options.

Online Help

There are several ways to get online Help with Eudora:

. To find out What something in the user interface does, use either Context
Sensitive Help from the Help menu, or the Help button on the toolbar, and
click on the item you want to know about. A brief description of the item is
displayed.

. The F1 key also displays context-sensitive Help. Select the user interface item
you want to know about, then press F1.

. For instructions on how to do certain tasks, select Help Topics from the Help
menu. The Help Contents are displayed, and you either browse the contents or use
the Find and Index options.
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Registering Your Copy of Eudora

Depending on the software license you have for Eudora, you may be eligible for
technical support directly from the Eudora Technical Support group. To receive
technical support, you must register your copy of Eudora Pro in accordance with
the terms defined in your license Agreement. If you have a previous version of
Eudora Pro, you need to register this new version.

Note: Ifyou are part ofa site license, you do not need to register.
Contact your organization’s e-mail administratorfor support.

If you are eligible for technical support, you are prompted to register after you
send the first message with your new version of Eudora Pro. Complete the
registration form and click Register. The registration is put in the queue in your
Out mailbox and is sent the next time you send queued messages.

If you don’t want to register at that time, you can choose Not Now to be prompted
7 days later, or Never Register to never be prompted again. At any time, you can
choose Register Eudora... from the Help menu to display the registration form.

Technical Support

If, after reviewing all of the available materials, you are still in need of assistance,
contact your e-mail administrator (your Internet service provider or your
company’s Eudora support coordinator) or the Eudora Technical Support group. If
you are eligible for technical support, the contact information is provided in the
More Help! On-line Help topic, and on the inside cover of this manual.

You must register your copy of Eudora Pro to receive technical support. See the
section “Registering Your Copy of Eudora” for details.
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Creating an Outgoing Message

An outgoing message is a message you send to someone else. The simplest way to
create an outgoing message is to select New Message from the Message menu. A
new message Window is displayed, referred to as the Composition Window.

Using the Composition Window

The composition Window consists of the title bar, the Toolbar} the message
header, and the message body.
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The composition window
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Title Bar

The Title bar provides information about the message, including the name of the
addressee, the time and date the message was sent, and the message subject.

Toolbar

The toolbar consists of a series of buttons and popups that are displayed just under
the title bar. It allows you to control the priority of your message, override some
of your default options for the current message, send or queue the message, and
apply text styles (in the 32-bit version only). Each button can be turned on or off
for the current message by clicking on it (a button is on when it is depressed, and
off when it is raised). You can set some of the defaults for the toolbar in the
Sending Mail Options.

The popup menus and buttons are described below.

Priority Popup

This lets you indicate that your message is of higher or lower priority than a
normal message. For most messages, this is just an empty box (normal priority).
For details, see the section “Setting the Message Priority.”

 

Signature Popup

This lets you automatically append one of your signatures to the end of a
message. For details, see the section “Using a Signature in an Outgoing
Message.”

 

 

 
NINE

Attachment Type Popup . _
- This lets you select the encoding format for attachments. For details, see the

section “Attaching a File to a Message.”

Quoted-Printable Encoding . . -
3 If this is on, quoted-pnntable encoding is used when sending messages that

contain long lines of text or special characters. It is used for all plain text
attachments. It is recommended that this always be on.

 

 

 

Text‘As Document _ .
5 If this is on, plain text files are attached to messages, not incorporated into the

message as part of the message body.

.wOrsiWrap . . . .
3 If this is on, a carriage return is not required at the end of each line. When the

message is sent, the text is automatically “wrapped,” meaning that carriage
returns are inserted at the end of each line of text, with roughly 76 characters per
line.
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‘ " Tabs in Body

If this button is on, pressing the tab key within the message body inserts a tab. If
this button is off, pressing the tab key within the message body returns the
cursor to the To field of the message header.

 

Keep 90W . . .
If this is on, a copy of each sent message 1s kept 1n the Out mailbox. These
messages are saved there until they are deleted or transferred.

 

Return Receipt . . .
‘ If this is on, the message to your rec1p1ents 1ncludes a Notify Sender button that

when clicked creates a message notifying you that the original message was
Viewed. This function does not work in all cases. For details, see the section

“Requesting a Return Receipt.”

 

Send or Queue . . . .
These let you send a message 1mmed1ately or put 1t 1n the queue to send later. If
the Immediate Send option in the Sending Mail Options is on, the button is
labeled Send. If the option is off, the button is labeled Queue. For details, see the
section “Sending or Queueing a Message.”

 

 

The following text formatting buttons are only available in the 32-bit version of
Eudora.

Bold

Make the selected text bold.

Italics . .
Make the selected text itallc.

Underline .
Make the selected text underllned.

Font

Make the selected text the selected font, size, and color.

Align Left

3 Make the selected paragraph aligned to the left of the indent.
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4 Align Center
Make the selected paragraph aligned to the center of the indent.

‘ Align Right
Make the selected paragraph aligned to the right of the indent.

” Smaller

Make the selected text one standard point size smaller.

‘ Bigger
Make the selected text one standard point size bigger.

lndent In

Make the selected paragraph indented once to the left.

lndent Out .
Remove one left 1ndent for the selected paragraph.

Hang lndent In

Outdent the first line of the selected paragraph.

 
Hang lndent Out .
Remove the outdent from the first 11ne of the selected paragraph.

Clear

Removes all the formatting from the selected text or paragraph.
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Message Header

Outgoing mail headers consist of the following fields: To, From, Subject, Cc,
Bee, and Attachments. Each field is described below. The To, Subject, Cc, and
Bcc fields can be directly edited. To move the cursor from field to field, press the
tab key or click in the desired field with the mouse.

To resize the Header region of the outgoing message window, drag the separator
up or down.

To

The intended recipients’ e-mail addresses, or nicknames you have defined (see the
section “Using the Address Book and Quick Recipient List”). Multiple addresses
and nicknames must be separated by commas.

From

The sender’s e-mail address. This is usually your POP account plus your real
name. You can use a return address other than your POP account by entering the
address in the Return address field of the Personal Info Options.

Subject

Some brief text indicating the contents of the message. This field can be left blank
(though it is a breach of e-mail etiquette to do so).

Cc

The e—mail addresses or nicknames of people to whom a copy of the message is to
be sent. These recipients are displayed in the message header for all recipients to
see. Multiple addresses must be separated by commas. This field can be left
blank.

Bee

The e—mail addresses or nicknames of people to whom a copy of the message is to
be sent. These recipients are not displayed in the message header, and the
recipients in the T0 or Cc fields will not know that a copy went to these
addresses. Multiple addresses must be separated by commas. This field can be left
blank.

This field can also be used to put a copy of the message in one of your mailboxes.
To do this, right click in the body of the message and select the mailbox from the
Fcc menu. The name of the mailbox is inserted into the Bcc field preceded by an
“f,” and when the message is sent, a copy is put in that mailbox.
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Attachments

A list of documents being attached to and sent along with the message. You must
use one of the attachment options to add attachments (see the section “Attaching a
File to a Message”). To delete an attachment from an outgoing message, select it
and press the delete key. This field can be left blank.

Message Body

After filling in the header fields, move the insertion point to the space below the
message header. Type the body of the message here. For information about
formatting your message text, see the section “Formatting Text.”

Using an Alternate E-mail Account

You can set up alternate “personalities” in Eudora for each e—mail account you
have. In the Personalities Options, you must specify the following options for
each personality: personality name, real name, and POP account. You can also
specify the default domain, return address, SMTP server, default stationery,
default signature, and Check mail and Leave mail on server functions (for
details, see the section “The Options Dialog”).

All the other options categories cannot be changed for alternate personalities—
they are effective for all. However, alternate personalities are automatically set to
use a Winsock connection and password authentication, regardless of how those
options are set in the Getting Started and Checking Mail options.

If you want to change other options, or use a separate set of mailboxes for an
account, see the section “Putting Multiple Users on One PC.”

To create an outgoing message as an alternate personality, hold down the shift key
and select one of the message creation commands from the Message menu (New
Message, New Message To, etc.) The Message Options dialog is displayed.
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The Message Options dialog

Note: The New Message With and Reply l’Vith commands will not

display the Message Options dialog. Ifyou want to open a
stationery message with an alternate personality, use one ofthe

other message creation commands to display the Message Options
dialog.

Select the personality you want to use (and stationery if you want to), then click
OK. The Composition Window is displayed, with the alternate personality as the
sender (and any stationery text if applicable). The default signature for that
personality is used, or if a stationery file is selected its signature is used. You can
always change the signature popup in the composition window (for details. see the
section “Using a Signature”).
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Using Stationery

Stationery files are templates for outgoing messages. If you find yourself
repeatedly sending the same message, save the message as a stationery file and
send it Whenever you need to with the New Message With or Reply With
commands. This way you don’t have to copy and paste text into a message, you
can just open a pre-written message and edit it as necessary.

To create a stationery file, open a new message, put the text you want into the
message body, fill in the headers as appropriate (subject, copies, etc), and set the
Toolbar. Select Save as... from the File menu to display the Save As dialog.

Select the Stationery option (if you are using 32—bit Eudora), then name the file
and click on Save to save it. You can delete the original message. If you are using
16-bit Eudora, there is no Stationery option—you only need to name the file (be
sure it has the .sta extension), all the options are set for creating stationery.

 
Creating a stationery file with the Save As dieing

To change a stationery file, open a new message with the stationery file, make
your changes, then use the Save As option again to save your changes. To delete a
stationery file, remove it from the Stationery directory.
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To send a stationery message, select a stationery file from the New Message With
or Reply With submenus from the Message menu. A Composition Window is
displayed containing the header and body from the stationery file. If you are
replying to a message, the stationery information is added to the reply. You can
edit and send this new message just as you would any other message.

To use a particular stationery file for all of your outgoing messages, select a
stationery in the Sending Mail Options (only for your dominant account), or in the
Personalities Options (for any of your personalities). Most new messages use this
file, unless you create the message using the Redirect, Send Again, New
Message With, or Reply With command.

You can also set up a filter to reply with a stationery message. See the section
“Filtering Messages” for more information.

Using a Signature

A signature is a few lines of text that are automatically added to the end of an
outgoing message when it is sent. A signature can be whatever you want, but it is
mostly used to give contact information (telephone, address, etc.) You can have
as many signatures as you want.

Note: Your signature is not displayed in the Eudora message window, but
is added to the end offhe message when it is sent.

To create or modify your Standard signature, select Standard from the
Signatures submenu on the Tools menu. The Signature window is displayed.
Enter your signature text, and select Save from the File menu to saye your
changes.

 
Creating the Standard signature
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To create additional signatures, select New from the Tools menu. An alert is
displayed, asking you what you want to call it. Enter a name and click on OK to
display a signature window. Enter your signature, save the file, and close the
Window. Your new signature is now part of the list of signatures.

To modify an additional signature, select Signatures—>Name from the Signatures
submenu on the Tools menu. The signature window is displayed for the signature
you specified. Make any changes you want, save the file, and close the Window.

To delete a signature, select Delete from the Signatures submenu on the Tools
menu. A dialog is displayed. Select the signatures that you want to delete, and
click OK.

To include a particular signature in an outgoing message, select the signature you
want from the Signature popup on the message toolbar.

 
Setting the signature for a particular message

To include a particular signature in all of your outgoing messages, select a
signature in the Sending Mail Options (only for your dominant account), or in the
Personalities Options (for any of your personalities). You can change this for a
particular message by selecting a different signature or None from the Signature
P013119
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Setting the Message Priority

You can assign a priority to incoming and outgoing messages. The priority is only
for you and your recipients—it does not affect the way mail transport systems
handle the messages.

There are five priority levels available, 1 being the highest, 5 being the lowest.
Each is represented by a small symbol in the Toolbar of a message window and
the Priority column of a message summary. Priority 3 is used for messages that
have no assigned priorities, and it is not displayed. The high and highest priority
symbols are red.

New messages are created with a Normal priority. To change the priority of the
current message, use the Priority popup.

i’ifii‘mhfifl: 
Changing the priority of a message using the priority popup

Note: To setup Eudora to always use the sender ’s priority on your

replies, turn on the Copy original ’s priority to reply option in the
Replying Options. You can always change the priority to the
message window.
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Requesting a Return Receipt

You can request that your recipients notify you when they have seen your
message. To do this, click on the Return Receipt button in the message toolbar.

When your recipients open the message then close it, a dialog is displayed asking
them to create a notification message now, later, or never (if you sent yourself a
copy, you will not get the notification request). If a recipient chooses to create a
notification message, it is sent to you and tells you when the recipient displayed
your message.

 
A request for notification

These Return Receipt options may or may not work as described, depending on
your recipients’ e-mail software.

Formatting Text in 32-bit Eudora

If you are using the 32-bit version of Eudora, you can use standard text editing
options to format the text of your outgoing messages or text files. The formatting
is delivered to your recipients using the “text/enriched” MIME standard, which
means that the formatting your recipient sees depends on how well their e-mail
package supports this standard.

It is important to remember that you cannot completely control what happens on
your recipient’ s computer. Depending on the type of computer they are using,
their installed fonts, their options or preferences, etc, they could end up Viewing
something different than what you intended. Also, the formatting changes you
make are sent to your recipient, but your default text settings are not. Any text that
you did not make changes to is displayed using your recipient’s default text.
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To format text, select the text you want to affect and use the buttons on the
Toolbar (see the section “The Toolbar”) or the Text commands from the Edit
menu. You can change the font, size, style, color, and the margins.

Word Wrap

If you turn on the Word Wrap button in the message toolbar, when the message
is sent carriage returns are automatically inserted at the end of each line of text,
with roughly 76 characters per line. This makes the message legible on the
recipient’s computer.

It is a good idea not to include your own carriage returns within paragraphs if you
have this option on. Only use carriage returns to create new paragraphs.

To manually wrap text, select the text you want, then select Wrap Selection from
the Edit menu. To unwrap text, select the text you want, then hold down the Shift
key and select Wrap Selection from the Edit menu.

To copy wrapped text without taking the carriage returns, hold down the Shift key
and select Copy from the Edit menu.

Attaching a File to a Message

Any file can be attached to and sent with a Eudora message. Most of the time, an
attached document functions like a “rider” to the e-mail message, and does not
appear within the message text. Instead, the name of the document is displayed
automatically in the Attachments field of the message header.

To attach a file to an outgoing message, select Attach File [to New Message}
from the Message menu. The Attach File dialog is displayed. Locate the file you
want, select it, and click on the Open button to attach the document to the current
message, or open a new message with the file attached. You can add as many
attachments as you want to a message.

You can also drag one or more files from the Desktop onto the message window
to attach them.

To detach a document before the message is sent, select the document in the
Attachments field, then press the delete key or select Clear from the Edit menu.
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When the message is sent, if the chosen document is not a plain text (ASCII) file,
it is encoded in the selected attachment type. This allows you to send any kind of
document through the mail, even applications.

If the document is an ASCII file, you can put it in the body of the message by
turning off the Text as Attachment button in the message toolbar, or by turning
on the Put text attachments in body of message option in the Attachments
Option.

The attachment types include the following:

MIME

This is best for recipients with MIME-compliant e-mail readers, regardless of
what operating system they are using. For more information on MIME, see
Appendix D.

BinHex

This is best for recipients on a Macintosh with an e-mail reader that is not MIME-
compliant.

U“?".°°de . . . . .
This is best for rec1p1ents us1ng PC or Un1x systems that are not MIME compliant.

Manually Decoding Attachments

If you send an attachment and your recipient’s e-mail program does not
automatically decode it, it will probably be included in the body of the message in
the chosen attachment format (MIME, BinHex, or Uuencode).

If you recieve a large message consisting largely of indecipherable text, it is
probably an attachment that was not automatically decoded. Usually this is
because the attachment headers are formatted incorrectly.

To decode an attachment that was not automatically decoded, open the message
and select Save As from the File menu to save the message as a text file. Then run
the decoding utility appropriate for the encoding method that the sender used.
Decoding utilities can be found at various shareware sites on the Internet.
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Including a URL in a Message

To include a URL (Uniform Resource Locator) in a message, enclose it with less
than and greater than signs to ensure that your recipient’s application can identify
it as a URL. For example, <http://www.eud0ra.c0m/>.

 
A URL in an outgoing message

Checking Your Spelling

Eudora includes a built-in spelling checker. It can be used to check for
misspellings in the body of current message composition windows, text files, and
signature files. It includes a built-in dictionary and also allows for the creation of
a custom user dictionary. Additionally, it can be configured to ignore capitalized
words, words with numbers, and mixed case words, to report mixed case and
doubled (repeated) words, and to suggest alternative spellings.

Note: Changes to the spell checking options can be made in the Options

dialog (Check Spelling) or by selecting Optionsflom the Check

Spelling dialog.

See Appendix A for information on how to get dictionaries for languages other
than US. English.
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To automatically check spelling when you send or queue a message, turn on the
Check when message queue/send selected option in the Spell Checking Options.
If this is on, when you send or queue a message the message is checked for
spelling errors. If you go through the spell checking process, the message is
automatically sent or queued. If you click Cancel, or leave spelling errors in the
message, a dialog is displayed asking you if you still want to send or queue the
message. If you don't want that dialog to be displayed, turn on the Don’t warn me
anymore option (this can also be set in the Spell Checking Options),

To check the spelling of a current composition window, text file, or signature file,
click on the Check Spelling button in the main window toolbar or select Check
Spelling from the Edit menu. If there are no misspellings, the No misspellings
found alert is displayed.

Note: Iftext is selected, Eudora only checks the spellt'ng ofthe selected
text. Otherwise, it starts the spelling checkfrom the beginning of
the message body or textfile and checks the entire text.

If a misspelled, unknown, or repeated word is found, the Check Spelling dialog is
displayed with the word listed in the Unknown field.

current
contract

perfectccrner 
The Check Spelling dialog

To correct the misspelled word, type the correct spelling of the word in the
Change To field, select it from Suggestions list and click the Change button, or
double-click it in the Suggestions list. The spelling checker then proceeds with
the check.
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Check Spelling Dialog

The Check Spelling dialog allows you to ignore an unknown word, change it,
suggest the correct spelling, add the word to your user dictionary, edit your
dictionary, or change the spell checking preferences Via the Options button. Each
of the fields and buttons is described below.

Unknown Field . . . . . . .
An unknown word IS one that 1s not found 1n Eudora’s bullt-in dictionary or your
own custom dictionary. You can act on an unknown word using the Ignore,
Ignore all, Change, Change all, or Add buttons, as described below.

Change To Field

This field works in conjunction with the Change and Change all buttons. It allows
you to modify the unknown word by typing its correct spelling in this field, or
selecting a suggested alternative spelling from the Suggestions field, and then
clicking the Change or Change all buttons, as described below.

Suggestions Field . .
This field lists Eudora’s suggestlons for the correct spelllng of the unknown word.
If the Always Suggest option is turned on, all suggestions are listed here by
default. If this option is turned off, click the Suggest button to display Eudora’s
suggestions.

Ignore Button . . .
This button causes the spelllng checker to 1gnore th1s occurrence of the unknown
word.

Ignore all Button . . .
This button causes the spelllng checker to 1gnore th1s occurrence and all
subsequent occurrences of the unknown word.

Change Button .
This button substitutes to contents of the Change To field for the unknown word.

Change all Button
This button substitutes to contents of the Change To field for the unknown word,
and all subsequent occurrences of the unknown word.

Suggest Button . .
This button displays Eudora’s suggestlons for the correct spelling of the unknown
word in the Suggestions field.

Note: HEudom doesn ’i have suggestions in its dictionary, than none are
listed
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Add Button ‘ ‘
This button adds the unknown word to your custom user dictionary.

Edit Dictionary Button

This button displays the Edit User Dictionary dialog.

 
The Edit User Dictionary dialog

The Edit User Dictionary dialog lists all of the words in your user dictionary in
the Dictionary field. It also allows you to add words to or delete words from your
personal user dictionary, or even clear the entire dictionary.

Note: Words in the user dictionary are saved in all lower case.

To add a word to the dictionary using this dialog, type the correct spelling of the
word in the Word field and click the Add button. The word is then added to the

dictionary and displayed in the Dictionary field.

Note: The Add button in this dialog works the same as the Add button in
the Check Spelling dialog.

To remove a word from the user dictionary, type it in the Word field or locate it in
the Dictionary field and single-click on it to display it in the Word field. Then,
click the Delete button.

To delete the entire user dictionary, click on the Clear button. You will then be
prompted to confirm the deletions. If you click Yes, all of the words are deleted
from the user dictionary.

36 QUALCOMM incorporated
MS 266807

THIS DOCUMENT IS CONFIDENTIAL AND FILED UNDER SEAL

AREND|315603



THIS DOCUMENT IS CONFIDENTIAL AND FILED UNDER SEAL 

Case 1:13-cv-00919-LPS   Document 312-1   Filed 03/10/21   Page 38 of 199 PageID #: 29651Case 1:13-cv-OO919-LPS Document 312-1 Filed 03/10/21 Page 38 of 199 PageID #: 29651

Eudora User Manila:f Creating Messages

Options Button

This button displays the spell checking Preferences dialog.

 
Spell checking Preferences dialog

The spell checking Preferences dialog lists the six spell checking options. A
check mark in the box next to the option name indicates that it is turned on.

Note: The spell checking options can also be modified in the Options
dialog (Spell Checking).

The available options are as follows:

Ignore capitalized words ‘ .
Ignores words that start With capltal letters, such as proper nouns.

Ignore words with numbers

Ignores words that contain numbers.

Ignore words with mixed case
Ignores words that contain both upper and lower case characters.

Report doubled words . . . . ‘
Rports words that appear tw1ce 1n sequence 1n text and 1dent1f1es them as Doubled
words.

Make Suggestions . .
Displays Eudora’s suggestlons for the correct spelllng of an unknown word. You
can select any combination of the suggestion options,.

Note: IfEudora doesn ’t have suggestions in its dictionary, then none are
listed
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Saving a Message for Later Changes

Sometimes it is convenient to save an outgoing message either as a safeguard
when typing long messages, or so you can return to it later to make changes.

To save the current message, select Save from the File menu. Saved messages are
put in the Out mailbox with a bullet (°) in the Status column. This indicates that
the message has been saved and can be sent or queued.

 
A message saved in the Out mailbox

You can continue making changes or close the message. If you tiy to close an
outgoing message window without saving that version of the message, an alert is
displayed asking if the message should be saved or the changes discarded. If you
select Discard and the message has never been saved, the message is deleted.
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Sending or Queueing a Message

After you compose a message, you can send it immediately or put it in a queue to
be sent later.

Note: Most SMTP servers do not require a password to send mail. For
information about setting up apassword checkfor sending mail,
see the section “Troubleshooting. ”

Sending a Message immediately

If you want to send your messages immediately instead of putting them in a queue
to send later, then be sure the Immediate send option is on in the Sending Mail
Options.

To send the current message, click on the Send button or select Send
Immediately from the Message menu. A progress window is displayed to show
the progress of the transmission.

If you have the Immediate send option on, but want to put the current message in
the queue, hold down the Shift key and click on the Send button. The Change
Queueing dialog is displayed and you can set detailed instructions. For more
details, see the section “Queueing a Message to Send at a Certain Time.”

Queueing a Message to Send Later

If you want to put your messages in a queue (in the Out mailbox) to send all
together at a later time, be sure the Immediate send option is off in the Sending
Mail Options.

You can set up Eudora to warn you if you try to delete a queued message, or try to
quit Eudora with queued messages. To do this, turn those options on in the Extra
Warnings Options.
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To put the current message in the queue, click on the Queue button or select
Queue For Delivery from the Message menu. The message window is closed (if
it was open), the message is saved in the Out mailbox marked Q (meaning it’s
ready to be delivered), and the date and time are placed in the Date column.

 
Queued messages in the Out mailbox

To send all of your queued messages, select Send Queued Messages from the
File menu. A progress window is displayed momentarily at the top of the screen
indicating the progress of the transmission.

If you have the Immediate send option off, but want to send a message
immediately, hold down the Shift key and click on the Queue button. The
Change Queueing dialog is displayed and you can select the Send message
Right Now option.

Queueing a Message to Send at a Certain Time

You can specify that a message be sent at a certain time in the future. To do this
for the current outgoing message, select Queueing... from the Change submenu
off of the Message menu. The Change Queueing dialog is displayed.

 
The Change Queueing dialog
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If you choose Right Now, the message is sent immediately when you click OK. If
you choose Next time queued messages are sent, the message is sent the next
time queued messages are sent.

If you choose On or After, you can use the Time and Date fields to fill in the
time and date when the message should be sent. The message is saved in the Out
mailbox with a T in the status column, and the specified date and time in the Date
column. The message is sent when the specified time arrives.

[warrant For the message to be sent at the correct time, Eudora must
be running at that time. IfEudora is not running, the message is
sent thefirst time Eudora is run after the specified time has passed

If you choose Don’t Send for a message that has never been queued, nothing
happens. The message is held in the Out mailbox until it is either deleted or re-
queued and sent.

Editing a Queued Message

To edit a queued message, open the Out mailbox and double-click on the message
summary. Make the necessary edits and save them. The message is kept in the
Out mailbox. If you close the changed message without saving it, an alert is
displayed asking you to verify the changes.

Taking a Message Out of the Queue

A message that is queued but is not yet sent can be unqueued using the Change
Queueing command. Open the Out mailbox and select the desired message
summary. Then, select Change Queueing... from the Message menu and click on
Don’t Send. This changes the message status from queued (Q) to saved (-). The
message is held in the Out mailbox until it is either deleted, re-queued, or sent.

Sending Queued Messages When Checking Mail

If the Send on check option in the Sending Mail Options is on, every time Eudora
checks for mail (automatically or manually), all queued messages are
automatically sent.
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Sending Messages with Special Server Instructions

To send your queued messages with special instructions for the server, hold down
the Shift key and select Send Queued Messages from the File menu. The Mail
Transfer Options dialog is displayed. Set the options you want and click OK. All
the actions you have requested are completed. For details, see the section
“Managing Your Mail on the POP Server.”

Keeping Copies of Outgoing Messages

There are three ways to keep copies of your outgoing messages.

To put a copy of every outgoing message in the Out mailbox, turn on the Keep
copies option in the Sending Mail Options.

To put a copy of the current outgoing message in the Out mailbox, turn on the
Keep Copy button in the message toolbar.

To put a copy of the current outgoing message in a particular mailbox, right click
in the body of the message and select the mailbox from the Fcc menu.

In all these cases, when the messages are sent they are put in the specified
mailbox with an S in the Status column, indicating that the message has been sent.

If none of these options are used, outgoing messages are put into the Trash
mailbox.

Note: You can also set up afilter to save outgoing messages inparticular
mailboxes based on information contained in the message. See the
section ”Filtering Messages ”for more information.
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Checking For incoming Mail

The POP server is where your mail is received and stored until it is transferred by
Eudora to your PC. You can use several different POP accounts with Eudora:
Your main POP account, or “dominant personality,” is specified in the Getting
Started Options, and additional POP accountss, or “alternate personalities” are
specified in the Personalities Options.

Note: To best understand the functioning ofthe POP server with respect
to Eudora, see Appendix C.

There are two ways to check your POP server and transfer mail to your PC:
automatically or manually. These are described in the sections below.

You can also control how your mail is transferred from the server, and what
happens to it on the server. For details, see the section “Managing Your Mail on
the POP Server.”

Checking for Mail Automatically

To set up Eudora to automatically check your POP account and transfer new mail
first open the Checking Mail Options and in the Check for mail every ?
minutes field, enter the number of minutes that you want between mail checks.
Then, go to the Personalities Options and turn on the Check mail option for
each personality that you want to be automatically checked.

9

Note: 15 minutes is a good minimum interval, because checking mail
morefrequentlyputs an unnecessary load on your POP server. 5’
thefield is empty, or is set to 0, mail is not automatically checked

Ifautomatic checking is set, the Check Mail command under the
File menu displays the next time that an automatic check is
scheduled to occur.

The Check mail option also specifies that an account should be checked for new
mail when a manual mail check is done.
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Checking for Mail Manually

You can manually check for new mail at any time by selecting Check Mail from
the File menu. Any account that has the Check Mail option turned on (in the
Personalities Options) is checked. If you haven’t successfully entered your
password since opening the Eudora program, you are prompted for it (for each
account being checked). A progress window is momentarily displayed at the top
of the screen indicating that an attempt to reach your POP account is being made.

Note: Ifautomatic checking is on andyou manually checkfor new mail,
the next automatic mail check will happen at the speczfied number
ofminutes after the manual check.

Stopping a Mail Check

If you want to stop a mail check in the middle, click on the Stop button in the
progress window.

Using Your Password

Each time you open Eudora and check mail for the first time, you need to enter a
password for each POP account that you have. This password is required by the
POP server before it will transfer your mail, so that no one else can get your mail
from the server.

Note: This does notprotect your mail once it is on your PC. Unless a
message has been sent with some type ofsecurtty, it isjustplain
text, which many applications can read 17you are interested in
securing the messages on your PC, you may want to consider a
disk driver that can encrypt hard disk data.

If you need to enter a password, the Eudora Password dialog is displayed. Enter
your password and click OK. If you make a mistake before clicking OK, simply
backspace and re-enter the password correctly.

Note: Your POP accountpassword is case-sensitive, so the uppercase
and lowercase characters must be typed in exactly. Be sure that
Caps Lock is ofl
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The Password dialog

If your password is rejected, an error message is displayed indicating that you
have entered the wrong password. Select Check Mail from the File menu to
redisplay the password dialog.

As long as Eudora is running, it remembers all of your passwords. If you don’t
want it to remember (if, for example, you are away from your PC), select Forget
Password(s) from the Special menu. The next time you check mail for any
account, you are prompted for your password again.

You can also make Eudora remember all of your passwords from one session to
the next, which means you never have to enter passwords again, even if you quit
and restart Eudora. You only want to do this if your PC is in a secure location,
where there is no possible chance of someone else having access to it. To use this
option, turn on Save password in the Checking Mail Options.

Changing Your Password

To change the password for one of your personalities, select Change Password
from the Special menu, and select the personality you want to change the
password for. You are prompted to enter your old password once, and your new
password twice. Depending on the server you are using, the password can be up to
30 characters, but normally it is only 7 or 8.

Note: This only works ifthe POP server is running a compatible
password-change server. For information about these servers, see
Appendix A.)

When you choose a new password, try not to use real words, names, dates,
familiar acronyms, etc. Some systems require at least one number or symbol in
your password, and you may want to do that even if it is not required.
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Receiving New Mail

When Eudora does a mail check, you can be notified of new mail in one or all of
the following ways: an alert dialog, the opening of the mailboxes to which new
mail is delivered, and a special “New Mail” sound. These options are turned on or
off in the Getting Attention Options.

Note: For the sound alert to work, you may need a sound driverfor the
PC speaker (see ‘Mppena’ix A ”for a sourcefor this driver).

When you receive notice that new mail has arrived, select Eudora from the
applications menu. Mail usually arrives in the In mailbox (unless you are using
filters to transfer messages). If the In mailbox is not already open, select In from
the Mailbox menu. The messages are listed in the order they are received, with
the most recent message listed last. Unread messages are designated by a bullet (0)
in the Status column of the message summary.

Double-click anywhere on a message summary to open the message. Incoming
messages are saved indefinitely in the In mailbox (or the mailbox they are filtered
into) until they are deleted or transferred to another mailbox.

The incoming Message Window

To open an incoming message, double-click on its message summary in a mailbox
window, or, if the message summary is current (highlighted), press the space,
enter, or return key.

1:19:15 .15 .2. 55-52: axe-5:323:93. 
An incoming message window

The incoming message window consists of the title bar, the Toolbar, and the
message body.
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Title Bar

The Title bar provides information about the message, including the name of the
sender, the time and date the message was delivered, and the message subject.

Toolbar

The Toolbar consists of buttons and popups displayed just under the title bar.

2”“. Tow Truck
This can be used to drag any current message into a different mailbox. Just hold
the mouse button down on the icon and drag it to an open mailbox or a mailbox
in the Mailboxes window.

BLAH,BLAH,BLAH

If this is on, all the message headers (and any formatting codes) are displayed.

Pencfl‘ .
If this is on, you can edit the message.

Trash

If this is on, the message is deleted from the server the next time you check mail.
This button is only displayed if the original message is still on the server. For
details, see the section “Managing Your Mail on the POP Server.”

Fetch

" If this is on, the message is transferred in full the next time you check mail. This
button is only displayed if the message was originally transferred in part. For
details, see the section “Managing Your Mail on the POP Server.”

 
 

Priority Popup

This lets you indicate that the message is of higher or lower priority than a
normal message. For most messages, this is just an empty box (normal priority).
For details, see the section “Setting the Message Priority.”

Subject

This is the subject that was assigned by the sender, and is shown in the message
summary. For instructions on changing this subject, see the section “Editing
Incoming Messages.”

 

Message Body

The message body contains the message header and text information, as well as
the name and icon of each attachment. Attachments can be opened from within
the message window by double-clicking on the attachment icon.
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Receiving Attachments

Unless you have specified a particular directory for your incoming attachments
(see the section “Specifying an Attachment Directory”), they are automatically
decoded and saved in the Attach Directory in your Eudora Directory. If you
receive multiple attachments with the same name, a number is added to the end of
each duplicate name, in the order they are received.

Attachment names and icons are displayed at the bottom of incoming messages.
To open an attachment from the message window, double—click on the attachment
name or its icon. If you have the application that the attachment was created in,
that application launches and the attachment opens.

If you recieve a large message consisting largely of indecipherable text, it is
probably an attachment that was not automatically decoded. Usually this is
because the attachment headers are formatted incorrectly. To decode an
attachment that was not automatically decoded, open the message and select Save
As from the File menu to save the message as a text file. Then run the decoding
utility appropriate for the encoding method that the sender used. Decoding
utilities can be found at various shareware sites on the Internet.

Specifying an Attachment Directory

If you do not want to use the default Attach Directory to receive your attachments,
select Options... from the Tools menu and select the Attachments Options. Then
click on the large button beneath the Attachment Folder prompt. A standard file
dialog is displayed.

Double-click on the name of the directory you want to use (its name should be
displayed in the menu above the list), then click the Use Directory button. The
dialog closes, leaving the Options dialog displayed. The name of the folder you
just selected is now displayed in the Attachment Directory button.
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An attachments directory is selected

Note: Uat any time Eudora cannotfindyour selected directory, Eudora

will use the Attack Directory in the Eudora directoryfor
attachments antilyou designate a new directory.

Editing incoming Messages

You can edit the message body in an incoming message if you turn on the Pencil
button in the Toolbar. You can also edit the Subject in the Toolbar (this is the
subject shown in the message summary).

To edit an incoming message, click on the Pencil button to turn it on, then edit the
message body. When you are done, save your changes and close the message.

To edit the subject of an incoming message, open it and edit the subject in the
Toolbar (not the subject in the message body). When you are done, click
somewhere else in the message, or close it. The new subject is displayed in the
message summary. The contents of the Subject field of the message header
remain unchanged.

Note: Uyou reply to the message, the original subject is usedfor the
reply, notyour changed subject.
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Using Active URLs

Any string of text that Eudora recognizes as a URL (Uniform Resource Locator:
http, ftp, gopher, ph, finger, etc.) is active. Double-click on a URL to open a
World Wide Web location, transfer a file, do a gopher search, use the finger tool,
etc. URLs are highlighted and underlined to show that they are active (32-bit
Eudora only).

To setup Eudora to automatically open a new message when you use a mailto link
within a Netscape Web browser, turn on the Intercept Netscape mailto URLs
option in the Miscellaneous Options. (Be sure you are not running the Mailto
Watcher application at the same time.)

Managing Your Mail on the POP Server

During a mail check, your incoming messages are normally transferred from your
account on the POP server to your PC, and then deleted from the POP server. But
this can be awkward if you want to read mail from two or more computers, and
keep your mail organized at the same time.

There are several options that you can use to control your mail transfers and the
storage on the server. Some of these options are available in the Checking Mail
Options, and some are available in the Mail Transfer Options dialog.

Leaving Mail on the Server

To transfer all of your new messages from the POP server to the PC you are on,
and also leave copies of those messages on the server, turn on the Leave mail on
server option in the Checking Mail Options. You can use the Delete from server
after ? days option to set the maximum number of days the copies should be
kept.

Note: The Leave mail on server option can also be setfor each alternate
personality you have. To do this, use the Personalities Options.

At the next mail check from that PC, Eudora ignores the copies of those
previously read messages and looks for new ones. However, if you check mail
from another computer, those messages are treated as new and are transferred to
that computer.

Note: The Leave mail on server option should he used with care, since it
can result in a buildup ofmessages on the POP server.
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Deleting a Message from the Server

To delete a message that has been left on the server (without retrieving it again),
turn on the Trash button in the message Toolbar or set the message summaiy’s
server action to Delete, then check mail again. Or, use the Delete all messages
that have been retrieved option in the Mail Transfer Options dialog (descfibed
in the section “Checking for Mail with Special Server Instructions”)

Skipping Messages Over a Certain Size

To stop Eudora from transferring incoming messages that are too large, turn on
the Skip messages over ? K in size option in the Checking Mail Options, and
specify a size. Only the first few lines of the messages that exceed that size are
transferred, with a note at the bottom stating that the whole message has not been
transferred.

If you decide you want to transfer the whole message, click on the Fetch button in
the incoming message window, or select the Fetch server action in the message
summary, then check mail again. You can also use the Trash button or the Fetch
& Delete server action so that the message is deleted from the server after
transferring it.

If you decide you don’t want the message and want to delete it from the server,
click on the Trash button in the incoming message window, or select the Delete
server action in the message summary, then check mail again.
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Checking for Mail with Special Server Instructions

To check your mail and give special transfer and storage instructions to the server,
hold down the Shift key and select Check Mail from the File menu. The Mail
Transfer Options dialog is displayed. Set the options you want and click on the
OK button to continue checking for mail.

Myflllei Ego 
The Mail Transfer Options dialog

The mail transfer options are described below.

Retrieve new mail .
Transfer your new mall from the POP server to your PC.

Send queued messages . ‘
Send all the queued messages (marked “Q”) 1n your Out mailbox.

Delete messages marked for deletion ‘ . .
Delete the messages on the server that are marked Delete in Eudora, This is for
messages that were retrieved only in part, either with the Leave mail on server or

Skip messages over ? k in size options (in the Checking Mail Options), or with
the Fetch all Message Headers option (in the Mail Transfer Options dialog).

Retrieve messages marked for retrieval ‘
Retrieve the messages on the server that are marked Fetch or Fetch & Delete 1n
Eudora. This is for messages that were retrieved only in part, either with the
Leave mail on server or Skip messages over ? k in size options (in the Checking
Mail Options), or with the Fetch all Message Headers option (in the Mail
Transfer Options dialog).
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Note: To mark a message Fetch, Delete, or Fetch & Delete, etther click
on the buttons in the incoming message window, or select an
optionfrom the Server Action popup ofthe message summary.

Delete all messages that have been retrieved

Delete all the messages on the server that have already been transferred to the PC
you are on.

Delete all messages on server (be sure) . .
Delete all of your messages on the server. Be absolutely sure this is what you
want to do because there is no way to undo it.

Fetch all message headers to In mailbox ‘
Retrieve the header and the first few hues of every new message. If you select this
option, the messages are not filtered. Set the Server Action in the message
summaries to specify what you want to do with the messages the next time you
check mail.

[warrant lfyoa delete the message header, andyou have the Delete

from server when emptiedfrom trash option on in the Checking
Mail Options, the message is gone completelyfrom Eudora and the
server.

How should checkingtsending be performed .
If you have multiple personalltles, you can check or send mail based on the
options on the left, or as specified in the Personalities Options. You can also
specify the personalities that you want to check or send with this mail transfer.
Hold down the Shift key to select multiple personalities in sequence, or the Ctrl
key to select them out of sequence.
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Replying to a Message

To reply to the current message, select Reply from the Message menu. A new
message window is displayed, with the original sender’s address automatically
placed in the To field of the header. All of the sender’s original text is quoted in
the message body. This text can be edited as needed. Additional text can be added
to the reply just as to any outgoing message, and the reply can then be sent or
saved for further changes.

If the sender’s text did not include style information, each line is prefixed by a
greater—than symbol (>).

>This is a test message. Could gou please Peplg
>50 that I can be sure guu received it?

Quoted text that does not include style information

If the sender’s text did include style information (e.g., bold text), it is quoted with
greater—than and less-than symbols above it and below it, and a left sidebar.

>>>>

This text includes stgle information, such as bold text,

and text that is uerg big.
<<<<

Quoted text that includes style information

Messages that have been replied to are identified with an “R” in the Status column
of their message summary.
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Using the Reply Options

There are several options that you can use when replying to messages.

To include everyone who received the original message, select Reply to All from
the Message menu.

To include yourself as a recipient, turn on the Include yourself option in the
Replying Options. This only works if you are using Reply to All.

Note: To determine who you are, Eudora uses the “me ” nickname. If

there is no ”me, ” Eudora uses the contents ofthe POP account

and Return addressfieldsfrom the Personal Information Options.
The ”me ” nickname isparticularly useful ifyou have multiple
addresses and don ’t want replies to go to any ofthose addresses.

To put the addresses of the other recipients of the original message in the Cc field
(instead of the To field), turn on the Put original To recipients in Cc field, not
To field option in the Replying Options. Only the original sender’s address is put
in the To field. This only works if you are using Reply to All.

To copy the original message’s priority to your replies, turn on the Copy
original’s priority to reply option in the Replying Options.

To map Ctrl-R to Reply to All instead of Reply, turn on this option in the
Replying Options.

Replying with a Stationery File

To reply to a message with a stationery file, select a stationery file from the Reply
With submenu from the Message menu. The stationery file is opened as a
message and is addressed as appropriate (your Replying Options are used). For
details about stationery, see the section “Using a Stationery File.”
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Forwarding a Message

Any message can be forwarded to someone else. To forward the current message,
select Forward from the Message menu. A new message window is displayed
with your address in the From field, the original sender’s text quoted in the
message body, and the original attachments in the Attachments field. For details
on how text is quoted, see the section “Replying to a Message.” Make any
changes you want, and enter the recipients’ address in the To field. The message
can then be sent or saved for further changes.

Note: Uyouforward an outgoing message (a message you sent), the
attachment(s) is not automatically included

Messages that have been forwarded are identified with an “F” in the Status
column of their message summary.

Redirecting a Message

Incoming messages can be sent to a new recipient “by way of" you, maintaining
the original sender’s address in the From field. This is called redirecting.

To redirect the current message, select Redirect from the Message menu. A new
message window is displayed with the original sender’s address in the From field
with the statement “by way ofyour address”, the original sender’s text in the
message body, and the original attachments in the Attachments field. Make any
changes you want, and enter the recipient’s address in the To field. The message
can then be sent or saved for further changes.

Note: You may want to enclose any changes in brackets ([j) so thatyou
don ’t confuse the recipient about who wrote what.
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A Redirected message

Messages that have been redirected are identified with an “D” in the Status
column of their message summary.

Turbo Redirecting

You can redirect a message to someone on your recipient list, queue the new
message (without displaying it), and delete the original message, all with one
command. To do this, turn on the Turbo redirect by default option in the
Miscellaneous Options.

When you use Redirect, your signature is not added to the message when it is
sent, unless you originally created the message.

Sending Rejected Messages Again

If for some reason an e-mail message can’t be delivered to a recipient, mail
transport agents return the message to the original sender (you). A message is
typically rejected because of an error in the recipient’s address, although many
other reasons are possible.

The return message usually includes cryptic information that may let you
determine the reason the message was rejected. It also includes the text of the
original message.

You can easily recover the original message, make any corrections, and resend it.
To do this for the current message, select Send Again from the Message menu.
This eliminates the inserted extra text and reformats the message as it originally
appeared. You can then make changes or additions and send the message again.
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Opening a Mailbox

To open a mailbox, select it from the Mailbox menu, or double-click on it in the
Mailboxes window.

Note: The unread message icon is displayed in the Mailbox menar
whenever a mailbox orfolder contains unread messages that are
less thanfive days old, and any mailboxes orfolders in the
Mailboxes window that conatin unread messages are displayed as
bold.

The Anatomy of a Mailbox

Mailbox windows contain all of your incoming and outgoing message summaries.
To open a mailbox, select it from the Mailbox menu, or double-click on it in the
Mailboxes window.

 
A mailbox window

Message Summaries

Each line in a mailbox window represents a message and is called a message
summary. Outgoing messages that are in any mailbox other than Out are shown
with italicized message summaries.
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60

To select one or more message summaries, use one of the following options:

- To select one summary, click on it.

- To select two summaries and all the summaries between them, select a

summary, hold down the Shift key, and select another summary.

- To select all of the summaries that have the same information in a particular
column, hold down the Alt key and click on one column in the summary. For
example, if you click on the Status column for one summary, all of the
summaries with that status are selected.

- To make “disjointed” selections, hold down the Ctrl key and select summaries.

- To select summaries by dragging the mouse over them, first turn off the Allow
drag and drop transfers option in the Miscellaneous Options.

Each message summary is divided into columns: Status, Priority, Attachments,
Label, Sender/Recipient, Date, Size, Server Action, and Subject. You can show or
hide these columns using the Mailbox Columns Options.

A message’s Status, Priority, Label, and Server Action can be changed directly in
the mailbox window. To do this, select the messages you want to change and click
the right mouse button. Select an option from the popup menu to make your
change.

The Status Column . ‘
This column displays the message status, Wthh is one of the following:

- The message has not been read (all mailboxes except Out), or is
queueable but has not been queued (Out mailbox only).

<blank> The message has been read (all mailboxes except Out), or is not yet
able to be queued because it has no recipients (Out mailbox only).

Reply has been chosen for the message.

Forward has been chosen for the message.

Redirect has been chosen for the message.

The message has been sent (outgoing messages only).

The message is queued to be sent (outgoing messages only).

The message is queued to be sent at a specified time (outgoing
messages only).

- The message was transferred from the Out mailbox before being
sent.

t—l/OVJUTJW
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The Priority Column . .
This column displays the message pr1onty. You can use the popup to set a
particular priority, or to raise or lower the priority.

fi Highest priority.

4“ High priority.

<hlank> Normal priority.

V Low priority.

3 Lowest priority.

gor more information on message priorities, see the section “Setting the Message
nority.”

The Attachments Column

This column displays the attachment icon ('3) if a message has attached
documents.

The Label Column

This column displays the message label. Labels are assigned to incoming
messages by the recipient, either manually or automatically using filters (see the
section “Filtering Messages”). When a message summary is assigned a label, the
entire summaiy changes color to match the label color.

Note: LabelT colors and titles are assigned using the Labels Options.

The Sender/Recipient Column . _
This column shows the sender of the message (for 1ncom1ng messages) or the
intended recipients (for outgoing messages).

Note: Bugs in some POP servers/mail transport systems cause Eudora to

display the sender ofincoming messages as ? ? ?@ ? ? ?. This is
because the requiredFrom: header is missing.

The Date Column . .
This column displays the date and t1me the message was composed, or, for t1med
messages, the date and time the message is scheduled to be sent.

The Size Column

This column displays the size of the message in K (K = 1024 bytes).
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The Server Action Column . . .
This column displays the actlon that 1s done to the corresponding message on the
server. The next time you check mail, the server action you requested is
automatically completed.

Leave Don’t change the message on the server.

"ff; Fetch Download the whole message from the server.

Delete Delete the message from the server.

jg” Fetch & Delete Download the whole message then delete it from the server.

Note: To control the mail transfer, you can also use the Mail Transfer

Options dialog. For details, see the section “CheckingMail with
Special Server Instructions. ”

The Subject Column

This column displays the subject of the message. The sender originally typed this
information into the message header, but you can modify it (see the section
“Editing Message Subjects”).

Displaying and Resizing Columns

To specify which columns you want to be displayed in your mailboxes, select
Options... from the Tools menu, click on Mailbox Columns and be sure the
columns you want to see are on.

To resize a column in a mailbox window, move the mouse pointer until it is over
the column heading divider to the right of the column you want to resize, drag the
divider to the position you want. The column divider moves to the new location,
and the mailbox is redrawn.

You can only shrink a column as far as its left divider. If you do that, a double
divider line is displayed in place of the column, and its contents are hidden. To
redisplay the column, drag the right divider line to the right.
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Using the Mailbox Size Display

In the lower left corner of each mailbox window, three numbers show the size

information for that mailbox. The first is the number of messages in the mailbox;
the second is the total amount of space those messages require; the third is the
amount of disk space that is wasted with the mailbox.

Wasted space is created when messages are deleted from a mailbox This wasted
space is automatically removed when the amount of wasted space in the mailbox
is greater than the amount of space the messages in the mailbox use, or if the
amount of space wasted in the mailbox is greater than 5% of the free space on the
disk drive that contains it.

To manually clean up the wasted space in a mailbox, click on the mailbox’s size
display. Or, to clean up all your mailboxes, select Compact Mailboxes from the
Special menu.

Creating Mailboxes and Folders

Eudora lets you create mailboxes to put messages in, and folders to put mailboxes
(or more folders) in.

There are three ways to create mailboxes and folders:

' Using the New option from the Mailbox menu and folder submenus.

' Using the Mailboxes window (see the section “Using the Mailboxes
Window”).

' Using the New option from the Transfer menu (see the section “Transferring
Messages”),
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Creating a Mailbox or Folder Using the Mailbox Menu

To create a new mailbox or mail folder, select New... from the Mailbox menu, or

from a mail folder submenu (to put the mailbox in that folder). The New mailbox
dialog is displayed.

 
New mailbox dialog

To create a mailbox, type in the new mailbox name and click OK, The mailbox is
created and added to the Mailbox and Transfer menus.

To create a mail folder, type the name of the new mail folder and check the Make
it a Folder option. Click OK to create the folder. The new mailbox dialog is
displayed again. Type the name of a mailbox to create within the new folder, then
click OK. The new folder and its mailbox are displayed in the Mailbox and
Transfer menus.
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Using the 16-bit Mailboxes Window

The l6—bit Mailboxes window lets you create new mailboxes and folders, remove
and rename them, and move mailboxes among folders. To accomplish any of
these tasks, select Mailboxes from the Tools menu. The Mailboxes window is

displayed.

 
The 16-bit Mailboxes window

The Mailboxes window has two identical lists of mailboxes and folders, each

called Top Level. These list the names of the mailboxes and folders you have
created (folders are identified by an arrow to the right of the name). Each list is
similar to that displayed under the Mailbox and Transfer menus, except that the
In, Out, and Trash mailboxes aren’t included.

If the Mailbox window isn’t big enough to display all of your created mailboxes
and folders, use the scroll bar on the right side of either list to View the rest of the
mailboxes and folders.

Note: Double-clicking on any of the mailboxes in a list opens that
mailbox. Messages can be selected, opened, and otherwise
manipulatedfrom there.

To open a folder and display its contents in the list, double—click the folder. To
change the folder being displayed in the list, select another folder from the title
FOPUP-
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Creating a New Mailbox or Folder

To create a new mailbox or folder in the Mailbox window, be sure one of the lists

is displaying the folder you want to put the new item in. Then click on the New
button below that list. A dialog is displayed requesting the name of the new
mailbox or folder.

Type in the new name, check the Make it a Folder option if you want to, and
click OK. The new mailbox or folder is displayed in the lists, and added to the
Mailbox and Transfer menus.

Renaming a Mailbox or Folder

To rename a mailbox or folder, select the one you want to rename (from either
list) then click on the Rename button under that list. A dialog is displayed
requesting the new name. Type in the new name and click Rename to rename the
mailbox or folder.

Moving a Mailbox from one Folder to Another

To move a mailbox from one folder to another, select the one you want to move
(from either list). In the other list, open the destination folder so that its name is
displayed above the list. Click on the appropriate Move button to move your
selection to the other folder.

Removing a Mailbox or Folder

To remove a mailbox or folder, select the ones you want to remove (from either
list) then click on the Remove button under that list. A dialog is displayed asking
you to confirm the removal. Click on the Remove It button to remove the
mailbox. If you selected more than one mailbox or folder, you are prompted for
each one of them. Click on the Remove All button to remove all of them without

further prompts.

If you choose to remove a mailbox in which messages are still stored, or a folder
in which other mailboxes or folders are stored, all the messages, mailboxes, and
folders contained within the selected mailbox are also removed.
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Using the 32-bit Mailboxes Window

The 32—bit Mailboxes window lets you create new mailboxes and folders, remove
and rename them, and move mailboxes among folders. Mailboxes or folders that
are bolded have unread messages.

The Mailboxes window is automatically docked to the left side of the Eudora
application window, and can also be docked to the right side of the Eudora
window, or placed anywhere on your desktop. You can right-click the mouse
button to toggle Docking view (floating vs. attached to the application window)
or Hide on and off.

To open the Mailboxes window if you’ve hidden it, select View Mailboxes from
the Tools menu.

Justine's stuff

“ " Puppies Mailing List 
The 32-bit Mailboxes window

To move the Mailboxes window, hold down the left mouse button on the gray rim
of the window and drag it where you want it. If you drag it to the left or right edge
of the Eudora window, it will dock in a vertical position in the Eudora window,

To open a mailbox or folder, double-click on it. You can move among the folders
and mailboxes using the up and down arrow keys, or close or open folders using
the left and right arrow keys. You can also start typing the name of the mailbox or
folder you want, and it is highlighted when you have typed enough unique
characters to identify it (the item must be displayed, so a mailbox that is in a
closed folder cannot be selected).
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Creating a New Mailbox or Folder

To create a new mailbox or folder in the Mailbox window, right click on a folder
and click New. A dialog is displayed requesting the name of the new mailbox or
folder.

Type in the new name, check the Make it a Folder option if you want to, and
click OK. The new mailbox or folder is displayed in the lists, and added to the
Mailbox and Transfer menus.

Renaming a Mailbox or Folder

To rename a mailbox or folder, click on it once, then click again to highlight just
the name (or right click on it and select Rename). Type in the new name.

Moving a Mailbox from one Folder to Another

To move a mailbox from one folder to another, select the one you want to move
and drag it to where you want it.

Removing a Mailbox or Folder

To remove a mailbox or folder, select the one you want to remove then select
Delete from the right mouse button or use the Delete key.

If you choose to remove a mailbox in which messages are still stored, or a folder
in which other mailboxes or folders are stored, all the messages, mailboxes, and
folders contained within the selected mailbox are also removed.
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Deleting a Message

As a safeguard against inadvertent deletions, two steps are used to delete a
message from your PC: first you put the message in the Trash, then you empty the
Trash.

To put a message in the Trash, select the message then select Delete from the
Message menu, or select Trash from the Transfer menu, or press the delete key.
The message is transferred to the Trash mailbox.

To delete the messages in the Trash mailbox (removing them permanently from
your PC), select Empty Trash from the Special menu.

You can set up Eudora to warn you if you try to delete unread, queued, or unsent
messages. To do this, use the Extra Warnings Options to turn on those options.

Quitting Eudora empties the contents of the Trash mailbox when the Empty
Trash when exiting option in the Miscellaneous Options is turned on. Finally, if
you want to delete just a few messages from the Trash mailbox, select them, then
select Delete from the Message menu or press the delete key. Deleting a message
from the Trash removes it completely.

Automatically Deleting Attachments

When you delete messages, you can have their attachments automatically deleted.
To do this, turn on the Delete attachments when emptying Trash option in the
Attachments Options, and be sure the attachments are still in the Attach
Directory (or the directory you have specified for attachments). If you have this
option on, and want to delete a message but save its attachment, move the
attachment into another directory before deleting the message.
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Transferring Messages

You can transfer messages to any of your mailboxes. There are several ways to do
this:

- Select the message(s) you want to transfer, then select a mailbox from the
Transfer menu.

- Select the message(s) you want to transfer, then right—click on it and select a
mailbox from the transfer submenu.

- Drag a message summary to an open mailbox or a mailbox in the 32-bit
Mailboxes window (this does not work with the 16-bit Mailboxes window).

To put a copy of a message in another mailbox (instead of transferring the
message), hold down the Shift key and use one of the transfer options above. This
is useful if you want to file a message in more than one mailbox.

If you try to transfer a message to the Out mailbox, an alert is displayed informing
you that some header information may be removed from the message during
transfer. Click Yes to transfer the message.

Note: You can undo mailbox transfers using the Uado command under
the Edit menu.

Using the Transfer menu

The Transfer menu is one way to transfer messages among your mailboxes. With
a current message open, or message summaries selected, select a mailbox from the
Transfer menu. The messages are transferred from their previous mailbox to the
mailbox you selected.

Dragging Messages

You can drag messages from one mailbox to another using the message
summaries or the Tow Truck 1con 1n an open Window.

To drag a message summary to another mailbox, select the message summary (or
summaries) and drag the summary into any open or minimized mailbox window,
or (if you are using the 32-bit version) any mailbox in the Mailboxes window.
When you release the mouse button, the message is transferred.

To drag an open message to another mailbox, hold down the mouse over the Tow
Truck icon and drag the message into any open mailbox or (if you are using the
32-bit version) any mailbox in the Mailboxes window. When you release the
mouse button, the message is transferred.
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Note: You can only drag messages around ifthe Allow drag and drop

transfers option is on in the Miscellaneous Options.

Creating a Mailbox or Folder During Transfer

To create a mailbox and transfer the current message into it at the same time,
select New... from the Transfer menu instead of the name of a mailbox. The New

Mailbox dialog is displayed.

You can create a new mailbox or mail folder (for details, see the section “Creating
Mailboxes and Folders”). When you are done, the current message is transferred
into the new mailbox.

To create the new mailbox without transferring the message into it. check the
Don’t transfer, just create mailbox option.
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Filtering Messages

Many of the e-mail management functions in Eudora can be done automatically
using filters. For example, you can automatically reply to a request for
information, transfer all the messages from your children into a Personal mailbox,
and label all the messages from your customers as “Hot.”

To open the Filters window, select Filters from the Tools menu. The Filters
window is displayed, and any filters you have created are listed on the left.

 
The Filters window with an example fifter

To create or modify a filter, first click on the New button or select an existing
filter.

Second, select the options for how you want the filter to be used: as an automatic
filter to be invoked on any Incoming and/or Outgoing mail, and as a Manual
filter that can be invoked when you select Filter Messages from the Special
menu. Any combination of these options works.
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Third, define the criteria for the filter: use the header item popups and the text
fields to specify which header items should include a particular string of text. You
can define two related terms for the criteria so that your filter is as specific as
possible (see the section “Filter Criteria”).

Fourth, Define the action to be taken on messages that fit the criteria (see the
section “Filter Actions”) and save the filters.

Note: Filters are automaticalh/ named based on the critertafor thefilter.

You can re-order them using the Up and Down buttons above the
list.

When the filters are invoked (automatically or manually), each message is
matched against each filter in order from top to bottom. If the message meets a
filter’s criteria, the actions are done as specified until there are no more actions,
then the message is matched against the next filter. If at any point a Skip rest
action is done, nothing else is done with that message, and the next message is
filtered.

You can change the Width of the filters list to create more or less space for your
list. To do this, put the arrow over the bar to the right of the list and drag the line
to the left or right.

Filter Criteria (the Match Area)

Each filter can use one or two “terms” as its criteria, connecting them as
appropriate with the conjunction popup.

Use the Header field to specify which message header items you want the filter to
search. You can select an option from the popup menu or enter one yourself. This
is helpful if you want to use a header item that does not appear on the menu, such
as X—Persona (for an alternate personality). The selections are as follows:

' To

' Cc

' From

' Subject

' Reply-To

' «Any Recipient»

' «Any Header»

' «Body»
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The «Any Recipient» option searches all possible recipient items (To, Cc, Bcc),
the «Any Header» option searches all message headers (including hidden headers
that are shown with the Blah Blah Blah option), and the «Body» option searches
the message body.

Use the Match Type popup to control how the header item is matched with the
text string in the text field. The match options are:

contains or doesn’t contain . . _
If the specrfied header 1tem conta1ns or does not contain the text string, filter the
message.

is or is not

If the specified header item is or is not a complete match of the text string, filter
the message.

starts wither ends with_ . . .
If the specrfied header 1tem starts w1th or ends With the text string, filter the
message. The starts with item refers to the first non-whitespace character after
the colon, so any spaces after the colon are ignored.

appears or doesn’t appear _
If the header 1tem appears or does not appear in the message, filter the message
(the text field is ignored). This is useful for filtering messages based only on the
types of fields they contain.

intersects nickname . . . .
If the text string 1s 1ncluded 1n a n1ckname (whether it is a full address or a
nickname within the nickname), filter the message.

Use the Text fields to specify the text strings that the filter is searching for.

Note: It is recommended that the contents ofthisfield be kept as specific
and briefas possible. The greater the complexity, the less the
likelihood ofa match.

Use the Conjunction popup to link the two terms. The conjunction options are:

ignore

Ignore the second term; if the message matches the first term, filter the message.

and

If the message matches both the first and second terms, filter it.

or

If the message matches either term, filter it.
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unless

If the message matches both the first and second terms, do not filter it. (This lets
you exclude certain variations of the first term.)

Filter Actions

All messages that match the filter criteria are acted on as specified with the
Actions popups. Each filter can do up to five things to a message that matches the
criteria. You can use the same action twice if it does not directly affect the
original message (for example, Copy To can be used twice, but not Transfer To).

The Action options are as follows:

None

No action.

Make Status .
Assrgns the selected status to message summarles.

Make Priority . ‘
Assrgns the selected priority level to messages. If you select a set level, messages
are set to that priority. If you select Raise or Lower, messages are raised or
lowered one priority level based on their pre-filter level.

Make Label
Assrgns the selected label to messages.

Make Subject . . ‘ .
Assrgns the new sub] ect to message summarles (does not affect the SL1} ect 1n the
message itself), If you choose this option, the entire subject of the message is
replaced with the new subject. Use the “&” symbol if you want to add the new
subject to the old subject. For example, entering New Subject:& results in New
Subject:01d Subject.

Play Sound .
Plays the selected sound when messages are recelved.

Open

Opens the Mailbox and/or Message when a message is received. If you set a
previous action to filter messages into a mailbox, then that mailbox is opened.

Print
Pr1nts one copy of each message.
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Notify User _
Notifies you As normal and/or In report when messages are received. The As
normal option notifies you based on the options you have selected in the Getting
Attention Options. The In report option notifies you by displaying a filter report
that details what filter actions have been done.

Notify Application

Notifies the selected application when messages are received, and provides
information from the message. Specify the application to use and the part of the
message to be included.

Use the Browse button to select an application, or enter the commandline
yourself. The commandline should include the path to the executable, any options,
and the following substitution variables, all separated by blank spaces:

%1 Date

0/02 To

0/o3 From

%4 Subject
O/oS Cc

%6 The entire message

For example, the commandline to send the subject of a message to a pager might
look like this:

C:\apps\pager.exe -C %4

Forward To . . .
Forwards messages to the e-ma11 address glven. Forwarded messages are placed in
the queue in the Out mailbox, and sent the next time you send queued messages.

Redirect To . . . .
Redirects messages to the e-ma11 address glven. Redirected messages are placed in
the queue in the Out mailbox, and sent the next time you send queued messages.

Reply With . . _ _
Replies to messages w1th the selected statlonery message. Replies are placed in
the queue in the Out mailbox and sent the next time you send queued messages.

Server Options . .
Sets the message’s server actlon to Fetch and/or Delete (see the section
“Managing Your Mail on the POP Server”).

Copy To .
Copies messages to the selected ma11box.
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Transfer To .
Transfers messages to the selected mallbox.

Skip Rest . .
Stops filtering for the message (the message 1s not matched to the rest of the
filters in the list).

Sorting Messages Within Mailboxes

The message summaries in mailboxes are automatically sorted by date, in
ascending order (the newest messages at the bottom of the mailbox). To change
this, select the appropriate command from the Sort submenu from the Edit menu.
Or, click on any of the column headings to sort by that column. To sort in
descending order, hold down the Shift key and select a sort option.

 
The Sort submenu

Mailboxes are sorted based on the previous state of the mailbox. For example, if a
mailbox is sorted by date, and then you sort by sender, the messages are grouped
by sender and each group is in order by date.

Note: Sometimes sorting by Dale can be incorrect. This usually happens
ifz‘l’ie messages have incorrectlyformatted dale fields, or unknown
or incorrect time zones.

QUALCOMM Incorporated 77
MS 266848

THIS DOCUMENT IS CONFIDENTIAL AND FILED UNDER SEAL

AREND|315644



THIS DOCUMENT IS CONFIDENTIAL AND FILED UNDER SEAL 

Case 1:13-cv-00919-LPS   Document 312-1   Filed 03/10/21   Page 79 of 199 PageID #: 29692Case 1:13-cv-OO919-LPS Document 312-1 Filed 03/10/21 Page 79 of 199 PageID #: 29692

Organizing Your Messages Eudora User Manual

Finding Text Within Messages

Eudora incorporates a Find function that searches for specific text Within a single
message, multiple messages, or even multiple mailboxes To display the Find
submenu of commands, select Find from the Edit menu.

 
The Find submenu

Finding Text Within One Message

To search for text within a single message, open the message and make sure it is
current. Then, select Find from the Edit menu and select the Find command

from the submenu. The Find dialog is displayed, with the blinking insertion point
located in the text field.

Type the text you want to find in the text field. When finished entering the
desired text, click the Find button.

 
Finding text

Starting at where the cursor is in the message, Eudora searches the current
message for the specified text. If no match is found, the not found alert is
displayed.

If the search is successful, the message is scrolled to the first point Where the
match is found and the matching text is highlighted.

To continue searching in the same message for the next occurrence of the text,
click the Find button in the Find dialog, or select the Find Again command from
the Find submenu. These commands are equivalent and limit the search to the
same message. Repeating these commands cycles through the matches in the
open message only.
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Finding Text Among Multiple Messages and Mailboxes

The Next, Next Message, and Next Mailbox commands are located in the Find
submenu (under the Edit menu) or as buttons in the Find dialog.

Next

The Next button (or Next command) allows you to search for the next match of
the specified text until it is found either in the same message or in one of the
following messages in the current mailbox.

Next Message ‘
The Next Message button (or Next Message command) begins the search at the
message after the current message. Eudora continues to search until it finds a
matching character string, even 1f 1t has to open more than one message or a new
mailbox.

Next Mailbox

The Next Mailbox button (or Next Mailbox command) begins the search for the
specified text in the mailbox following the current mailbox. The search is
conducted among all messages in that mailbox and any subsequent mailboxes,
including the In, Out, and Trash mailboxes.

Note: Mailboxes are searched in the order they are listed under the
Mailbox menu until the current mailbox is reached.

When the character string isfound in a message, the message is
displayed Ctrl+ double-click on the message title bar to open the
mailbox that contains the message.

Match Case

Normally, Eudora ignores capitalization when searching. If you want Eudora to
consider capitalization when searching, check the Match Case option in the Find
dialog. When this option is checked, Eudora searches for exact matches of
character strings, including any capitalization.

Summaries Only

If you know the text you are searching for is included in a message summary,
check the Summaries Only option in the Find dialog. When you click the Find
button, Eudora searches for the text only in the Sender and Subject fields of
message summaries as they appear in mailbox windows. Eudora searches much
faster when this option is checked.
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Enter Selection Command

If you don’t want to actually type the text in the Find dialog (for example, the text
is very long or complex), highlight it in an existing message, and then select
Enter Selection from the Find submenu. This automatically inserts the selected
text at the insertion point in the Find dialog. Then, select the Find command from
the Find submenu to start the search.

Stopping a Find

If you want to stop Eudora from continuing a search, click the Stop button on the
progress Window or press the Esc key.

Saving a Message to a File

You can save a message to a separate text file on your PC. To do this, open or
select the messages you want to save. Then, select Save As... from the File menu.
The Save As dialog is displayed.

 
The Save As dialog

Enter the name you want to give the text file, and select the appropriate options.

Important: Be sure to change the Save as type: option to Text Files.
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Include Headers retains the first message’s header information in the saved
document. If this is not checked, only the body of the messages is saved.

Guess Paragraphs removes extraneous carriage returns from the message,
leaving returns only at the ends of paragraphs, and converts multiple spaces into
tabs

Stationery saves the message as a “stationery” file (if you are saving an incoming
message, this option is not available). For details, see the section “Using
Stationery Messages.”

Once you’ve made all of your choices, click on the Save button in the dialog.

Note: Han unread (9 message is saved to afile, its status changes to
read, regardless ofwhether the message was opened.

If you select multiple messages from a mailbox window and select Save As..., all
of the messages are saved to a single file.
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Using the Address Book

The Address Book is where you keep information about individuals or groups that
you correspond With. Each entry in the Address Book includes a nickname for a
person or group, their full e-mail addresses, a real name, any contact information,
and any notes. You can also use the Address Book to put nicknames on the Quick
Recipient List, and to address a new message.

To open your Address Book, select Address Book from the Tools menu.

  
The 32-bit Address Book with example entries
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All of the Address Book entries are kept in files. The example above shows files
for Business, Family, and Friends (Eudora Nicknames is the default file). In the
32-bit Address Book, you can show or hide the entries in a file by double-clicking
on the file. The icon shows an open or closed book, depending on whether the file
is open or closed. In the 16-bit Address Book, files are flush to the left, and their
entries are listed under them.

You can use the View By option to display the entries using any of the fields
except the Notes field. For example, if you want to View the entries by nicknames,
select View By Nicknames. If you View by a field that doesn’t contain any data,
the entry is displayed with <<>>.

You can also start typing in the list of entries, and the appropriate entry will be
selected when you enter enough unique characters to identify it.

To page up and down in the list of entries, use the arrow keys. To resize the list,
drag the divider.

To close and open the right-hand side of the Address Book, use the << and >>
buttons.

Creating New Entries

To create a new file of Address Book entries, click on New. A dialog is displayed
asking what you want to call it.

 
Creating a new file or entry

Enter a name for the file and select Make it a file, then click OK to create it. The

file is displayed in the list, and you can now add entries to the file.
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To create a new entry to be included in an existing file, do one of the following:
click on New in the Address Book, select an address from anywhere in Eudora
and drag it to the Address Book, or drag a message summary to the Address
Book.. A dialog is displayed. Enter a Nickname for the entry. A Nickname
(sometimes called an alias) is an easily remembered, shorter substitute for the e-
mail addresses in the entry. Nicknames can be used in place of proper e-mail
addresses in the To, Cc, and Bcc fields of outgoing messages.

Specify which file this entry belongs in (if you have multiple files), and select the
Put it on the recipient list option if you want the nickname on your list. You
cannot create a file within a file, so do not use the Make it a file option. Click
OK to create the entry. Then you can enter the information for that entry.

In the Address(es) tab, enter the complete e-mail addresses of the people (or
person) to be included in the nickname, separating the addresses with commas or
returns (this is the only place you can use a return to separate addresses). You can
also use nicknames in this field, but be sure that any nicknames you use are
defined in their own entry. You can use a miX of nicknames and complete e-mail
addresses.

Note: Be sure there is no other information in thisfield except addresses
or niclmames, or your messages will be addressed incorrectly.

In the Name field (in the Info tab), enter the real name of the person or group. If
there is just one address for the entry, the real name and the address are included
in the To field for your recipient to see. If there is more than one address for the
entry, the real name is the only thing included in the To field for your recipients—
they do not see the whole list of recipients. If there is nothing in the Name field,
the recipients do see the whole list.

In the other fields provided in the Info (Phone, Fax, and Postal Address) and
Notes tabs, you can enter contact information for the person or group, and any
notes to yourself. This information is not included in outgoing messages.

It is recommended that you have at most 2,500 entries per file. If you have a large
number of entries, you may want to consider using a Ph server (for information,
see Appendix A).

To save your changes to the Address Book, select Save from the File menu.
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Changing, Moving, Copying, and Deleting Entries

To make changes to an entry (including changing the name of the entry, the
nickname for it, and any information in the Address, Notes, or Info tabs), select
the entry from the list and edit the fields as appropriate.

Important: Ifyou change a nickname, but sure to correct any entries that
reference that nickname.

To move or copy an entry to a file, right-click on it and select the Move T0 or
Copy To command. The Choose a Nickname File dialog is displayed so that you
can select the file you want to move the entry to.

In the 32-bit version, you can move an entry (or entries) to a different file by
dragging it, or copy it by holding down the Shift or Ctrl key then dragging it.

Note: You cannot move an entry into the file it is already in, but you can
copy an entry into itsfile (a ”Copy ofEntry ” is created}.

To delete an entry or an address file, select it from the list and click on the De]
button or the Delete key. You cannot remove the Eudora Nicknames file.

Note: Ifa ntcknameflle is set to read-only (you do not have permission to
write to 1'0, you cannot move or copy entries into it, or delete an
entryfiom it.

To save your changes, select Save from the File menu.

including Nicknames on the Quick Recipient List

To include a nickname in the Quick Recipient List, select the appropriate Address
Book entry from the list and click on the Recipient List option (next to the
Nickname field). The nickname for the selected entry is included on the Quick
Recipient List.

 
  ickname Everyone l 
 

 
 ‘ Eudora Nicknames

' e
a in  

The Recipient List option
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If you change a nickname or remove an entry, the Quick Recipient List is updated
as appropriate. For details about using the Quick Recipient List, see the section
“Using the Quick Recipient List.”

Note: You can add or remove multiple nicknames to orfrom the Quick
Recipient List by selecting multiple entries. Hold down the Ski]?
key to select multiple entries in sequence, or the Ctrl key to make
digoint selections.

Addressing a Message from the Address Book

You can open and address a new message from the Address Book using the To,
Cc, and Rec buttons.

To create a new message from the Address Book, select the entry to which you
want to address the mail (hold down the Shift key to select multiple entries in
sequence, or the Ctrl key to make disjoint selections). Then click on To, Cc, or
Bcc. A new composition window is displayed with the selected nickname(s)
inserted in the appropriate field.

Note: You can also double-click on an entry to enter that nickname in the
Tofield.

To address the message with the addresses in the Address(es) field (instead of the
nickname), turn on the Expand Nicknames option.

Once the composition window is displayed, you can use the To, Cc, and Rec
buttons to insert additional nicknames into the corresponding fields.

The “Make Address Book Entry” Command

The Make Address Book entry command is used to create entries in your
Address Book, and is especially helpful for making group entries.

In the Address Book, highlight several different entries (hold down the Shift key
to select multiple entries in sequence, or the Ctrl key to make disjoint selections),
then select Make Address Book Entry... from the Special menu. The New
Nickname dialog is displayed prompting you for the nickname of the new entry.
The Address(es) field of the new entry will include the nicknames for the entries
you selected, not the real addresses.
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Using the “Make Address Book Entry” command from the Address Book

In a mailbox, highlight the message summaries you want and select Make
Address Book Entry... from the Special menu. The New Nickname dialog is
displayed prompting you for the nickname of the new entry. Follow the
instructions for creating a new entry. If the current message is an outgoing
message, the new entry will include all of the addresses in the To, Cc, and Dec
fields. If the current message is an incoming message} the new entry will include
the address in the From field. If multiple messages are current (i.e., you have
several message summaries selected in a mailbox window), addresses are taken
from each message and are all put in the new entry.

Note: The Make Address Book Entry command uses the Reply Options. If

the Include yourselfoption is on, your address is included tr: the
new entry.
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In the Directory Services window, finish a Ph query, select the items that you
want to include in the entry (or do not select anything to use all of the items), and
select Make Address Book Entry... from the Special menu. The New Nickname
dialog is displayed so that you can name the nickname. The real name and e-mail
address are included in the new entry.

The “Finish Address Book Entry” Command

With the Finish Address Book Entry command, you can enter a unique portion
of a nickname in the To, Cc, or Bcc fields of a message, then select Finish
Address Book Entry from the Edit menu, and the nickname will be completed
for you. You must enter the characters in the nickname that make it unique, or
Eudora will not know which nickname to use. For example, if you have two
nicknames, jon and john, you would have to enter “j on” or “j oh” for Eudora to
complete them,

To insert the real addresses for the entry, instead of the nickname, hold down the
Shift key and select Finish Address Book Entry from the Edit menu. To set this
to happen all the time, turn on the Automatically Expand Nicknames option in
the Miscellaneous Options.

Using Central Address Book Files on a Server

You can set up central Address Book files on a server and configure Eudora
clients so that they refer to the central files.

First, be sure the files are plain text, have a .txt extension, and are formatted as
follows: One nickname on each line with the real addresses separated by commas,
and one line for notes and info with the Notes text following the Info data. For
example:

alias Wowjoe@wow.com,lisa@wow.com,chris@wow.com

note Wow <fax: 222.2223><phone: 222.2222><address:1 234 Street>

<name:Wow lnc.>My favorite company

Then, for each client application, add a ExtraNicknameDirs entry to the
[Settings] section of the EUDORAINI file. This entry should be followed by the
list of directories that contain Address Book files, separated by semicolons (;).
Any Address Book files located in those directories are added to the Address
Book. Users will need to exit and re-open Eudora to see the new entries.
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Using Address Book Files Not Created by Eudora

To use a Address Book file that was not created in Eudora, put the file in the
Nickname directory (in your Eudora directory), and be sure the format is as shown
in the section “Using Central Address Book Files on a Server.” You will need to
exit and reopen Eudora to see your new entries in the Address Book.

Using the Quick Recipient List

The Quick Recipient List is your list of recipients to whom you often send mail.

To add a nickname to the Quick Recipient List, check the Recipient List option
in its Address Book entry.

To add an e-mail address to the Quick Recipient list, select the text that makes up
the fiill address. Then, select Add As Recipient from the Special menu.

To remove an entry from the list, uncheck the Recipient List option in the Address
Book entry, or select the nickname from the Remove Recipient submenu from
the Special menu.

To open a new message addressed to someone on your Quick Recipient List,
select New Message To, Forward T0, or Redirect To from the Message menu,
and select the nickname from the displayed list.

To insert a recipient into a message that you have already opened, put the cursor
where you want the recipient and select Insert Recipient from the Edit menu.

To insert the real address(es), instead of a nickname, hold down the Shift key and
select Insert Recipient from the Edit menu. To set this to happen all the time,
turn on the Automatically Expand Nicknames option in the Miscellaneous
Options.

More than one recipient from the Quick Recipient List can be added to the To,
Cc, and Bcc fields of any message. If you use the Insert Recipient command,
commas are added where necessary.
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Opening Directory Services

Eudora can access two different directory services, Ph and Finger. To use these
services, you must put the name of the host machines for the Ph and finger servers
in the Hosts Options. The active Ph or finger server (defined in your Host
Options) is displayed in the Server field, which includes a popup list of the last 10
servers you have accessed.

To use the directory services, select Directory Services from the Tools menu.

Using Ph

To look someone up using Ph, enter the information (usually someone’s name)
into the command field and click on Ph. The command is sent to your Ph server,
and the response is displayed in the lower section of the window.

If there is more than one match, you can use the Tab key to move down to the
next one, or hold down the Shift key and press Tab to move up to the previous
one,

 
A Ph command and its response

Note: You can type any Ph command in the commandfield, except Iogin
commands or commands requiring login. For information about
the PI? server source code, see Appendix A.
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Finding Ph Servers

Some Ph servers keep a list of other Ph servers that are available on the Internet.
This is not always a comprehensive list of every Ph server out there, but it can be
helpful.

To get the list of servers that the active server knows about, click on the Server
button in the Directory Services window. A list of servers is displayed in the
results area. To go to one of those servers and do a query, double-click on the
servers URL.

Using Finger

To use the Finger protocol, enter the command and click Finger. The command

should be in the form “name@domain.” If you omit the “@domain” segment, the
host name displayed in the Server field is used. The finger command is sent to the
finger server, and the response is displayed in the lower section of the window.

Addressing a Message from the Directory Services Window

You can create and address a message with the command results in the Directory
Services window.

To create a new message, be sure there are no outgoing messages already open, do
the Ph or Finger command, and use the Tab key to select the right address (if there
is more than one). Then click on the To, Cc, or Bcc button. A new message is
created, and addressed appropriately with the query results.

To add an address to an existing message, make sure the message you want to
address is active, open the Directory Services window, do the Ph or Finger
command, and use the Tab key to select the right address. Then click on the To,
Cc, or Bcc button. The address from the query result is added to the appropriate
field of the current message.

To keep the Directory Services window on top so that you can easily continue
using it, turn on the Keep on Top option at the bottom of the window.
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Customizing the Main Toolbar

The Main Toolbar is a group of buttons that gives you easy access to your
frequently used Eudora commands.

 
The Main Toolbar

The 32—bit toolbar can be moved to wherever you want it on the screen. Just hold
down the left mouse button on the bar itself (not on a button) and drag it around
until you find a place you like. You can dock it to the top or bottom of the Eudora
window or put it anywhere on your desktop.

To add buttons to the 32-bit toolbar, right click on the toolbar, and select
Customize. The Customize Toolbar dialog is displayed.

 
essageflhange
tanslel
pedal
00!: 

The Customize Toolbar dialog
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Select a Eudora menu from the list on the left, then drag buttons from the list on
the right down to the toolbar.

To change the placement of a button on the toolbar, hold down the Alt key and
drag the button to where you want it. To remove a button, hold down the Alt key
and drag it off of the toolbar.

The 16-bit toolbar cannot be moved or changed.

The Main Window Icon

The main window icon displays when Eudora’s main window is minimized. It
provides a unique 1nd1cat10n of when new mail has been delivered, when outgomg
messages are queued, or both.

Q NormalThis is the normal state of the icon. There is no new mail and no messages are
udora queued and waiting to be sent.

E

9 New Mail
The mailbox is open and has a letter in it, indicating that new mail has been

Emma delivered.

@ Queued Messages
The flag on the side of the mailbox is in the up position, indicating that you have

EUdG'a outgoing messages queued for delivery.

Q New MaillQueued Messages
The mailbox is open and has a letter in it and the flag on the side of the mailbox

Eudflra is in the up position, indicating that new mail has been delivered and outgoing
messages are queued for delivery.

If you are using the 32-bit version of Eudora under Windows 95 or Windows NT
4.0, a New Mail notification icon in the Task Bar Tray also tells you when new
mail has arrived. You can hold the mouse over the icon and a tool tip tells you
how many messages you have, and if you double-click on the icon Eudora is
brought to the foreground. The icon goes away when you click the mouse button
or press a key inside the Eudora window.
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The Right Mouse Button

The commands that are available from the right mouse button are generally the
same as those on the main menu and toolbar, it is simply another access method.

To use the right mouse button commands, place the arrow over a Eudora window
and click on the right mouse button, then select a command from the list that is
displayed. The list varies depending on which window you are in and what tasks
you might need to perform while in that window.

If you have Eudora minimized, you can check for new mail without maximizing
the icon. To do so, place the arrow over the Eudora icon, click on the right mouse
button, and select Check Mail. If you want to turn the main toolbar or the status
bar on or off, right-click on the gray area of the toobar or status bar and select that
item.

Pfinfing

To print the current message or item, select Print... from the File menu. Eudora
automatically prints headers and footers on each page, giving the window title,
page number, and your return address.

Plugins (Extended Messaging Services)

Plugins are special add-ons that can be installed to add features to Eudora. For
example, you could use a language conversion plugin to translate a message to
another language, a security plugin to automatically secure a message, or a text
manipulation plugin to change lowercase to uppercase. Plugins interface to
Eudora using the Extended Messaging Services Application Programming
Interface (EMSAPI).

To make plugins available to Eudora, put them in the Plugins directory in your
Eudora directory, then restart Eudora. Depending on the plugin type, it will be
available in Eudora through the following methods:

' The Message Plugins submenu (in the Edit menu) typically includes plugins
that are used to modify the text of a message. These are referred to as on-
request plugins. Some samples of these types of plugins are available with
Eudora: Sort, UpperLower, and Unwrap.

' Icons in the message window are typically for plugins that are used to
manipulate messages as they are sent or when they are received. These are
referred to as on-transmission and on-display plugins.
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- The Tools menu typically includes plugins that are used to do tasks that are not
directly related to Eudora functions. These are referred to as tools plugins.

- The Attach submenu (in the Message menu) typically includes plugins that are
used to create and attach particular files to a message. These are referred to as
attachment plugins.

- Plugins that are automatically used when a message is received are not
available through the user interface.

To see all of your currently installed plugins, select Message Plugins Settings
from the Special menu. If a plugin has any settings options, you can use the
Settings button to change them. For information about available plugins, send

e-mail to <eudora-rep@eudora.com> or visit the World Wide Web site
<http://www.eudora.com/>.

The Messaging Application Program Interface (MAPl)

96

MAPI is an interface that lets you send e-mail messages from any MAFI-
compatible application, such as your word processor, spreadsheet, graphics
application, etc. See Appendix F for technical details on the Eudora MAPI server.

MAM-compatible applications have a Send or Send Mail option in the File
menu. When you select the option, the Eudora MAPI server displays a new
outgoing message with your current document attached. All you need to do is
address the message, type any details you want to include in the body of the
message, and click Send or Queue.

To run the Eudora MAPI server, use the MAPI Options dialog. To display the
MAPI Options dialog, select Options... from the Tools menu and click on the
MAPI category (see the “Options Dialog” section). You have several options in
the MAPI Options dialog for loading the Eudora MAPI server. You can set it to
always run or to run only when Eudora is running, or you can specify that it never
run. These three options open or exit the server as soon as you select them.

Note: When you are running the Eudora MAPI server, Microsoft
Exchange will not work. Ifyou need to use Exchange, turn offrhe
Eudora server.

You also have several options for saving or deleting MAPI attachments. When
you use MAPI to attach a file and send a message, that file is immediately copied
into the Attach directory (or a directory you have specified). You can use the
MAPI options to save those copies, delete them after sending their corresponding
messages, or delete them after their messages are emptied from the trash.
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Putting Multiple Users on One PC

If you have a multiple-user license for Eudora, you can set it up so that more than
one user can be on a single PC. This also works if you have multiple e-mail
accounts but you don’t want to have alternate personalities set up and using the
same set of mailboxes. You will need to Exit and reopen Eudora to switch users.

Reference

Multiple users with Windows 3.x or Windows NT 3.51

To have multiple users on one PC, make a separate directory for each user and
copy the original eudoraini file into each one (the directories can be put anywhere
you like, including on floppies or network drives). Then create a separate program
item for each user and point the command line to the new eudorajni file, as
shown in the example below:

'= Program Item Properties

Qeseription:
gemmand Line:
florking Directory:
fihortcul Key:

J oe's M ail  

eudora_exe c:\ioesmail  

 
None  

Cancel

grouse...    
  
  Hun Minimized  Change Leon...

Correcting the properties for each user’s program item

Note: Be sure to change the account information in the Getting Started
Options.

If you don’t already have a program item set up for your original Eudora
directory, you should probably do that. Be sure that the command line gives the
path to the original eudoraini file.
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Multiple users with Windows 95 or Windows NT 4.0

To have multiple users on one PC, make a separate mail directory for each user
(the directories can be put anywhere you like, including on floppies or network
drives), and put a copy of the eudoraini file into each user’s directory. Then, for
each user, create a shortcut to the Eudora executable (eudoraexe). Right-click on
the new shortcut and select Properties, then click on the Shortcut tab. In the
Target field, add the path to the user’s eudoraini file, as shown in the example
below.

 
Specifying a mail directory

Note: Be sure to change the account information in the Getting Started
Options.
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Troubleshooting

Occasionally, you may encounter a problem or bug when using Eudora; this
section includes information to help you solve those problems. You can also
check the Eudora Technical Support Web Pages at
<http://www.eudora.com/techsupport>.

If you are having problems, try the following:

Be sure that you have the current release of Eudora.

Be sure that your POP account is set correctly. This is probably different than
your e-mail address, so double-check that you have the right information.

Be sure your SMTP server is set correctly. This may or may not be the same
machine as your POP server.

Be sure you are entering your password correctly, paying attention to upper and
lower case letters (make sure the Caps Lock key is off).

Be sure the date is correct on your computer, especially the year.

Be sure the Winsock option is on (in the Getting Started Options) unless you
are using a shell account. (If you can use a browser, use Winsock.)

Be sure Eudora can find your winsock.dll. If Eudora cannot find it, be sure the
Path line in your AUTOEXECBAT file includes the directory that contains
the winsockdll. Or, if you do not want to edit your AUTOEXECBAT file, try
copying your Winsockdll into the Eudora Pro directory.

Toggle both of the Use asynchronous Winsock calls options (turn them on if
they’re off, or vice versa) in the Advanced Networking Options.

Run ScanDisk to check for problems on the hard drive.

If you’re having trouble with your mailboxes (especially with repeated requests
to rebuild a mailbox’s table of contents), quit Eudora and find the mailbox’s
.toc file in the Eudora directory. Change the .toc extension to .000, then open
Eudora and see if the problem persists.

Windows 95 users: If you’re having other problems, especially crashes, remove
all of the items in your Startup directory (C:\Windows\Start
Menu\Programs\StartUp), then restart Windows while holding down the P8
key. In the Startup menu, select Safe Mode. Then open Eudora and see if the
problem persists.
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Errors

The following are possible errors and alerts you could recieye from Eudora, and
suggestions for fixing them.

“-ERR Maildrop lock busy”

This usually happens after your PC has “hung” during a mail check and you
are now attempting to re-connect to the mail server The best thing to do is
to contact your e-mail administrator and tell them that you have a POP3
server process that needs to be disconnected.

“503 Need RCPT (Recipient)”

You must include at least one recipient in the To field for your message to
be delivered. If you have a nickname in the To field, be sure that in the
Address Book at least one e-mail address or valid nickname is included in

the Address(es) tab. If the Address(es) tab is blank, there are no recipients
and this causes the error.

“Error getting a network socket. Cause: no buffer space available

(10055)”

The buffers the error message is referring to are TCP buffers. TCP/IP stacks
need buffers where they can store data that goes to/from the network. Since
at a low level the data has to be sent to a hardware device, the buffers

generally have to be in low memory (i.e., < 1MB). This is valuable space
for most users, so most TCP/IP stacks have a way of controlling how many
of these buffers the user wants allocated. If you’re using a lot of other
network applications at the same time (especially X Windows, which uses a
buffer for each window), then you might get this error. The other case that
this error might occur is the TCP/IP stack not correctly marking buffers as
being unused, so you have a buffer not being used that the stack thinks is
being used.

“Could not rename lmos.tmp t0 lmos.dat”

Quit Eudora, and go to your Eudora directory. Find the files called
lmos.tmp and lmos.dat and delete them both (lmos.tmp may not be there,
that’s not a problem). On your next mail check you may get some mail that
you have already received, but that should only happen once.
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Formatting and Printing

The following are possible formatting and printing problems, and suggestions for
fixing them.

You received a message containing columns and the columns are not

lining up correctly.

Your screen font is probably a proportional font. Change your display font
to a non-proportional font (such as Courier) in the Fonts & Display Options.

You have a message that is printing with strange line breaks.

When most e-mail programs send out messages, they insert hard returns at
around 75-80 characters. (If they didn’t, some e-mail applications would
only be able to display the first 80 characters or so of a very long line of
text.) What's happening with your message is that the width of the line that
fits on the printed page is shorter than 75-80, so the hard returns end up in
the wrong place.

The solution is to make the print font smaller, or choose a font that is closer
together (like Helvetica instead of Courier, for example). These settings are
in the Fonts and Display Options.

Miscellaneous

You want to set up a password check for sending mail, not just checking mail.

SMTP servers, which are used to send mail for most e-mail accounts, do not

require a password for access like a POP server does. However, if the POP
daemon your server is using is descended from the UC Berkeley POPper,
you can use the POPSend protocol, which routes SMTP calls through the
POP server, so the POP server requires the password.

If you turn this feature on in your POP server, add this line to the Settings
section of the eudoraini file:

UsePOPSend=1

This means you will have to enter your password to send as well as check
mail. However, it's not terribly secure since users who know what they’re
doing can simply remove that .ini file line or uncheck the Use XTND XMIT
option and disable the feature. But it will protect you against inexperienced
but unscrupulous users.

QUALCOMM Incorporated 1 01
MS 266872

THIS DOCUMENT IS CONFIDENTIAL AND FILED UNDER SEAL

AREND|315668



THIS DOCUMENT IS CONFIDENTIAL AND FILED UNDER SEAL 

Case 1:13-cv-00919-LPS   Document 312-1   Filed 03/10/21   Page 103 of 199 PageID #: 29716Case 1:13-cv-00919-LPS Document 312-1 Filed 03/10/21 Page 103 of 199 PageID #: 29716

Reference Eudora User Manual

The Options Dialog

The Options dialog lets you specify how you want to use Eudora. To display the
Options dialog, select Options... from the Tools menu.

The Options dialog contains many categories, which are described below. The
default setting for each option is listed in brackets after the name of the option.

Note: For your convenience, some options appear :‘n more than one
category. For example, your real name appears in both the Getting
Started andPersonal Information Options. Changing a setting in
one group changes the setting in all groups.

Getting Started

The Getting Started Options determine the minimum information necessary to
send and receive mail. The information here is for your “dominant” personality.

 

Checking M ail
.;_;.,§.

Sending Mail
 

«i;

 
The Getting Started Options
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POP account [none]
This is the address for your account on the POP server. Enter your POP account

name, an “@” sign, and the full domain name of the computer. For example, if
your assigned POP account name is “justine,” and the name of the computer
where you receive e-mail is “pop3.qualcomm.com” type

“justine@pop3,qualcommcom” in this field.

Note: Be sure to use your POP account ithl's may or may not be your
e-mail address. Ifyour e-mail address is diflerent than your pop

account, putyour e-mail address in the Return Addressfield ofthe
Personal Info Options.

Real name [none]

This is your real name. It is included in the From field of outgoing mail.

Connection method [Winsock] . . .
This speCIfies how you are connectlng to the network. If you are usmg Eudora Via
TCP/IP software (e.g., a direct network connection, SLIP, or PPP), select
Winsock. If you are using Eudora without TCP/IP software, select Dialup. If you
don’t want Eudora to attempt to make any connections, select Offline.
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Personal Info

The Personal Info Options determine your personal information.

Q:J. [3372
Penguin-3| Inlo

 

 

Checking M ail
925%

S ending M ail

é :-:-:

Fleplying
  

The Personal Info Options

P0_P account [none]
This IS the address for your account on the POP server.

Real name [none]

This is your real name. It is included in the From field of outgoing mail.

Return address [none] . . . ‘
This is your e-mail address. It is included in the From field of outgomg messages,
and when a recipient replies, this address is used. Your POP account is used if you
do not enter an address here.

Note: Ifyoa do enter an address in thisfield, first test the address to be
sure that mail sent to it is indeed delivered to you. [fyou use an
invalid return address, no one will be able reply to your mail.

Dialup username [none] . _ .
This IS your dialup username. If you use Eudora With the Communications
Toolbox, and you have a secondary user name for use during the dialup process,
enter it here (e.g, your login name on a terminal server). See Appendix E for
details regarding how this field can be used.
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Hosts

The Hosts Options determine what servers to use.

63;,»

Checking M ail

3%

Sending Mail

4:.
E

Replying

Attachments

 
The Hosts Options

POP account [none]
This is the address for your account on the POP server.

SMTP [none]

This is the name of your SMTP server. If the computer that your POP account is
on also runs an SMTP server, you can leave this field blank.

Note: Kym; use UUCP as your mail transport, see Appendix F.

Ph [none]

This is the name of your Ph server. It is necessary for doing Ph queries in the
Directory Services window.

Finger [none] .
This is the name of your finger server. If you leave th1s blank, Eudora uses your
SMTP server as your finger server.
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Checking Mail

The Checking Mail Options determine how Eudora checks for and receives your
incoming mail messages.

8 ending M ail

firs.
:3

Fl eplying

E?
Attachments

Personalities

   
The Checking Mail Options

P0_P account [none]
This IS the address for your account on the POP server.

Checkfor mail every ? minutes [none] .
lfth1s1s on and you enter a number, Eudora automatically checks your POP
server for new mail at regular intervals and transfers any mail addressed to you to
your PC. The number you enter specifies the number of minutes between checks.
It’s a good idea to set this at no less than 15 minutes. Checking mail more
frequently puts an unnecessary drain on your POP server. This option only works
when Eudora is running. Leaving this field empty disables automatic checking
(even if the box is checked).

Skip_m.essages over ? K [off, 40] . . _
lfth1s1s on, messages over the spec1f1ed Size are downloaded only in part. These
messages include the first few lines, and a statement that says the message is not
complete. This can be useful on slow connections. For details, see the section
“Managing Your Mail on the POP Server.”
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Send on check [on] . _ '
If this is on, any messages that are queued 1n the Out mallbox are sent when mail
is checked (automatically or manually).

Save password [off] . . .
If this is on, your password is remembered even 1f you qu1t and restart Eudora, so
you’ll never be prompted to enter it. Only use this option if your PC is in a secure
place.

Leave mail on server [off, none]

If this is on, Eudora copies incomlng messages to your PC and leaves the message
on the POP server. For details, see the section “Managing Your Mail on the POP
Server.”

Delete from server after ? days [off, 9] . .
This option has a check box for turn1ng 1t on and off and an edit box for
specifying the number of days mail that was left on the server should be saved
before being deleted. It is a good idea not to leave copies of your messages on the
server indefinitely, as this will create mail storage problems on the server.

Determine first unread message by [First message not read by this machine]
Eudora has the capabihty to track unread messages on your desktop, instead of
relying solely on the POP server to mark the messages as unread. This option
allows you to select what constitutes an unread message.

The choices are as follows:

First message not read by this machine - any message not previously read by this
machine is considered unread.

Status: headers - any message not identified as read in the message Status: header
is considered unread. Old versions of Eudora used this method exclusively.

POP3 LAST command - any message after the LAST downloaded message is
considered unread. This method is more efficient than the Status: headers method

when connecting to a POP server that supports the LAST command.

If you want to get all your messages on multiple PCs, on each PC select First
message not read by this machine, and set the Delete from server after ‘3 days
to a number of days that will allow you to check for mail on each PC.
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If you want to get all your messages on one PC but also want to be able to read
new messages from other machines, on each PC select First message not read by
this machine. On the PC that you use for all your messages, turn off Leave mail
on server. On the PCs that you use to read new mail, turn on Leave mail on
server.

Deletefrom server when emptied from trash [oft] .
If this is on, any messages that are deleted from your Trash mallbox are also
deleted from the POP server. For details, see the section “Managing Your Mail on
the POP Server.”

Authentication [Passwords] . .
This specrfies wh1ch authent1cat10n technology to use: Passwords, Kerberos, or
APOP. Ask your e-mail administrator which one to use.
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Sending Mail

The Sending Mail Options determine how Eudora sends your outgoing messages.

  

Fonts .. isplay

   
The Sending Mail Options

Return address [none]
This is your e-mail address.

Domain to add to unqualified names [none] . ‘
This IS the domain name that Eudora automatlcally adds to an unqualified name.

An unqualified name is a name that doesn’t have an “@” sign followed by a
domain name. This can be used to save time when addressing large numbers of
messages to users in the same domain.

SMTP server [none] _
This is the name of your SMTP server. If the computer that your POP account is
on also runs an SMTP server, you can leave this field blank.

Immediate send [on] . _ _
If this is on; the rightmost button 1n the Toolbar of the message composrtion
window is labeled Send. Clicking on this button immediately sends the message
to the SMTP server. If this option is off, the button is labeled Queue and clicking
on it places the message in the Out mailbox marked ready for delivery (Q).
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Send on check [on] . . .
If this is on, any messages that are queued 1n the Out mailbox are sent when mail
is checked (automatically or manually).

Default stationery [_no default] .
If a stationery file is selected, that file is used when you open new messages
(except with the Redirect or Send Again commands).

The message toolbar is set according to how the stationery message was saved,
regardless of how the options below are set. But, you can always change them
after you open the message.

Default signature [no default] . .
If a Signature is selected, that s1gnature is used on the toolbar of new messages.

Worsiwrapionl. . . . .
If this is on, carriage returns are automatically inserted in long lines when the
message is sent, creating roughly 76 characters per line. This makes the message
legible on the recipient’s computer. It is a good idea not to include your own
carriage returns within paragraphs if you have this option on—only use carriage
returns to create new paragraphs. It is strongly recommended that you leave this
option on.

Keep copies [off] _ .
If this is on, a copy of each message you send is kept in the Out mailbox. If this
option is off, outgoing messages are put in the Trash mailbox after they are sent.

May _use Quoted-Printable [on] . _
If this is on, Eudora uses quoted-printable encoding when necessary, such as
when messages that contain long lines of text or special characters are sent. If this
option is off, quoted-printable encoding is never used. We recommend that you
leave this option on.

Tabs in body of message [on] . . ‘ . .
If this is on, pressing the tab key Within the message body inserts a tab. If it is off,
pressing the tab key within the message body moves the cursor to the To field.
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Replying

The Replying Options determine how replies are created.

Replying

Attachments 
The Replying Options

Map_Ctrl+R to “Reply to All”[off] .
If this is on, when you hold down the Ctrl key and press R, a new message is
created addressed to all of the recipients of the original message.

Copy original’s priority to reply [oft] . . . _
If this is on, your replies use the same pr10r1ty as the onglnal message.

Automatically For. to original mailbox [off]. ‘ _
If this IS on, replies are automatlcally copled to the same mailbox that contains the
original message.

When replying to all [off]

This specifies how to address a reply. If Include yourself is on} when you Reply
to all (as described above) your address is left in the address list of the new
message and you receive a copy of your own reply. If this option is off, your
address is removed from the reply message and you do not receive a copy of the
reply. If Put original To: recipients in Cc: field, not To: field is on, the
addresses of the original message recipients are moved from the To field to the Cc
field of the reply to all message. Only the address of the original sender is placed
in the To field.
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Attachments

The Attachments Options determine how Eudora sends and receives attachments.

F'elsonalities

Fonts 3: Display

Style ext

of
ABC

Spell Ch cking
  

The Attachments Options

EncodingMethod [MIME] .
This specifies what Encodlng Method to use for attached documents. To change
the method for just the current message, use the Attachment Type popup in the
outgoing message window. For details, see the section “Attaching a File to a
Message”).

Put text attachments in body of message [oft] _ '
If this is on, Eudora puts any p1a1n text attachment you send directly in the
message body, as if it were typed in manually.

Attachment Directory_[none] . . ‘ .
This specifies what d1rectory to put 1ncom1ng attachments into. To spec1fy a
folder, single-click on the folder name button. A dialog is displayed prompting
you to select a folder.
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Delete attachments when emptying Trash [oft] ‘ .
If this is on, Eudora automatlcally deletes an attachment received with a message
when that message is deleted. The attachment must still be in the folder defined as
the Attachments Folder. If you want to save an attachment but delete the message,
move the attachment to another folder or turn this option off.

Delete Automatic attachments: [When message emptied from Trash]
This spec1fies how to handle attachments to automatlcally generated messages,
such as is created with the Insert System Configuration command

Never

If this is on, automatic attachments are never deleted from the attachment

directory.

After sending message ‘
If this is on, automatic attachments are deleted from the attachment directory
when their corresponding messages are sent.

When message emptied from Trash ‘
If this is on, automatic attachments are deleted from the attachment directory
when their corresponding messages are emptied from the trash.
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Personalities

The Personalities options determine your alternate e-mail accounts.

<Dominant>

 

Fontsllc" isplay

Styled Tel-it

W"ABE

Spell Checking

M ailbox Columns
  

The Personalities options

Personality . . .
A popup menu of your alternate e-mall accounts, or “personalities.”

The New, Add/Modify and Delete buttons let you create a new personality, add
it to the list, and modify or delete the selected personality.

To set the following options for a personality, just be sure that personality is
selected in the Personality field (select it from the popup). The options for the
Dominant personality are reflected in the other Options categories—if you change
them in the Personalities Options they will change in other categories.

Real Name . . . _ _
The real name. For detalls about th1s optlon, see the sectlon “Getting Started
Options.”

POP Account . . . . .
The POP account. For detalls about th1s optlon, see the section “Getting Started
Options.”
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Default Domain . .
The default domain. For detalls about this option, see the section “Sending Mail
Options.”

Return Address .
The return address, if different than the POP account. For details about this

option, see the section “Personal Information Options.”

SMTP Server

The SMTP server, if different than the POP server. For details about this option,
see the section “Hosts Options.”

Default Signature

The default Signature (select one from the popup). For details about this option,
see the sections “Using a Signature” and “Sending Mail Options.”

Default Stationery
The default stationery (select one from the popup). For details about this option,
see the sections “Using Stationery” and “Sending Mail Options.”

Check Mail

If this is on, mail checking is enabled for the personality. If you have specified a
number in the Check for mail every ? minutes option in Checking Mail, mail is
checked automatically. If you manually check for mail (using the Check Mail
command from the File menu), then mail is checked for the personality.

Leave Me" on Server . .
If this is on, mail for the persona111ty is left on the POP server and a copy is
transferred to your PC.
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Fonts & Display

The Fonts & Display Options determine how Eudora displays windows and text.

 Styled :-:t

ABE

Spell Checking

 M ailbox Columns

“é:  
The Fonts & Display Options

Screen Font: [Courier New,9]

This field lists the font to be used for displaying the text of your Eudora messages
and mailbox windows. It also lists the point size of the font. To change the
selection, click on this field. The Font dialog is then displayed, allowing you to
select a new font and size.

Print Font: [Courier New,12] . . _ ‘
This field lists the font to be used when pnntlng messages usmg the Print...
command. It also lists the point size of the font. To change the selection, click on
this field. The Font dialog is then displayed, allowing you to select a new font
and size.

Message Window Width: [80] _ . .
This field spec1fies the w1dth of new and recelved message Windows (in
characters). If you leave this field blank, the default value is 80. This setting has
no effect on what your mail looks like when it is sent. When mail is sent, Eudora
wraps at or before 76 columns.

Note: Ifyoa use aproportionalfont, Eudora sets the window Width based
or: the average width offhe characters in thefonf.
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Message Window Height: [20]

This field specifies the height of new and received message windows (in lines). If
you leave this field blank, the default value is 20.

Note: che Zoom windows when opening option is turned on, received
message window heights are automatically adjusted to the height
ofthe message text.

Zoom windows when opening [on] . . _
If this option is on, new message w1ndows automatlcally open to their “zoomed”
size. The zoomed size is computed on a window-by-window basis. For message
windows, zoomed size is just long enough to display all of the message (but no
longer than the main window), and as wide as the Message Window Width
setting. Composition windows zoom to the height specified by the Message
Window Height setting.

Show tool_bar.[on] ‘ . . . _ _
If this option is on, the ma1n w1ndow toolbar 1s d1sp1ayed (see the “Main Window
Toolbar” section).

Show toolbar tips [on] . . ‘ _ _
If this option is on, holding the mouse p01nter over a button in the main WlndOW
toolbar displays a very brief description of that button’s function.

Show status bar [on] . .
If this option is on, Eudora d1sp1ays a status bar at the bottom of the main
window. The status bar provides a brief description of menu items and toolbar
buttons.

Show category icons [on] . . ‘ .
This option allows you to turn the Category 1cons 1n the Options dialog on and
off.
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Styled Text

The Styled Text Options determine how styled text is sent and received.

I - \

Getting Attention
  

The Styled Text Options

Warn me when I queue amessage with styled text _
If this IS on, a warnlng d1alog 1s d1sp1ayed 1f you queue a message With styled text.

Discard styles before sending messages . .
If this IS on, styles are not sent w1th messages. Even if you have used styles in a
message, that information is not sent with the message.

When receiving styles pay attentionto . _ . _
If any of these are on, they can be d1sp1ayed1n1ncom1ng messages (if the message
includes the style).
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Spell Checking

These options control the spell checking options.

Extra Warnings
1111011110

   
The Spell Checking options

Ignore capitalized words [oft] .
Ignores words that start w1th cap1tal letters, such as proper nouns.

Ignore words with numbers [on]
Ignores words that contam numbers.

Ignore words with mixed case [oft]
Ignores words that contam both upper and lower case characters.

Report words with mixedcase [on] _ _
Reports words that conta1n both upper and lower case characters and Identlfies
them as Mixed case.

Report doubled words [on] . . . . ‘
Reports words that appear tw1ce 1n sequence 1n text and 1dent1f1es them as
Doubled words.

Always suggest [on] . . _
D1splays Eudora’s suggest1ons for the correct spell1ng of an unknown word 1n the
Suggestions field by default.

QUALCOMM Incorporated 1 19
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Ignore original text [on] .
Ignores any text that 1s preceded by a “>”. Eudora assumes that thrs text was
originally from another message, and therefore does not need to be checked.

Check when message queue/send selected [oft]
Checks the spelhng of messages when you use the Queue or Send commands.

Warn me when [queue/send a message without completing the spell check [on]
Drsplays a warnlng 1f you are checklng spelhng on outgomg mall but Clld not
complete the spell check.
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Mailbox Columns

The Mailbox Columns Options determine which columns are displayed in
mailbox windows.

Extra Warnings
lflIfllfllfl    

The Mailbox Columns Options

Show columns [Status, Priority, Attachments, Label, Sender, Date, Size, Server,
Subject]

If any of these options are on, that column is displayed in mailbox windows.
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Labels

The Labels Options determine the title and color of the seven labels that can be
used to categorize messages.

a? la...“

Getting Attention

A.
Extra Warnings

inioinio 

dvanced N etwolk

£3?

  
The Labels options

To change a label title, type the new title in the field to the right of the label
number. To change a label color, single-click on the label number to display the
Color dialog.

 
The Color dialog

1 22 QUALCOMM Incorporated
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You can select from one of the pre-defined Basic Colors or create your own
Custom Colors, To assign a basic color to a label, select the color and click OK.
To create a custom color, click the Define Custom Colors button to display the
custom colors palette.

 
The custom color palette

To define a custom color, select one of the 16 custom color boxes. Using the
mouse pointer, click anywhere on the color palette to select the color Hue and
Saturation. Use the color control bar to the right of the color palette to adjust the
color. When you are satisfied with the color, click the Add to Custom Colors
button. Once you have completed creating the custom colors, select the desired
label color and click OK.
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Getting Attention

The Getting Attention Options determine what Eudora does when it is running in
the background and wants your attention, or when new mail arrives.

 
Extra Warnings

iniqium

___A___
Advanced N etwo

MAPI
  

The Getting Attention Options

Use an. alert [on] . . . ~ _
If this IS on, an alert d1alog not1fies you when new mall is recelved.

Open mailbox (new mail only) [on] . ‘ _ .
If this IS on, mallboxes are automat1cally opened when new mall arrives in them,
and the first unread message of the last unread batch of messages is selected.

Play_a sound [on] . .
If this IS on, a sound 1s played when Eudora needs attention. To select a sound
(.an) file, click on the button below the Play a sound option. The Select sound
file dialog is then displayed, allowing you to select a sound.

Generate Filter Report [on]_
If this IS on, a filter report 1s generated when filters are used.

1 24 QUALCOMM Incorporated
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Extra Warnings

The Extra Warnings Options determine whether you are warned before making a
possible mistake. Most of the warnings are displayed with an option to stop that
warning from being displayed again. If you chose that option, you can turn the
warning back on using the Extra Warnings Options.

111191010

3”:

Advanced Netwoik

Kerbeios     
The Extra Warnings Options

Delete ‘unreacl mail [on] . ‘
If this IS on, you are warned 1f you try to delete unread mail.

Delete queued mail [on] . ‘
If this IS on, you are warned 1f you try to delete queued mail.

Delete _unsent mail [on] .
If this IS on, you are warned 1f you try to delete unsent messages.

Queue‘a message with no subject [on] ‘ ‘
If this IS on, you are warned 1f you try to queue a message With no sub} ect.

Queue‘a message with styled text [on] ‘
If this IS on, you are warned 1f you try to queue a message wrth styled text. (You
can also use the Styled Text Options to set several options related to styled text.)
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Quit_with messages queued to be sent [on] .
If this IS on, you are warned 1f you try to qu1t Eudora and you have queued
messages.

Queuea message bigger than ? k [on, 500] . _
If this IS on, you are warned 1f you try to send a message whose Size IS more than
the specified number. This number must be between 0 and 1000000,

Set a changed message back to read-only [on] . ~ ‘
If this IS on, you are warned 1f you try to make an edited incommg message
uneditable.

Emptythe Trash mailbox [on] .
If this IS on, you are warned 1f you try to empty the Trash mailbox. Once
messages are deleted from the Trash, they are completely gone.

Start Eudora and it’s not the default mailer [on] ‘
If this IS on, you are warned 1f you try to start Eudora when it’s not the default
mailer. When Eudora is the default mailer, “mailto” commands open a Eudora
message, regardless of what application the command is in.
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Dialup

These options set the dialup configuration.

[warrant Do not use the Dialup connection option unless you home a
Unix shell account. Most users have a SLIP, PPP, or direct
neneork account and can use the I/Vmsock connection method.

 

  
Miscellaneous

   
The Dialup options

Dialup username: [none]

Type your dialup user name in this field. Leave this field blank if your dialup
username is the same as your POP account username.

Phone number: [none]

Type the dialin phone number for your terminal server here. When using Eudora
from a location that requires a prefix (such as “8” or “9”), make sure to include
the prefix in this field along with the phone number.
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Modem: [*Default:Hayes (unreliable transfers)] . ‘
Spec1f1es the modem type. If your modem is listed among those available, select
it. If not, select *DefaultzHayes (unreliable transfers)

Note: While the default modemfimctions in many cases, you may experience
data corruption when sending or receiving messages. To configure
Eudorafor a reliable connection using the default modem, you must
modifi/ the DEFA UL TMOD dialupfile, as described in Appendix E.

Baud rate: [9600] . ‘ . .
Spec1f1es the speed at wh1ch your modem communicates With the terminal server.
Select the value that corresponds with your modem speed.

com port: [C0lVl2]

Specifies the COM port that your modem is connected to on your PC.

Flow_Control: [Hardware] . ~ ‘
Spec1f1es the modem flow control. Flow control is the ability of the modem and
PC to stop the data flow before the internal buffers fill up and overflow. The
modem may use either hardware or software flow control (software flow control
is typically the modem default setting), but hardware is preferred and strongly
recommended at baud rates above 9600. If your modem does not support
hardware flow control, then you must use software flow control. Software flow
control, however, does not work well at speeds above 9600 baud.

Data bits: [8], Stop bits: [1], Parity: [none]
Specrfy various termlnal server sett1ngs. The default values are correct for almost
all cases. Consult with your local Eudora support coordinator or service provider
prior to changing any of these values.

Service provider: [*Default (must modify)] . ‘ .
Spec1f1es the serv1ce prov1der whose termlnal server Eudora 1s connecting to. If
your service provider is listed among those available, select it. If not, select
*Default (must modify).

Note: The default service provider will notfunction until the
SERIALNA Vdialupfile is modified to work with your service
provider, as described in Appendix E.

Dialup timeout after ? seconds [60] . ~ . .
Spec1f1es the number of seconds before a d1alup connection Wlll time out.

Show trace window [on]

This option allows you to enable the Trace Window that Eudora displays when
making dialup connections. When enabled, the Trace Window is opened
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automatically at the beginning of the dialup session. It follows what Eudora is
sending, expecting, and the characters returned to Eudora. The Trace Window is
a valuable troubleshooting tool because when there is an error during the dialup
process, the window displays the source of the error.
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Advanced Network

These options control some of Eudora’s advanced network functions. They
should not be modified without first consulting with your e-mail administrator.

Miscellaneous

  
The Advanced Network options

Use asynchronous Winsock calls for:
This option allows you to select asynchronous calls for Database functions or All
others when using the Winsock connection method. There are two methods of
making Winsock calls using TCP/IP stacks: blocking and asynchronous. Because
of the ability to handle error conditions more gracefully) asynchronous is the
preferred method. However, some TCP/IP stacks do not handle asynchronous
calls correctly, so if you’re experiencing trouble with your Winsock connection
make sure both of these options are off.

Networkppen timeout after ? seconds [60] .
This option allows you to set the number of seconds before a network connection
will time out.

Networktimeout after ? seconds [60] .
This option allows you to set the number of seconds before a network connection
will time out.
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Networkbuffer size of ? bytes [4095]
This option allows you to set the srze of the buffer that Eudora uses to transfer
information to and from the server.

Note: Hyatt are having trouble transferring large messages, the size of
this bufi’er may be decreased

Cache network info [on] ‘ _
This option causes Eudora to remember the results of prevrous database functions
when using the Winsock connection method. This speeds up database functions
within a single Eudora session.

Unload WIHSOCK DLL after closing socket [off] .
This option causes Eudora to unload the Wrnsock DLL after closrng the socket,
This is useful if you don’t want Eudora to keep your Winsock DLL open
continuously.

Automatically dial & hangup this connection [off] (32-bit Eudora only)
If this is checked, the specrfred d1alup connectron (referred to in Windows NT 4.0
as a “phonebook entry”) is used when Eudora does any network operation. Use
the popup menu to select a connection in the Entry field.

This option is only available if you have installed the dialup networking services
with Windows 95 or Windows NT 4.0.

Username

This specrfies the username for the auto connectron.

Save password . . .
If this is on, the auto connectron password 1s saved 1n Eudora so that you do not
have to re-enter it after you exit and restart Eudora.

If you select Forget Password(s) from the Special menu, you will need to re-enter
the password the next time you check mail.
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MAPl Options

These options control the Eudora MAPI Server.

10191010 3

Miscellaneous

  
The MAPI options

Use Eudora MAPI server: Never [default] _ ~ .
If this option is on, the Eudora MAPI server 13 off and is never automatically
loaded.

Use Eudora MAPI server: When Eudora is running . .
If this option 1s on, the Eudora MAPI server 13 on when Eudora is running.

Use Eudora MAPI server: Always _ .
If this option is on, the Eudora MAPI server 13 on and is always loaded on startup.

Delete MAPI attachments: Never
If this option is on, MAPI attachments are never deleted from the attachment
directory.

Delete MAPI attachments: After sending messages .
If this option is on, MAPI attachments are deleted from the attachment directory
when their corresponding messages are sent.

Delete MAPI attachments: When messages are emptied from trash [default]
If this option is on, MAPI attachments are deleted from the attachment directory
when their corresponding messages are emptied from the trash.
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Kerberos Options

These options control the Kerberos authentication system. If your network uses
Kerberos for authentication, the appropriate options are provided by your e-mail
administrator.

Miscellaneous

   
The Kerberos options

Kerberos POP3 port: [1110] . . .
This is the port that the Kerberos POP server 1s 11sten1ng on.

Realm: [none] . ‘
This is the network realm that the Kerberos server res1des 1n.

Servipe name: [rcmd] ' .
This is the type of serv1ce that you’re requestlng.

Serviee format: [%1.%4@%3]
This is the name of the ticket that Eudora requests from the Kerberos server.
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Miscellaneous

The Miscellaneous Options determine miscellaneous Eudora functions.

10194010 3

___d\___
Advanced N network

a

   
The Miscellaneous Options

Switch. messages with_: Unmodified arrow keys [off]
If this IS on and there is an incoming message Window open on the screen, the up
or left arrow key opens the previous message and the down or right arrow key
opens the next message. If this option is off, the arrow keys can be used to move
the caret in messages.

Note: Even if Unmodified arrow keys is on, the arrow keys do not switch
messages if there is an outgoing message topmost on the screen.

Ctrlfarrow keys [off] . ‘ . _
If this IS on, you can sw1tch messages (as described in the “Unmodified arrow
keys” section above) by holding down the Ctrl key and pressing the arrow keys.
The Ctrl+arrow keystrokes do not work when composition windows are open on
the screen.

Alt+arrow keys [on] . ‘ . _
If this IS on, you can sw1tch messages (as described in the “Unmodified arrow
keys” section above) by holding down the [Alt] key and then pressing the arrow
keys. The Alt+arrow keystrokes do work when composition windows are open on
the screen.
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Require confirmation for deletes [on] .
If this is on, Eudora alerts you when you are deleting messages you haven’t read
or transferring queued messages out of the Out mailbox.

Close messages with mailbox [off] .
If this is on, closmg any mailbox w1ndow (except Out) closes all the open
messages from that mailbox.

Empty‘Trash when exiting‘ [on] . . . _ _
If this is on, the Trash ma11box1s emptied when you ex1t Eudora. If this is off, the
Trash is only emptied when you select Empty Trash from the Special menu.

Say 9K to alerts. after ? seconds [on, 120] .
If this is on, notifications of network problems automatically go away after the
specified number of seconds. This allows Eudora to try the communication again,
and is most useful if you have automatic mail checking enabled for any of your
accounts.

Turbo redirect by default [off] . . . .
If this is on and you select Redirect To, a redirected message is created With the
specified recipient, the message is queued, and the original message is deleted.

Automatically open next message [off]
If this is on, deleting or transferring the current message opens the next message
in the mailbox, but only if it is unread.

Allow Drag and Drop Transfers [on] . .
If this is on, you can transfer a message to another mailbox us1ng drag and drop.

Intercept Netscape mailto_URLs [off] . . ‘ . _
If this is on, Netscape mailto commands (clicking on an active e-mail address in a
Web page) opens a Eudora message.

Include outdated Return-Receipt-Io [off] . . _
If this is on, the old Return-Receipt-To header is included in the new return
receipt header. The old Return-Receipt-To header requested that a cooperating
mailer retuni a message to you when your outgoing message was delivered to the
addressee. This did not necessarily mean that your recipient ever displayed the
message.

Automaticallyexpand nicknames [off] ‘
If this is on, nicknames in message headers are replaced With the real addresses
when you switch fields.
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Menu Commands

The following sections describe each of the Eudora menu commands.

File

This menu provides basic file and mail functions.

- New Text File
Create a new text file.

 
Open Text file...

Open a selected (highlighted) message summary, or text file.

Open Attachment

Open a selected (highlighted) message summary, an
attachment, or a mailbox (from the Mailboxes window).

Close .
Close the current w1ndow.

Save _
Save the changes to the topmost Window.

Save As... .
Save the current messages to a text file or a Stationery file.

Send Queued Messages .
Send all messages that have been queued for delivery.

Check Mail

Pick up new mail from the POP server.

Print...

Print the current message(s), or window.

Print Preview . ‘ .
D1splay the Pr1nt Prev1ew Window.

Print Setup

Display the Print Setup window.

Exit

Exit the Eudora application.
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Edit

Reference

This menu provides text editing tools.

3-

  

QUALCOMM Incorporated

Undo .
Reverse the last act1on taken.

Cut

Delete the selected text and place it on clipboard.

Copy

Copy the selected text and place it on clipboard.

Paste .
Paste the contents of the cl1pboard.

Paste as Quotation .
Paste the contents of the cl1pboard as quoted text.

Clear

Delete the selected text.

Text

Apply text styles to the selected text or paragraph.

Select All . .
Select the entlre contents of a message or a mailbox.

Wrap Selection . ‘ _
Insert carnage returns Into the selection. as appropriate.

Finish Address Book Entry .
Complete the partlal text of a n1ckname.

Insert Recipient . .
Insert the chosen rec1p1ent.

Find submenu . ‘
Search for the des1gnated character string.

Sort submenu

Sort the message summaries in a mailbox in ascending order.

Check Spelling

Display the Check Spelling dialog.

Message Plugins submenu
Use Message Plug1ns.
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Mailbox

This menu lets you open a mailbox, or bring an open mailbox to the front.

In

Open the mailbox where incoming messages are stored until
deleted or transferred to another mailbox.

Out

Open the mailbox where messages you compose are stored,
where queued messages are held until actually sent, and
where copies of sent messages may be initially stored.

Trash

Open the mailbox where deleted messages are stored.

 
New...

Display the New Mailbox dialog to create a new mailbox.
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Reference

This menu lets you create, send, and delete messages.

QUALCOMM Incorporated

 
New Message

Open a new message compos1tion Window.

Reply

Reply to the sender of the current message.

Reply to All

Reply to all the original recipients.

Forward

Forward the current message to someone else.

Redirect
Redirect the current message to someone else.

Send Again . ‘
Resend a message rejected by the mail system.

New Message To . . _ _
Send a message to someone on the Quick Recrpient llSt,

Forward To . _ _ '
Forward a message to someone on the Quick Recrpient list.

Redirect To

Redirect the message to someone on the Quick Recipient List.

New Message With . . .
Open a new message Window With the selected stationery.

Reply With . .
Open a reply message With the selected stationery.

Attach File [to New Message]

Attach a file to the current message or a new message.

Send Immediately or Queue For Delivery
Send the message or put it in the queue.

Change . . _
Change the queueing, status, priority, label, or server status.

Delete . ‘
Transfer the current message into the Trash mailbox.
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Transfer

This menu lets you transfer current message(s) to another mailbox.

In

Transfer the current message(s) to the In mailbox.

Out

Transfer the current message(s) to the Out mailbox.

Trash

Transfer the current message(s) to the Trash mailbox.

 
New...

Display the New Mailbox dialog to create a new mailbox;
current message(s) may be transferred into that mailbox.
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Special

This menu lets you use additional Eudora functions.

Filter Messages

Run the manual filters for the current message(s).

Make Address Book Entry...

Create an Address Book entry from the current message,

Add As Recipient . _ ‘ .
Add selected text to the Qu1ck Recrpient list.

Remove Recipient . . . _
Select a rec1p1ent from th1s menu and the recrpient IS removed
from the Quick Recipient list.

Empty Trash .
Delete all messages from the Trash mailbox.

 
Com pact Mailboxes . .
Recla1m unused space 1n all ma1lboxes.

Forget Password(s) .
Make Eudora forget your passwords so mail can’t be checked.

Change Password...

Change a POP account password on the POP server.

Message Plugins Settings... .
Open the Message Plug1ns Settings.
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Tools

All the Eudora Tools are listed in this menu. Select one to open it.

Filters

Display the Filters window.

View Mailboxes

Display the Mailboxes Window.

Address Book

Display the Address Book window.

Directory Services . .
D1splay the Dlrectory Serwces w1ndow.

 
Signatures . .
D1splay a Slgnature Window.

Options...

Display the Options dialog.
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Window

All standard Window options are listed in this menu, including what Eudora windows you
have open.

 
Help

Reference

Cascade

Cascade open w1ndows.

Ti_|e Horizontal .
T11e open w1ndows horlzontally.

Ti_|e Vertical . .
T11e open w1ndows vertlcally.

Arrange Icons ‘ .
Arrange all 1cons at the bottom of the main w1ndow.

Send to Back

Send the topmost window to the back of all displayed
windows.

[Your Windows]

All Eudora windows that are open are displayed here.

The Eudora Help menu and About Eudora screen are listed in this menu.

 

QUALCOMM Incorporated

Topics

Display the on-line Help contents.

Context Sensitive Heip_
D1splay context sens1t1ve Help.

Register Euodra . .
D1splay Reglstratlon d1alog.

Insert Systern Configuration ‘
Insert text w1th your system configuration
information.

About Eudora...
D1splay the About Eudora screen.
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Mail Storage

When you install Eudora, it creates a number of files within the assigned
directory. In addition, Eudora creates additional files as needed for mailboxes,
signatures, and other functions. The Eudora files are described below.

eudora.ini

Your Options information is saved in the eudoraini file, along with other
information. This file contains notes that describe each entry.

nndbase.txt

Your nicknames are saved in the nndbasetxt file.

nndbase.toc

This file is the table of contents for your nicknames. Extra nickname files are
stored in the Nickname directory.

in.mbx, outmbx, trash.mbx

These files hold your mail. You’ll see files like these for every mailbox you
create.

Note: Thesefiles are in UNIXmailformat.

in.toc, out.toc, trash.toc

These files are the tables of contents for your mailboxes. They make it much
faster for Eudora to access your mail. You’ll see files like these for every mailbox
you create.

lmos.dat

This file contains information about the messages on your mail server.

eudoraJog, eudorlog.old

Eudora can keep records of all mail transfers. These records are kept in the
eudoralog and eudorlogold files. The eudorlogold file is overwritten and a new
eudoralog file is created when the eudoralog file reaches its approximately 100K
maximum size. To enable logging, set the LogLevel entry in the [Debug] section
of the EUDORAINI file (for more information, see the [Debug] section of the
EUDORAINI Settings File On-line Help).
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filters.pce

Eudora filter names and extensions are saved in the filterspce file.

descmap.pce

Mappings between mailbox names and DOS 8.3 file names are stored in the
descmappce file.

*.tlx

Dictionary information is stored in the .th files.

Sigs Directory

The Standard and additional signature files are kept in the Sigs directory.

Stationery Directory

The stationer files are kept in the Stationery directory. Stationery files have a stat
extension.

Piugins Directory

The EMSAPI plugins are kept in the Plugins directory.
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Anonymous ftp (ftp.qualcomm.com)

QUALCOMM has an anonymous ftp server (ftp.qualcomm.com) that has
information and software related to Eudora. These are located within the “quest”
directory. Included are POP3, Ph, and password changing servers, the srialpop
program, current product information, dialup files, and more.

Eudora information

The information in this manual was correct at the time of printing. However,
things happen very quickly in the electronic world, meaning that some of this
information may already be out of date. For the very latest information about

Eudora, send e-mail to eudora-info@qualcomm.com.

Obtaining a PCP Server

If you would like to run a POP server on your own UNIX system, we suggest you
use “popper.” Popper is available via anonymous ftp from ftp.qualcomm.com.
Popper versions are available for a number of UNIX systems.

VAX/VMS systems may try the “Multinet” package from TGV, or IUPOP3,
available via anonymous ftp from ftp.indiana.edu.

For VM/CMS users, there is a port of “popper” available via anonymous ftp from
vmd.cso.uiuc.edu (cd to the “POPD” directory).

Ph Server Source Code

A server for the “Ph” protocol is available via anonymous ftp from
ftp.qualcomm.com.

Password Change Server

Three sample UNIX servers for Eudora’s “Change Password” command are
available via anonymous ftp from ftp.qualcomm.com.
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Windows Sockets Products

Demos of Windows Sockets 1.1 compliant stacks and applications are available
via anonymous ftp from papaindstateedu in the directory winsock-l. The are also
available on ftpcicaindianaedu in the directory pub/pc/win3/winsock.

For those with World Wide Web (WWW) browsers} try the following sites:

The Consumate Winsock Applications list: http://wmvcwsappscom/
The Ultimate Collection of Winsock Software: http://wvtucowscom/
Stardust Technologies: http://www.stardust.com/wsd/

PC Speaker

If you want the new mail sound notification to work with the speaker that comes
with your PC, you need to install the PC speaker driver. This driver is available
via anonymous ftp from ftpqualcommcom. It’s the file SPEAKEXE in the
directory quest/windows/eudora/utils. This is a self-extracting archive, so just run
it on your PC to produce the necessary files and instructions.

Note: The PC speaker driver does not work with Windows 95 or
Windows NT.

Kerberos

You can get the necessary files and information for setting up Kerberos
authentication in Eudora from ftpqualcommcom in the directory
quest/windows/kerberos. Be sure to read the installation instructions to insure
that Kerberos is set up properly.

To learn more about the Kerberos authentication system, anonymous ftp to
athena—distmitedu and begin in the pub/kerberos directory.

Spelling Dictionaries

There are additional spelling dictionaries that are compatible with Eudora’s spell
checker. They are available Via anonymouse ftp from ftpqualcommcom in
quest/windows/eudora/spelling. To configure Eudora to use these dictionaries,
look at the online help under Eudoraini settings file} [Settings] MainLeX files.
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Modifiers

Many operations in Eudora can be implemented by holding down one or more
“modifier” keys. Eudora uses the Shift, Ctrl, and Alt keys as modifiers.

Shift + Check Mail Display the Mail Transfer Options dialog to
define the interaction with your POP account.

Shift + Queue/Send Open the Change Queuing dialog.

Shift + New message command

Display the Message Options dialog to select a
personality for the new message.

Shift + Insert Recipient Insert the address(es) instead of the nickname.

Shift + Ctrl + , Expand the nicknames in the current field to
their real addresses.

Shift + Finish Address Book Entry

Finish the Address Book entry with the
address(es) instead of the nickname.

Shift + Sort command Sort in descending order.

Shift + Transfer Put a copy of the current message in the selected
mailbox and leave the original where it is.

Shift + Copy Copies the selected text without the carriage
returns (copy unwrapped).

Shift + Wrap Selection Removes the carriage returns from the selected
text (unwraps).

Shift + Save Saves changes to all open windows.

Shift + Close Closes all open windows.

Shift + Exit Sets all open windows to open again when
Eudora is next started.

Alt + Drag toolbar button Moves the button on the toolbar.
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Shortcuts

The shortcuts for Eudora functions are as follows:

Ctrl + 0 Open Out mailbox Ctr! + L Open Address Book

Ctrl + 1 Open In mailbox Ctr! + M Check mail

Ctr! + 6 Check Spelling Ctr! + N New message

Ctrl + ’ Paste as quotation Ctr! + 0 Open file

Ctrl + ; Find next Ctr! + P Print

Ctrl + A Select all Ctr! + Q Exit Eudora

Ctrl + B Make text bold* Ctr! + R Reply

Ctrl + C Copy to clipboard Ctr! + S Save current window

Ctr! + D Delete Ctr! + T Send queued messages

Ctrl + E Send or Queue Ctr! + U Make text underlined*

Ctr! + F Find window Ctr! + V Paste from clipboard

Ctr! + G Find again Ctr! + W Close message

Ctrl + H Attach document Ctr! + X Cut to clipboard

Ctr! + I Make text italic* Ctr! + Y Directmy Services

Ctrl + J Filter messages Ctr! + Z Undo

Ctrl + K Make nickname

arrows Move from one message to another in a mailbox.

enter Select the outlined button in any dialog. alert, or window,
or open the selected messages.

esc Stop any operation currently in progress.

F1 Get Help.

F2 Rename the selected item in Mailboxes or Address Book.*

F3 Find again.

F7 Toggle split windows in Composition and Address Book.*

page up, page down Scroll up or down through the window.

* 32-bit version only
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Introduction

Eudora uses Simple Mail Transfer Protocol (SMTP) to transfer your outgoing
mail to your SMTP server machine, which in turn uses SMTP to send your mail to
the world at large. Mail from the world at large arrives on your Post Office
Protocol (POP) server, where it waits for Eudora to pick it up with POP version 3.
The mail Eudora sends and receives is constructed in accordance with RFC 822

and RFC 1521 (MIME).

Check Mail

Your PC POP/SMTPServer

SMTP
Send Queued Messages  

  
 

The World at Large

Eudora mail transport overview

Outgoing Mail

When you send an e-mail message to someone, Eudora uses SMTP to send the
mail to your local SMTP server computer. That computer then sends the mail to
your addressee’s computer, also (usually) by means of the SMTP protocol.
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Why doesn’t Eudora talk directly to your addressee’s computer? For one thing, it
would take a lot longer for your mail to leave your PC, because your PC would
have to call up each addressee’ s computer and deliver your mail. For another,
some computers are “hard to find,” it’s much better to let another computer
“hunt” for your addressee than to make your PC do it. Finally, sometimes your
addressee’s computers won’t be available when you want to send mail. The
SMTP server handles this by holding your mail until the other computer is ready
to accept it, eliminating the inconvenience of having unsent messages hanging
around on your PC.

Incoming Mail

When somebody sends you mail, other computers use the SMTP protocol to
deliver the mail to your POP server. Your POP server puts mail in your “mail
drop,” where it stays until the Eudora program picks it up. When you check your
mail, Eudora uses POP version 3 to pick up your mail and move it to your PC.

Why doesn’t Eudora use SMTP to receive your mail? SMTP works best when the
computers it knows about are always ready for mail. Unless you wanted to run
Eudora 24 hours per day, seven days a week, SMTP wouldn’t work very well for
you, It also doesn’t work well in lab environments, where you might use any
number of different PCs.

More Information

If you want to know more about the Internet in general, consult the book
[riter‘nem/orkingwilh TCP/IP, by Douglas Comer, 1988, Prentice-Hall ISBN
0-13-4730154-2 025.

If you want to know more about SMTP, RFC 822, POP version 3 and MIME, the
official standards are:

RFC 821, “Simple Mail Transfer Protocol,” by Jonathan B. Postel

RFC 822, “Standard for the Format of Internet Text Messages,” by Dave Crockeb

RFC 1939, “Post Office Protocol, Version 3,” by Marshall Rose

RFC 1521, “Multipurpose Internet Mail Extensions,” by Ned Freed and Nathaniel

 

Borenstein

You can find the RFCs by anonymous ftp to nicddamil; see Internetworking with
TCP/IP for details.
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What is MlME?

“MIME” stands for Multipurpose Internet Mail Extensions. MIME serves two
major purposes — it allows mail applications to tell one another what sort of data is
in mail, and it also provides standard ways for mail applications to encode data so
that it can be sent through the Internet mail system.

MIME Encoding

The Internet uses the “SMTP” protocol to move mail around. SMTP is limited to
the US-ASCII character set (see Appendix C). This is a problem for people who
speak languages other than American English and so need accented characters or
non-American letters, or for people who want to use special symbols like the
bullet.

MIME provides a way around this restriction. It offers two encodings, “quoted-
printable” and “base64.” These encodings use US-ASCII character codes to
represent any sort of data you like, including special characters or even non-text
data.

Quoted-printable is used for data that is mostly text, but has special characters or
very long lines, Quoted-printable looks just like regular text, except when a
special character is used. The special character is replaced with an “=” and two
more characters that represent the character code of the special character. So, a
bullet in quoted-printable looks like “=95.”

However, there are some other things that quoted-printable does. For one, since it
uses an “=” to mean something special, equal signs must themselves be encoded
(as “=3D”). Second, no line in quoted-printable is allowed to be more than 76
characters long, If your mail has a line longer than 76 characters, the quoted-
printable encoding will break your line in two, and put an “=” at the end of the
first line, to signal to the mail reader at the other end that the two lines are really
supposed to be one. Finally, a few mail systems either add or remove spaces from
the ends of lines. So, in quoted-printable, any space at the end of a line gets
encoded (as “=20”) to protect it from such mail systems.
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Let’s try an example. Here’s a passage of text that you might type on your PC:

«11 est demontre, disait—il, que les choses ne peuvent étre autrement; car tout

etant fait pour une fin, tout est nécessairement pour la meilleure fin.»

Without any encoding, this might show up on your recipient’s screen as:

+11 est dimontri, disait—il, que les choses ne peuvent btre autrement; car tout

itant fait pour une fin, tout est nicessairement pour la meilleure fin.;

This corruption happens because SMTP cannot handle the special characters.
However, if you and your recipient both have MIME, quoted-printable encoding
would be used, and your text would show up properly:

«Il est demontre, disait—il, que les choses ne peuvent étre autrement; car tout

etant fait pour une fin, tout est nécessairement pour la meilleure fin.»

While your mail was actually in transit, however, it would have looked like:

=ABIl est d=E9montr=E9, disait—il, que les choses ne peuvent =EAtre =

 autrement; car tout =E9tant fait pour une fin, tout est n=39cessairement =

pour la meilleure fin.=BB

Base64 encoding is another way to protect binary data from the SMTP mail
system. However, Base64 makes no attempt to be legible, and is most appropriate
for non-text data.

MlME Labelling

The other important part of MHVIE is that it lets mailers communicate what kind
of data is in a message (or part of a message). The primary mechanism used for
this is the Content-Type header:

Content-Type: text/plain; charset=iso-8859-l
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A content-type header is divided into three parts; the content type, the content
subtype, and the parameters. In this case, the content type is “text,” meaning the
message contains mostly legible text. The content subtype is “plain,” which
means there aren’t any formatting commands or anything like that embedded in
the text. Finally, “charset=iso-8859-1” is a parameter; in this case, it identifies the
character set the message uses.

The major content types are:

text legible text

image pictures and graphics
audio sound

video moving pictures

message messages or pieces of messages

multipart several different kinds of data in a single message

Practical issues

There are really only two things you sometimes need to do with Eudora and
MIME. One is that it may occasionally be necessary to turn off quoted-printable
encoding. Another is that you may want to know how to define mappings
between PC file extensions, MIME types, and Macintosh types.

Turning Off Quoted-Printable Encoding

Eudora automatically uses quoted-printable encoding if your mail contains special
characters. Eudora also uses quoted-printable encoding for attached plain text
files. If your recipients don’t have MIME, quoted-printable may hurt more than it
helps. If that’s the case, just turn off the QP button in the message Toolbar when
you are sending text files to those recipients.

Mapping Between File Extensions, MIME Types, and Macintosh

Types

Since Eudora needs to have the appropriate extensions on attachment filenames in
order to open them up from the message, Eudora has the ability to map between
file extensions, MINEE types and subtypes, and Macintosh creators and types.
Messages received by Eudora can grab the MHVIE type/subtype and/or Macintosh
creator/type from an attachment and map that into the correct file extension.
Also, on outgoing messages, Eudora can make sure that attachments are encoded
with the correct MIME type/subtype and/or Macintosh creator/type depending on
the file extension of the attachment being sent.
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Eudora knows about some MHVIE types. However, since new MIME types are
being defined all the time, it may be necessary to add to Eudora’s knowledge from
time to time. Adding new mappings between the various types only requires
editing the EUDORAINI file with a text editor (like the one that comes with
Eudora).

There is a section in the EUDORAINI file labelled [Mappings], followed by
some entries, one per line. Each entry is called a map. A map defines when the
mapping should occur (which can be “in,” “out,” or “both”), followed by an equal
sign and five parameters. These five parameters are (in order) the PC file
extension, the Macintosh creator code, the Macintosh type, the MIME type, and
the MIIVTE subtype. Here are some sample entries:

{Mappings}

both:gif,,,image,gif

both:mpg,,,video,mpeg

both:doc,MSWD,,,

in:XIs,XCEL,,,

out:xls,XCEL,XLS4,,

bothzeps,,EPSF,application,postscript

A map marked “in” only tries to match the map to messages that you receive. A
map marked “out” only tries to match the map to messages that you send. A map
marked “both” tries to match the map to both incoming and outgoing messages.

The first map above says that any incoming MIME message that has a part type of
“image” and subtype of “gif’ will get saved to a file with the extension “.gif.” It
also specifies that outgoing messages that have an attachment with the file
extension “.gif’ will get the MHVIE type of “image” and subtype of “git" if the
encoding method of the message is MIIVIE. The second map is similar to the first
map in structure, but uses a different file extension and MIME type and subtype.

You can use map entries to move between PC file extensions and Macintosh
creator and type as well. The third map says that if an incoming message has an
attachment with the Macintosh creator “MSWD” (which is the Macintosh creator
for Microsoft Word) then the file extension of the attachment when saved to disk
should be “.doc” (the file extension that Word for Windows uses). Since the map
is marked as “both,” it will also give attachments with the extension “.doc” on
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outgoing messages the Macintosh creator of “MSWD” if the encoding method of
the message is BinHex.

Note that the Macintosh type from this map is empty. This allows multiple types
to be recognized with just one mapping. This is nice for “in” maps because it
allows you to cover a range of creator/type pairs with one map. You must be
careful in using this type of map with an “out” or “both” mapping, though,
because an outgoing attachment that matched this map would have a Macintosh
creator, but no Macintosh type. Some Macintosh applications cannot open files
with a missing type. Microsoft Word for the Macintosh can open files without a
type, so this map is fine being marked “both.”

Microsoft Excel for the Macintosh is an example of a program that can't open a
file with an empty type. This is why there are two maps for Excel (the fourth and
fifth maps above). The incoming map for Excel is like the one for Microsoft
Word, but the outgoing map explicitly defines the Macintosh type.

The last map shows that you can have both Macintosh creator/type and MIlVTE
type/subtype in one entry. This map says that if an incoming message has an
attachment that is encoded in MHVIE and has the “application/postscript”
type/subtype, or has a BinHex attachment with the Macintosh type of “EPSF,”
then the resulting file will have an extension of “.eps.” Similarly, if an outgoing
message has an attachment with the extension “.eps” and if the MIME encoding is
being used for the message, then the attachment will get the
“application/postscript” MIME type/subtype. If the message was using the
BinHex encoding, then the attachment would get the Macintosh type of “EPSF,”

But what happens if an attachment matches more than one map? Eudora will try
and find the best match. For example, if you had the following [Mappings]
section:

[Mappings]

inles , XCEL, , ,

in:xlc , XCEL, x333, ,

and you received a message with an attachment that had a Macintosh creator of
“XCEL” and a Macintosh type of “XLC3” (a Microsoft Excel Chart), then the file
would get an extension of “.xlc” since the first map only matched the Macintosh
creator, but the second map matched both the Macintosh creator and type.
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Eudora can receive attachments that have both a MIME type/subtype and a
Macintosh creator/type. Eudora understands attachments with the MIME
type/subtype “application/appleflle,” which has Macintosh creator/type
information embedded in it. With this type of attachment, Eudora will consider a
match with the Macintosh creator/type as a “better” match than a match with the
MIME type/subtype.

Finally, if an incoming attachment matches two different maps to the same degree
(eg, both maps have the same MIME type/subtype with different file extensions),
then Eudora will use the file extension in the first matching map.
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Introduction

The Dialup connection method is only for users with a Unix shell account. Most
users have SLIP, PPP, or direct network connections and can use the Winsock
connection method.

Eudora is capable of dialing into systems such as Cisco and Annex terminal
servers and UNIX and WS systems for the purposes of sending and receiving
mail messages and making Ph and Finger inquiries. Dialup Eudora utilizes a
serial connection that relies on error correcting modems and proper modem and
serial port configurations to create a reliable link. This facility is not to be
confused with dialup connections such as SLIP and PPP, which provide reliable
network connections.

This appendix outlines the IBM PC/Modem and dialup connection requirements
for establishing a serial dialup link between Eudora and your mail server. It
includes descriptions of the dialup files Eudora runs when establishing this
connection, along with instructions for creating your own dialup files by
modifying the default files installed with the Eudora software. These instructions
assume you are familiar with a text editor, your PC, your modern equipment, and
your Internet service provider and/or POP/SMTP hosts.

Note: It is recommended that one person create the dialupfilesfor
Eudora and then redistribute the customizedfiles to other users at

your site.

IBM PCIModem Requirements

To use Eudora over a dialup connection, you should have a modem which
supports the Microcom Networking Protocol version 4 (MNP4) or the Link
Access Protocol for Modems (V42). If you are using an external modem you
must have a straight through cable (with a minimum of 8 signals for TX, RX,
RTS, CTS, DCD, DTR, DSR, and GND). A communications card with 16550
UARTS is also recommended for communication speeds over 9600 baud.
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Diaiup Connection Requirements

Eudora needs a “transparent” and “reliable” connection to your POP, SMTP, and
other servers.

Transparent means primarily two things:

1. Characters Eudora sends should NOT be echoed back to Eudora. Most

systems do echo characters, so something special may need to be done to
achieve this (see the “Echo Canceling” section).

2. You must pay close attention to how carriage returns are treated. Telnet
programs routinely translate carriage returns into carriage return (cr)/
linefeed (lf) pairs. For this reason, Eudora processes cr/lf pairs to plain
carriage returns by default. If your system does not translate carriage
returns to cr/lf pairs, or you are running srialpop to establish an echoless
session, Eudora’s cr/lf processing must be disabled. This can be done by
entering the “set CRLFProcessing=0” command in the DEFAULTNAV
file or by unchecking the CRLF Processing option in the Options dialog
(Dialup).

Reliable means that the modem you are using supports flow control (hardware
RTS/CTS is recommended) and either MNP4 or V42 for a reliable modem to
modem connection.

Diaiup Files

160

Eudora uses a rudimentary command language stored in specific text files to tell it
how to dial into and back out of the mail server. These text files are called

“dialup” files. The dialup files are placed in a Scripts directory within your
Eudora directory when you install Eudora. You select which modem and
navigation (Service provider) file to use in the Options dialog (Dialup). However,
if your modem and/or service provider are not supported, you should use the
Default files. These files must then be modified to work with your
modem/service provider, as described in the “Creating Your Own Dialup Files”
section.

There are four dialup files associated with Eudora. The first file
(DEFAULTMOD) contains the modem configuration commands; the second file
(DEFAULTNAV) contains the dialing and navigation commands along with the
appropriate telnet command (and the srialpop command, if necessary); the third
file (DEFAULTMID) contains the prompt locating commands; and the fourth file
(DEFAULTEND) is used to hang up the modem. The first three dialup files
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must exist or an error dialog will appear. The DEFAULTEND file is usually not
necessary.

Eudora starts off the dialing process by interpreting the DEFAULTMOD file.
The commands in this file configure the modern.

The DEFAULTNAV file then takes over to dial the phone number and run
commands to reach the terminal server/system user prompt. After reaching the
user prompt, the telnet command is run. The telnet command accesses the service
being used and, in some cases, establishes the echoless session required by
Eudora. In those cases where the telnet command does not disable echo, the

srialpop command should be run.

Once the network service is no longer required, the DEFAULTMID file is
executed to reacquire the user prompt. Eudora is then free to close down the
connection or acquire another service.

In closing down the dialup connection, Eudora drops the Data Transfer Ready
(DTR) signal, which resets a properly configured modem. Eudora also has the
option of interpreting commands in the DEFAULTEND file to place the modem
on hook and/or any other action.

Note: The execution during the dialup connection may be terminated at
any time by clicking the Stop button in the progress window or
typing [Esc].

All the dialup files are checked for syntax and variable replacement before the
dialup takes place. If a syntax error occurs a dialog appears to notify the user of
the navigation file name and line number. The navigation file commands
themselves are described in the “Dialup File Command Lines” section.

Creating Your Own Dialup Files

The appropriate dialup files may have been installed in the Scripts directory
within your Eudora directory when you installed Eudora. However, if your
modem and/or Internet service provider were not included in the installation, you
were instructed to install the “default” files (if this happens, please let us know so
that we can include your modem and service provider in a future revision). This
section outlines the steps you should take to modify the default files to work with
your modem/service provider.

To edit any of the four dialup files, simply use a text editor (one is provided
within Eudora),
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DEFAULT.MOD File

This dialup file is responsible for configuring your modem. The default
DEFAULTMOD file contains general modem configuration commands that all
Hayes-compatible modems will respond to. It also contains comments describing
the dialup Eudora requirements that need to be met in order to guarantee a stable
connection between your PC and modern, and your modem and server.

Note: Ifthese dialup Eudora requirements are not met, Eudora may still
work, butyou may experience data corruption when sending or

receiving messages.

There are five commands that need to be entered into the DEFAULTMOD file to

meet the Eudora dialup requirements. The modem commands are defined in the
commands section of your modem reference guide. Enter these five commands as
follows:

Note: An explicit “\r ” must be placed at the end ofeach send line ifyou
wish to terminate the line.

1. Enter the command that configures your modem to respond to DTR.
When DTR is dropped the modern should reset, drop carrier, and go into
command mode. Typically, the modern defaults to ignore DTR. A
Hayes-compatible modern uses the command “AT &D2” to configure it
to respond to DTR.

EXAh/IPLE: send AT &D2\r

2. Enter the command that configures your modem for reliable operation
(MNP4 or V42). If you do not use a reliable mode you risk
dropping/altering characters, thus corrupting incoming as well as
outgoing messages. Typically, the appropriate command can be found in
the \N section of the modern manual (e.g., \NZ).

EXAh/IPLE: send AT \N2\r

Note: Some Internet service providers do not support both V. 42
andMNP4. Ifthis is the case with your service provider,
find out which reliable mode is supported and then
configure your modem accordingly. Ifyou cannot match
your modem to your service provider {e.g., your modem
supports only V. 42 andyour service provider supports only
MNP4), you may need to disable reliable mode and
sacrifice your data integrity.
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3. If your modem supports hardware flow control, enter the command that
configures your modem for hardware flow control. Flow control is the
ability of the modem and PC to stop the data flow before the internal
buffers fill up and overflow. The modem may use either hardware or
software flow control (software flow control is typically the modem
default setting), but hardware is preferred and is strongly recommended at
baud rates above 9600. Typical hardware flow control commands are
*FL, \Q, and &K.

EXAMPLE: send AT >“FL\r

If your modem does not support hardware flow control, then you must
use software flow control. Software flow control, however, does not

work well at speeds above 9600 baud.

Note: Hardwareflow control uses the RTS and CTS signals on
the 125-232 cable. The PC and modem can react to these

signals muchfaster than software flow control, which uses
a character to stop and a character to start the
transmission ofcharacters.

4. If you have set your modem to support hardware flow control (as
described in step 3), change the command that sets the Eudora
FlowControl variable to Hardware (i.e., “set FlowControl=Hardware”).
This command overrides the FlowControl value in the [Dialup] section of
the EUDORAINI file (this feature is only available in version 2.0.2 or
later).

Note: Theflow control optionsfor the modem and Eudora must
match oryou will experience data corruption and/or
communicationfailures. The ”set FlowControl:Software”
command was inserted into thisfile so that Eudora matches
the default setting ofthe modem ifyou do not change it to
hardware.

5. Enter the command that fixes the modem baud rate. Many modems
adjust the speed to the line speed after the carrier is established. You do
not want the modem to change the speed that the PC is expecting.
Typical commands are \JO, B0, and \B0.

EXAMPLE: send AT \J0\r

Note: Sometimesjust selecting hardware flow control will disable
baud rate adjust.
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DEFAULT.NAV File

This dialup file is responsible for dialing the phone number (via the
{DialNumber} variable) and navigating to the system prompt of your
system/terminal server. In addition to the DEFAULTNAV files installed with
Eudora, some Internet service providers and system administrators have
developed DEFAULTNAV files that work with Eudora Contact your Internet
service provider or system administrator and ask if they have a navigation script
that works with Eudora. If not, it will be necessary to edit the default
DEFAULTNAV file to match the login requirements of your particular Internet
service provider.

Note: Prior to editing the default DEFA ULTNA Vfile you will need to be
familiar with all of the available commands and variables. These
are defined in the ”Dialup File Command Lines ” section ofthis
appendix.

The default DEFAULTNAV file contains a generic dialup script. Prior to editing
this script, you will need to know the navigation sequence for getting to the host
system prompt. You can accomplish this by dialing into the host system using a
standard terminal program that saves your login session, such as the one that
comes with Windows (“Terminal”). This will tell you what prompts to expect
from the system and what commands to send it. Using the commands and
variables at your disposal, edit the navigation sequence accordingly,

Note: An example dialup session and the resulting navigation sequence
are provided in the default DEFA ULINA Vfile.

Telnet Command

Once you have edited the navigation sequence of this file, enter the appropriate
telnet command or activate one of the three telnet commands that are provided in
this file (to activate a command, simply remove the comment character at the
beginning of the command line). The telnet command is required to access the
network services once you have logged into your terminal server or system.

Prior to entering/activating the telnet command you will need to know the
following:

- Are you logging into a terminal server or UNIX system?

- If logging into a terminal server, what type is it?

- Do you need to run srialpop on the host to establish an echoless
connection?
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Telnet commands are provided for Annex and Cisco terminal servers. These
commands establish the echoless telnet session required by Eudora.

Note: The active telnet command in this dialupfile will overrtde the
default Eudora telnet command or an existing telnet command in
the [Dialap] section ofthe EUDORAJNIfile (thisfeature is only
available in version 2. 0.2 or later). See the ‘EUDORAJNI

[Diahip] Settings” sectionfor information on the default telnet
command

An additional telnet command is provided if you are dialing directly into a UNIX
system (that is, you get a system prompt instead of a terminal server prompt).
This command works in conjunction with the srialpop command to establish an
echoless telnet session. Srialpop runs on the UNIX host computer. A source
copy of this program (srialpopsh) was placed in your Eudora directory as part of
the installation process.

If you are using this telnet command (or any other telnet command that does not
disable echo), activate the “set CRLFProcessing=O,” “send exec srialpop ” and
“waitfor %” commands by removing the comment character at the beginning of
each command line. This will run srialpop on the host computer and provide for
an echoless session.

If you are connecting to a terminal server that is not supported by one of the
provided telnet commands, contact your service provider or system administrator
to obtain a telnet command that provides an echoless session. If it does not
disable echo, then enter it after the srialpop command lines and be sure to activate
them.

Note: Hyatt enter a different telnet command in thisfile, be sure to place
a “l ” character directly before the beginning “{“ character in a
variablefield. For example, “set TelnetCommand:stty
-echolntelnet -r l{System} \{Port}\n. ”

DEFAULT.MID

This dialup file simply waits for the terminal server/system prompt. The waitfor
command in this file should match the waitfor command at the end of the

navigation sequence in the DEFAULTNAV file.

EXANTPLE: waitfor %
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DEFAULTEND

This dialup file is normally not required (and may be deleted). It is responsible
for resetting the modem if DTR will not. This file contains the standard modem
hangup and reset commands for Hayes-compatible modems.

Dialup File Command Lines

The Eudora dialup files are simple text files that can be edited using any text
editor (the one provided within Eudora, for example). The command lines
themselves are made up of commands, character sequences, delimiters, text string
variables, and special characters. These elements are defined below.

Note: Command lines beginning with a ‘# ’ or ’character are comment
lines which are not utilized as part ofthefile. Yhese may contain
comments or help text supplied by the script writer. Blank lines
are also treated as comment lines.

The maximum string length of a command line is 255 characters. This is the
same limit for the string used after variables and special characters are replaced
with the appropriate values. Trailing spaces are stripped unless the last space is
escaped (i.e., preceded by a ‘\’ character), at which point all trailing spaces up to
that point are left in the translation string. All variables and commands are case-
insensitive, so you may mix case as you see fit. Character sequences may be
case-sensitive, however, depending on the system/terminal server you are
connecting to.

Note: Command lines are not automatically terminated with a carriage
return or new line, you must add a ‘\n ’ and/or ‘lr ’ character to the
end ofany command line you wish to end with [Enter] (see the
“Special Characters ” section).

Commands

The first word in each command line must be a command. The following
commands are defined for use in the Eudora dialup files:

Note: In the examples below, the symbol <str> represents the character

sequence (see the “Character Sequences ” section), the symbol <c>
represents the delimiter character (see the “Delimiters” section),

the symbol <setting> represents any ofthe EUDORAJNI [Dialup]
settings (see the “EUDORAJNI [Dialup] Settings” section), and

the symbol <sec> represents a value in seconds {e.g., 60).
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send <str>

waitfor <str>

cancelon <str>

set <setting>=<str>

pause <S€C>

sendbreak

sendprompt <str>

timeout <sec>

Character Sequences

Appendix E — Diaiup Eudora

Send the character sequence out the serial port. All
input waiting in the serial receive buffer is purged.

Do not continue the file until the character sequence is
matched. Multiple sequences may be searched if a
delimiter is used; however, the delimiter must be used

at the beginning of the first sequence and the end of the
last sequence. For example, waitfor
<c><str><c><str1><c> <str2><c> allows you to wait
for one of three matches. Any non alpha-numeric
character may be used as a delimiter (see the
“Delimiters” section).

If, while executing a waitfor, this character sequence is
matched, the file is aborted with an error. Multiple
matching may occur if a delimiter is used, as described
in the waitfor command.

This command can be used to override one of the

[Dialup] settings in the EUDORAINI file (an example
of this is the “set FlowControl=Hardware” command in

the DEFAULTMOD file).

Wait the specified number of seconds before
interpreting the next command.

Send a break signal to the modem.

Prompt the user for input required by the service
provider/system that is not a fixed value (such as a
timed password). You are then prompted to enter a
string that will be sent out to the serial port (with an
optional \r\n on the end).

Set the waitfor timeout to be a specified number of
seconds. Shorter timeouts are useful for modern

commands, longer ones for waiting for carrier.

Command line character sequences can be made up of any characters. However,
special care must be taken with the characters ‘{’, ‘}’, and ‘\’, which are used to
designate variables and special characters. When used in character strings, these
characters must be preceded with a ‘\’ (i.e., ‘\{’, ‘\}’, ‘\\’).
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Note: Character sequences may be case-sensitive, depending on the
server being connected to.

Delimiters

Delimiters are used to separate character sequences in command lines where more
than one character sequence is present. Any non alpha-numeric character may be
used as a delimiter. The delimiter serves the ‘or’ function when placed between
character sequences. Additionally, a delimiter must be used at the beginning of
the first sequence and the end of the last sequence. For example, in the command

line cancelon [NO DIALTONE | BUSY | NO CARRIER} , the connection will
be canceled if any of three matches are found.

Variables

Although not required, predefined variables can be used in the dialup files. They
are enclosed in curly brackets, that is, ‘{’ and ‘}’, when appearing on command
lines. The available variables are defined below.

The following variables are set in the Eudora Configuration dialog with the
exception of the password variables, which are set in popup dialogs:

{DialNumber} Phone number configuration line.

{DialLogin} Commonly set with the terminal server user name.

{DialPass} Password associated with the {DialLogin} variable.

{POPLogin} User name in the POP account configuration line.

{POPPass} Password associated with the {POPLogin} variable.

{POPHOst} Host portion of the POP account configuration line.

{SMTPHost} SMTP host configuration line.

The following variables are derived from values in the Options dialog and can be
used in the telnet command:

{System} This is the system you are connecting to.

{Port} This is the port number of the host where the network
service is located.

Special Characters

Special characters can appear at any place in the command line. The available
special characters are defined below.
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Note: Characterspreceded with a '\ ' character that are not in the
following fist are simply stripped of the '\'.

\n A linefeed (ASCII 10).

\r A carriage return (ASCII 13).

\O — \7 An octal constant, usually one to three characters.

\\ A single backslash character.

When Eudora is communicating with your POP or SMTP server, it is important
that they agree on what constitutes a line. The specifications for these two
protocols stipulate that a line ends with a carriage return (or) followed by a
linefeed (If). Most UNIX systems translate carriage returns into cr/lf pairs. For
this reason, Eudora processes cr/lf pairs to plain carriage returns by default. If
your system does not translate carriage returns to cr/lf pairs, or you are running
srialpop to establish an echoless session, Eudora’s cr/lf processing must be
disabled. This can be done by entering the “set CRLFProcessing=O” command in
the DEFAULTNAV file or by editing the [Dialup] section of EUDORAINI file
(refer to these sections for more details).

Echo Canceling

Echo can cause Eudora to become confused, reduce throughput, and cause data to
be lost if buffers fill up. Therefore, disabling echo when using Eudora is very
important. If your PC has a serial line to a UNIX machine, or if there are modems
on your PC and UNIX machine, you can disable echo using a number of methods,
two which are described below.

Method 1 — The Telnet Command

Some terminal servers allow commands to be run that disable echo to be part of
the telnet command. For example, when connecting to an Annex terminal server
the DEFAULTNAV file uses the following command line:

set TelnetCommand=stty -echo\ntelnet -r \{ System} \{Port}\n

The “stty -echo” command turns off terminal server echo.

Note: Wen using this method, the DEFA UL TMIDfile should be
configured to waitfor the system prompt.
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Method 2 — Serial pop

1. Install the srialpop program onto your UNIX system. Source to this is
part of the Eudora distribution.

2. Activate/place the following command lines in the DEFAULTNAV file.

set CRLFProcessing=O
send exec srialpop\r
waitfor %

Note: When using this method, use a ”waitfor % ” command in the
DEF/l ULTMIDfile.

Dialup File Troubleshooting

Eudora has a way to help users troubleshoot dialup files — the Trace Window.
This window follows what Eudora is sending, expecting, and the characters
returned to Eudora while it is waiting for a pattern match This window is
enabled in the Options dialog (Dialup).

When enabled, the Trace Window is opened automatically at the beginning of the
dialup session. If there is an error during the dialup process, the window displays
the source of the error. You can then explore the appropriate corrective action.

Trace Window

—---Running the navigation script----
set TelnetCommand=stty —echo\ntelnet —r {System} {Port}\r
set CRLFProcessin3=l
timeout EU
cancelon ”NO CARRIER”BUSY”NO DIALTONE”Usernamefpassword Incorrect“
send ATDT SSE—1234\r   

Example Trace Window

In addition to using the Trace Window when troubleshooting dialup Eudora, a few
of the typical problems encountered when attempting to connect to your terminal
server/system for the first time are described below (symptoms), along with the
probable corrective action for each:

I Symptom I Corrective Action I

1 m QUALCOMM Incorporated
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command when sending or

checking mail (it has never

worked).

to your modem at speeds

higher than 9600 baud, even

Eudora can send small

messages but not large
messages.

Eudora can receive mail but

times out when sending mail,

even small messages.

QUALCOMM Incorporated

Eudora times out at the telnet -

Eudora has problems talking

with hardware flow control.

Appendix E — Diaiup Eudora

You may have a problem with carriage return
(cr)/linefeed (1f) processing. By default,
Eudora converts cr/lf character pairs into cr.
This is because many telnet programs convert
cr into a cr/lf pair. If your telnet program does
not convert cr to cr/lf, then you need to disable
the cr/lf processing done by Eudora. To do
this, add the command “set

CRLFProcessing=O” to the beginning of the
navigation sequence in your DEFAULTNAV
file.

Standard serial ports that come with most PCs
do not operate well above baud rates of 9600
baud. You may need a high speed serial card
with 16550 UARTS.

Chances are you have not been successful in
disabling echo on your telnet session. If echo
is not disabled, Eudora will get very confused.
Edit your DEFAULTNAV file and enable the
commands that run srialpop (see the “Echo
Canceling” section). This will establish the
echoless connection that Eudora requires,

Chances are the flow control between your
modem and your PC, or the flow control of
your service providers modems and systems is
not setup correctly. This problem is very
difficult to diagnose and fix. If you have
created your own DEFAULTMOD script,
then recheck it and verify that the FlowControl
command matches the modem configuration
(hardware or software). Refer to steps 3 and 4
of the DEFAULTMOD section of this

appendix for more details. If they match, it
may be a problem at your service provider.
Contact your Eudora technical support
representative for assistance in troubleshooting
this problem.

171
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Corrective ActionI Symptom

Eudora can receive mail but Chances are the flow control between your
times out when sending mail, modem and your PC, or the flow control of
even small messages. your service providers modems and systems is

not setup correctly This problem is very
difficult to diagnose and fix. If you have
created your own DEFAULTMOD script,
then recheck it and verify that the FlowControl
command matches the modem configuration
(hardware or software). Refer to steps 3 and 4
of the DEFAULTMOD section of this

appendix for more details. If they match, it
may be a problem at your service provider.
Contact your Eudora technical support
representative for assistance in troubleshooting
this problem.

Mail can be retrieved via POP - Your telnet command probably ends with a
but cannot be sent via SMTP. cr/lf combination (“\r\n”). Remove the line

feed (“\n”) from the telnet command line.

Eudora times out after - There is probably an error in your
sending or receiving mail (it DEFAULTMID file and it may be waiting for
has never worked). the wrong system prompt. Verify that the

system prompt symbol in the “waitfor (system
prompt)” command matches your server
system prompt. Also verify that it matches the
last line of the navigation sequence in your
DEFAULTNAV file.

When sending mail, SMTP Edit the EUDORAINI file and add the line
complains that your HELO SMTPHELOString=(your fully qualified host
command is invalid and must name) in the [Dialup] section.
be a fully qualified host.

1 ?2 QUALCOMM Incorporated
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I Sympton I Corrective Action I

Eudora displays the following Serial overruns are usually caused by running
error when you try to check your modem at a speed greater then 9600 bps
mail: when you don't have a 16550 UART in your

PC. The regular UART (8250) only has a one
byte buffer. A serial overrun occurs when the
buffer is filled up and more bytes come in. The
16550 UART has a 16 byte buffer and should
never overrun. It is also strongly
recommended to get a serial driver other than
the one that comes with Windows. There are

several drivers on the internet which work

better at higher speeds. The Cybercom drivers
on ftpqualcommcom in the
quest/windows/utils directory work well. If
you do have a 165 50 UART then the problem
could be your Windows com driver.

“Serial Overrun on Rx”

Eudora displays the following This error indicates that flow control is not set
error when you try to check up correctly with your modem. Hardware
or send mail: flow control is recommended) and the

initialization strings sent to the modem in the
seria1.mod file should set it up for hardware
flow control. Also put the modem into reliable
mode, using LAPM or MNP4 error correction.
If you are going to use software flow control
(Xon/Xoff), then it is only reliable up to 9600
bps. Also, for speeds over 9600, make sure the
the modem/serial port has a 16550 UART.

“Serial Framing Error”
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Fine Tuning Dialup Eudora

Once you have successfully modified the default dialup files so that Eudora works
with your system, there are a couple of adjustments that can be made to fine tune
Eudora for the best possible dialup connection performance. These are as
follows:

I. Enable compression — Many modems allow for data to be compressed
while traveling over the phone line. Enabling data compression can
dramatically increase the speed at which large messages are transmitted
and received. Data compression is available in MNPS or V42 protocols.
To enable data compression, enter the appropriate command in the
DEFAULTMOD file. Typical Hayes commands which enable data
compression are %C1, %C3, and >“DCl. Check your modem reference
manual for the command that applies to your modem.

Delete the DEFAULT.END file — This file is required for systems that
need help in shutting down a modem. If you have DTR configured
correctly, then this file is not required. You will save approximately 5
seconds during shutdown if you delete this file.

EUDORAJNI [Dialup] Settings

The following settings can be entered into the [Dialup] section of the
EUDORAINI file (you will have to create this section if it does not exist). In
general, the default parameters are what you want, with the exception of
“BaudRate,” which you may want to increase to at least twice the expected line
speed to get the best performance out of your modem.

Note: The EUDORAJNI [Dialup] settings can be modified in the diaiup

1?4

files by entering the set commandfollowed by the setting value
(e.g, ”set CRLFProcessing:0 ”).

ATSendDelay The delay between sending characters in a modem AT
command (in milliseconds). The default is lOO.

BaudRate Values support in this field; 2400, 9600, 19200, 38400,
56000. The default is 9600.

BreakTime Length of modem break command (in milliseconds).
The default is 150.
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BusyRetries

ComPortName

CRLFProcessing

DataBits

DialupTimeout

EndScript

FlowControl

MiddleScript

ModemConfScript

Parity

SMTPHELOString

StartupScript

StopBits

TelnetCommand

QUALCOMM Incorporated
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The number of times that the phone will be redialed
after receiving a busy signal.

Sets port name “coml”, “comZ”, The default is
com2.

Enabled by default, setting this to zero will inhibit the
translation of \r\n to \r on output and \r\r to \r on input.

4 to 8 data bits. 8 bits is the default.

The default dialup timeout is 60 seconds. You may
change the default with this variable. You may change
the timeout during a script run with the “timeout”
command as well.

The name of the script file that closes the modem
connection.

Hardware or software. Hardware is the default.

The name of the script file that closes the telnet
connection.

The name of the script file that does the modem
configuration

None, mark, even, odd. None is the default.

String to send as the parameter of the SMTP HELD
command. This should only be set if your SMTP server
fails to recognize HELO.

The name of the file that does the dialup and
navigation.

1, 1.5, or 2. 1 is the default.

Telnet command used to contact network servers

(SMTP, POP, etc.). Eudora’s default telnet command
1s:

TelnetCommand = telnet {system} {port}\r\n

175
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What Does MAP! Do?

Eudora’s MAPI support allows users to quickly attach documents to e—mail
messages directly from the application that created the document. Without MAPI,
users must first save the document, remember what folder the document is in,

switch to Eudora, and then remember to manually attach the document to the
outgoing message.

MAPI streamlines this process dramatically. To e-mail the current, open
document from your word processor, select the Send command from your word
processor’s File menu. This automatically activates Eudora and attaches a
snapshot of the open document to a new composition message.

The MAPI system standardizes how messages are handled by client applications
so that each client application does not have to have custom code for each target
messaging application. MAPI accomplishes this by providing a standard
applicationprogram interface used by all MAPI-enabled client applications.

An additional MAPI feature supported by Microsoft Office applications is the
ability to add a “routing slip” to a Word, Excel, or PowerPoint document. This
routing slip contains a list of e-mail recipients obtained from the MAPI
subsystem. Once a document has an embedded routing slip, then it can be semi-
automatically routed as an attachment via e-mail to all recipients listed in the
routing slip. Once the routing is complete, the annotated document is returned
back to the original sender.

QUALCOMM Incorporated 1 77
MS 266948

THIS DOCUMENT IS CONFIDENTIAL AND FILED UNDER SEAL

AREND|315744



THIS DOCUMENT IS CONFIDENTIAL AND FILED UNDER SEAL 

Case 1:13-cv-00919-LPS   Document 312-1   Filed 03/10/21   Page 179 of 199 PageID #: 29792Case 1:13-cv-OO919-LPS Document 312-1 Filed 03/10/21 Page 179 of 199 PageID #: 29792

Appendix F — MAP! Technical Report Eudora User Manual

MAP! Overview

Let’s start with ap—icture:
 

 
 

 16-bit MAPI

client application

32-bit MAPI

client application

MAPIDLL MAPBZDLL

A MAPI client application is any 16-bit or 32—bit Windows application that
knows how to access the standard MAPI messaging functions in a library known
as a DLL (Dynamic Link Library). The functions in the MAPI DLL allow a
MAPI client application to transparently and generically access a MAPI service
provider. A MAPI service provider is the application that handles the receipt,
transmission, and storage of messages. Examples of MAPI client applications
(“front-ends”) include Microsoft Word and Microsoft Excel. Examples of MAPI
service providers (“back-ends”) include Microsoft Mail, Microsoft Exchange, and
Microsoft Fax.
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All l6—bit client applications use the 16-bit MAPIDLL and all 32-bit client
applications use the 32-bit MAPI32.DLL. The MAPI and MAPI32 DLLs are
“twins” which contain the same list of MAPI functions—they are parallel
implementations of the 16-bit and 32-bit MAPI functions. These DLLs are
provided by Microsoft as standard components of Windows for Workgroups,
Windows 95, and Windows NT. For non-networked Windows 3.x, the

MAPIDLL is available in add-on development kits or is included with MAPI-
enabled applications. The MAPI DLLs are normally installed in the Windows
SYSTEM directory (or SYSTEM32 for Windows NT).

As shown in the diagram on the previous page, when a MAPI client application
wishes to send a document, it simply loads the appropriate MAPI library (DLL)
and calls the defined MAPI functions. The MAPI DLL takes care of routing the
messaging and authentication requests to the appropriate MAPI service provider
application, displaying the address book user interface, and returning address
book and messaging data to the MAPI client application. The MAPI DLL also
provides an optional user interface for user authentication. For example, the user
may need to supply a user name and password to the mail system in order to “log
on” to the mail system. (The Eudora implementation of MAPI does not implement
authentication since Eudora itself requires authentication to access the POP3
server.)

Eudora implementation of MAPI

Eudora implements a subset of the full MAPI library by providing two
“replacement DLLs” for the standard Microsoft MAPI DLLs. The Eudora
EUMAPLDLL is a replacement for the 16-bit Microsoft MAPIDLL and the
Eudora EUMAPBZDLL is a replacement for the 32-bit Microsoft
MAPI32.DLL. The Eudora MAPI DLLs must be located in the same directory as
the Eudora program.

The Eudora MAPI DLLs implement the standard Simple MAPI functions detailed
in the MAPI specification. The MAPI specification also defines ExtendedMAP]
functions, however, the Eudora MAPI DLLs implement only the Simple MAPI
subset.

Note: The Eudora MIAPI implementation requires allMAPI client
applications to use only the Simple ll/[APIfunctions supported by
the Eudora MAPI DLLs.
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MAPI client applications which use only the basic Simple MAPI calls will
generally not be able to tell the difference between the Eudora MAPI DLL
functions and the Microsoft MAPI DLL functions.

It is important to understand that MAPI client applications load the MAPI DLL
libraries at runtime whenever they need to access the MAPI functions. Each
client application expects to find either the 16-bit MAPIDLL file or the 32-bit
MAPBZDLL file in a common, application-independent location (generally the
Windows SYSTEM directory). Therefore, it is not sufficient to copy the
EUMAPIDLL and EUTVIAPBZDLL Eudora DLL files into the Windows

SYSTEM directory alongside the standard Microsoft MAPIDLL and
MAPBZDLL files. For client applications to find the Eudora MAPI DLLs, the
DLL files must be named MAPIDLL and MAPI32DLL. This creates a conflict

since most Windows installations will have the MAPIDLL and MAPBZDLL

files preinstalled in the Windows SYSTEM directory to support Microsoft Mail
(Windows for Workgroups) or Microsoft Exchange (Windows 95, Windows NT).

Note: Eudora is able to swap the Eudora EWPIandEWAPI32
DLLs with the ll/[icrosoft MAP] andAMPBZ DLLs when the user
launches Eudora, and is able to unswap the Eudora MP1 DLLS
when the user exits Eudora.

 

This approach gives the user the most flexibility and preserves the user’s ability to
use Microsoft Mail and/or Microsoft Exchange when Eudora is not running. If
we “permanently” install the Eudora MAPI DLLs over the existing Microsoft
MAPT DLLs, then applications (such as the Microsoft Fax service bundled with
Microsoft Exchange) which rely on the Microsoft MAPI DLLs will no longer
work. This is clearly unacceptable for users who need to use MAPI for both
Microsoft Exchange and Eudora.
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Eudora MAP! Startup Procedure

When launched, Eudora runs the following “swap” procedure when the user has
selected either the “Always” or the “When Eudora is running” MAPI Server
option in Eudora (see Tools / Options / MAPI):

1. Check to see whether or not the Eudora MAPI DLLs are already installed in
the Windows SYSTEM directory. If so, then finish.

Check for existing Microsoft MAPIDLL and MAPI32.DLL files. If found,
rename MAPIDLL to MAPIOOO and rename MAPI32.DLL to MAPIBZOOO.

(If a MAPTOOO file already exists, then Eudora uses MAPIDOI, MAPLOO2
etc.)

Copy the EUMAPIDLL and EUMAPI32.DLL files from the Eudora program
directory to the Windows SYSTEM directory as MAPIDLL and
MAPIBZDLL, respectively.

Eudora MAP! Shutdown Procedure

When shutdown, Eudora runs the following “unswap” procedure when the user
selects either the “When Eudora is running” or “Never” MAPI Server option in
Eudora (see Tools I Options / MAPI):

1. Check to see whether or not the Eudora MAPI DLLs are already installed in
the Windows SYSTEM directory. If not, then finish.

Delete the Eudora MAPIDLL and MAPI32.DLL files.

Rename the MAPIOOO and MAPI32.000 files, if any, to MAPIDLL and
MAPISZDLL, respectively. (If a MAPI.001, MAPLOOZ etc file exists, then
Eudora renames the one with the highest number.)
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Eudora DLL Swapping Restrictions

It is important to note that there are several restrictions with the above Eudora
swap and unswap procedures: The Eudora swap and unswap procedures can only
run successfully if the MAPIDLL and MAPI32DLL are not currently “in use” by
one or more MAPI client applications.

When a MAPI client application loads a MAPI or MAPI32 DLL file, Windows
“locks” the DLL file while the library is loaded into memory to show that the file
is “in use.” Eudora can normally detect that the MAPIDLL and/or MAPBZDLL
files are “in use.” If Eudora detects that a MAPI or MAPBZ DLL is locked, it

displays an error message and skips the swap or unswap procedure.

When Eudora is forced to skip the swap or unswap procedure, this means that the
MAPI DLLs are in the wrong “state” with respect to Eudora —— that is, l) the
Microsoft MAPI DLLs could be installed even after Eudora starts, or 2) the
Eudora MAPI DLLs could be installed even after Eudora shuts down. To prevent
this from happening, use the following procedure when using Eudora MAPI:

1. Start Windows.

2. Start Eudora.

3. Start any MAPI client applications.

4. Send attachments to Eudora via the installed Eudora MAPI interface.

5 Shutdown a_ll MAPI client applications.

6. Shutdown Eudora.

7. Exit Windows.

Once Eudora’ s MAPI DLLs get into the wrong “state” with respect to Eudora,
you cannot correct the state mismatch until a_ll MAPI client applications unload
the MAPI DLLs and Windows is able to unlock the DLL file. Since the MAPI

DLLs are shared by multiple MAPI client applications, Windows does not unlock
the MAPI DLL file until the last MAPI client application is shut down.
Therefore, to force all MAPI client applications to unload the DLLs, you must
shutdown all MAPI client applications.
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Important:When running 16-bit MAPI client applications under Windows 3.l or
Windows NT, then Eudora cannot detect the lock placed on the MAPI DLLs by
Windows unless the SHARE program is running. This means that Eudora can
inadvertently perform the DLL swap and/or unswap procedures while the MAPI
DLL is loaded into memory. This almost always causes Windows to become
unstable and can lead to crashes in MAPI client applications as well as in
Windows itself,

Note: lfyou run 16-bit MAP] client applications under Windows 3.1 or
Windows NT, then you should always run the SHAREprogram.

The good news is that Windows for Workgroups and Windows 95 implement the
SHARE functionality without requiring you to explicitly run the SHARE
program. By default, Windows NT only implements the SHARE functionality for
32-bit applications. If you are running a 16-bit application under Windows NT,
then you must run the SHARE program explicitly as you do under Windows 3.1.
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Symbols

-, in the Status column 60
-, in the Status column 38, 41, 46, 60

???@??? 61

A

Add As Recipient command 9O
Add/Modify button in Personalities 114
Address Book

<< and >> buttons 84

adding nicknames to the Quick Recipient List
86

Address(es) field in 85

addressing a message from 87
changing entries in 86
copying entries in 86
creating a message from 87
creating new entries in 84, 85
deleting entries in 86
displaying entries in 84
Fax field in 85
file format 89

Make Address Book Entry command from 87
maximum entries in 85

moving entries in 86
Name field in 85

New button in 84, 85

paging up and down in 84
Phone field in 85
Postal Address field in 85

Recipient List option 86
removing entries from 86
resizing 84
saving changes to 86
Using central Address Book files on a server
89

View By option 84
Address Book command 83

Address(es) tab 85

QUALCOMM Incorporated

Index

Advanced Network options 130
After sending message option 113
Alerts, timing out 13 5
Align Center button 22
Align Left button 21
Align Right button 22
Allow Drag and Drop Transfers option 135
Alt+arrow keys option 134
and option 74
Any Header field 73
Any Recipient field 73
APOP option 108
appears option 74
Arrow keys 134

Composition windows and 134
Attach Directory 48, 69
Attach File [to New Message] 139
Attach File [to New] command 31

Attachment Directory option 112
Attachment Type popup 20
Attachments

attaching files to outgoing mail 31
Attachment Directory 112
automatically deleting 69
changing the Attachment Directorylf you do
not want to use the default Attach Directory to
receive your attachments, select Options...
from the Tools menu and select the

Attachments Options. Then click on the large
button beneath .i.Attachm 48

Delete attachments when emptying Trash
option 113
delete automatic attachments after sending
message 1 13

delete automatic attachments when message
emptied from Trash 113
detaching from a message 31
dragging to attach 31
encoding 32
Encoding Method option 112
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never delete automatic attachments 113

opening 48
Put attachments in body of message option 112
receiving 48

Attachments column 61
Attachments field

in a forwarded message 57
in outgoing mail 24, 31
in redirected messages 57

Attachments Options 112
Attachment Directory option 112
Delete attachments when emptying Trash
option 69, 1 13
delete automatic attachments after sending
message 1 13
delete automatic attachments when message
emptied from Trash 113
Encoding Method option 112
never delete automatic attachments 113

Put attachments in body of message option 112
Authentication option 108
Automatically dial & hangup this connection
option 131
Automatically Expand Nicknames option 89, 90,
135

Automatically Fcc to original mailbox option 111
Automatically open next message option 135

B

Baud rate field 128
Bcc button

in Directory Services 92
in the Address Book 87

Bcc field

in outgoing mail 23
to copy outgoing messages 42

Bigger button 22
BinHex encoding 32
BLAH,BLAH,BLAH button 47
blank, in the Status column 60

Blind copy
with Bcc field 23
with Name field in Address Book 85

Body field 73
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Bold button 21
Bounced mail 58
Broken lines 31

C

Cache network info option 131
Carriage returns inserted 31
Cc button

in Directory Services 92
in the Address Book 87

Cc field
in Filters 73

in outgoing mail 23
Change Password command 141
Change Password submenu 45
Change Queueing command 40, 41
Change Queueing dialog 39, 40
Check for mail every ? minutes option 43, 106
Check mail 50

automatically 43, 106
Check Mail command 44

Delete from server option 107
Delete server action 51

entering password 44
Fetch & Delete server action 51
Fetch button 51
Fetch server action 51

Forget Password command 45
Leave mail on server option 50, 107
manually check 44
minimum interval 43

Save password option 45
Skip messages over ‘3 K in size option 51
Skip messages over ‘3 K option 106
stopping 44
Trash button 5 1

with special instructions 52
Check Mail command 43, 44, 45, 136
Check Mail from the File menu. The .i.Mail

Transfer Options dialog 52
Check spelling 33
Check Spelling command 137
Checking Mail Options 50, 106

Authentication option 108
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Check for mail every ? minutes option 106
Delete from server option 107
Delete from server when emptied from trash
option 53, 108
Leave mail on server option 50, 107
POP account option 106
Save password option 45, 107
Send on check option 107
Skip messages over ? K in size option 51
Skip messages over ? K option 106

Checking Spelling 33
Check Spelling command 34
Check Spelling dialog 34

Add button 36

Change all button 35
Change button 35
Change To field 35
Dictionary button 36
Ignore all button 35
Ignore button 35
Suggest button 35
Suggestions field 35
Unknown field 35

Edit User Dictionary dialog 36
Add button 36
Clear button 36
Delete button 36

Preferences dialog 37
Always suggest 37
Ignore capitalized words 37
Ignore words with mixed case 37
Ignore words with numbers 37
Report doubled words 37

Clear button 22

Clear command 31, 137
Close command 136

Close messages with mailbox option 135
columns 101

COM port field 128
Compact

all mailboxes 63
one mailbox 63

Compact Mailboxes command 63
Composition Window 19
Connection method option 17, 103
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contains option 74
Copy & Unwrap command 31
Copy blind

with Bcc field 23
with Name field in Address Book 85

Copy command 137
Copy original’s priority to reply option 29, 56, 111
Copy To action 76
Copying a message to a mailbox 23, 70
Ctrl+arrow keys option 134
Cut command 137

D

D, in the Status column 58, 60
Data bits field 128
Date column 61

Decoding attachments 32
Default signature option 110
Default stationery option 110
Delete all messages on server (be sure) option 53
Delete all messages that have been retrieved option
53

Delete attachments when emptying Trash option
69, 113

Delete Automatic attachments option 113
Delete button in Personalities 114
Delete command 69

Delete from server option 107
Delete from server when emptied from trash option
53, 108

Delete messages marked for deletion option 52
Delete queued mail option 125
Delete server action 51, 62, 76

Delete unread mail option 125
Delete unsent mail option 125
Detaching attachment 31
Determine first unread message by option 107
Dialup Eudora 159

Dialup Connection Requirements 160
Dialup Files 160

Command Lines 166

Character Sequences 167
Commands 166
Delimiters 168

187

MS 266958

THIS DOCUMENT IS CONFIDENTIAL AND FILED UNDER SEAL

AREND|315754



THIS DOCUMENT IS CONFIDENTIAL AND FILED UNDER SEAL 

Case 1:13-cv-00919-LPS   Document 312-1   Filed 03/10/21   Page 189 of 199 PageID #: 29802Case 1:13-cv-00919-LPS Document 312-1

Index

Special Characters 168
Variables 168

Creating Your Own 161
DEFAULTEND file 166
DEFAULTIVIID file 165
DEFAULT.MOD file 162
DEFAULTNAV file 164
Telnet Command 164

Sequence 161
Telnet Command 164

Echo Canceling 169
EUDORAINI Settings 174
Fine Tuning 174
PC/Modern Requirements 159
Troubleshooting 130

Trace Window 170

Dialup options 127
Dialup timeout after ? seconds option 128
Dialup usemame field 127
Dialup usemarne option 104
Directory Services

addressing a message from 92
Bcc button 92
Cc button 92

finding Ph servers 92
Finger button 91
Finger option 105
Finger queries 92
Keep on Top option 92
Ph button 91
Ph commands 91

Ph option 105
To button 92

Directory Services command 91
Discard styles before sending messages option 118
Docking View 67
doesn’t appear option '54
doesn’t contain option 3’4
Domain to add to unqualified names option 109
Don’t Send option 41
Don’t transfer, just create mailbox option 71
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E

Edit

incoming mail 49
outgoing mail 30

Edit menu 13?

Empty the Trash mailbox option 126
Empty Trash command 69, 141
Empty Trash on Quit option 17
Empty Trash when exiting option 69, 135
EMSAPI 95

Encoding Method option 112
Encoding methods

BinHex 32
MIME 32

Uuencode 32

ends with option 74
Enter key 46
Enter Selection command 80

ER Maildrop lock busy 100
Error getting a network socket 100
Eudora Information 147
Exit command 136

Expand Nicknames option 87
Extended Messaging Services 95
Extended Messaging Services Application
Programrning Interface 95
Extra Warnings Options 39> 125

Delete queued mail option 125
Delete unread mail option 125
Delete unsent mail option 125
Empty the Trash mailbox option 126
Queue a message bigger than ? k option 126
Queue a message with no subject option 125
Queue a message with styled text option 125
Quit with messages queued to be sent option
126

Set a changed message back to read-only
option 126
Start Eudora and it’s not the default mailer

option 126
Try to delete any unsent mail option 69
Try to delete queued mail option 69
Try to delete unread mail option 69
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F

F, in the Status column 57, 60
Fax field 85

Fcc menu 23, 42

Fetch & Delete server action 51, 62
Fetch button 47, 51
Fetch server action 51, 62, 76
File menu 136

Filter Messages command 72, 141
Filters 75, 76, 77

and option 74
appears option 74
automatically named 72
Conjunction field 74
contains option 74
does’t appear option 74
doesn’t contain option 74
ends with option 74
header field 73

ignore option 74
Incoming option 72
intersects nickname option 74
invoked from top to bottom 73
is not option 74
is option 74
Manual option 72
Match Type field 74
Matching Text field 74
or option 74
Outgoing option 72
re-ordering 73
starts with option 74
unless option 75

Filters command 72
Filters window 72
Find 78

Match Case option 79
Multiple messages 79
Next button 79
Next Mailbox button 79

Next Message button 79
Stopping 80
Summaries Only option 79
Within a message 78
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Find button 78
Find submenu 137

Finger button 91, 92
Finger option 105
Finish Address Book Entry command 89
Flow control field 128
Font button 21

Font options
For printing 1 16
For screen 116

Fonts & Display Options 116
Forget Password command 45
Formatting text

text/enriched MIME 30

Forward command 57, 139
Forward To action 76

Forward To submenu 90, 139

Forwarded (F) status 57
From field

in a forwarded message 57
in Filters 73

in outgoing mail 23
in redirected message 57

ftpqualcommcom 147

G

Generate Filter Report option 124
Getting Attention Options 124

Generate Filter Report 124
Open mailbox option 46, 124
Play a sound option 46, 124
Use an alert option 46, 124

Getting Started Options 16, 102
Connection method option 17
POP account 16, 43, 103

Real name option 16, 103
Guess Paragraphs option 81

H

Hang Indent In button 22
Hang Indent Out button 22
Help

Menu 143

Index
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Help with Eudora 17 K
Hide 67 . . . ,

Hide the recipient list Keep copies of outgorng mail option 42
Keep copies option 110with Bcc field 23 _

with Name field in Address Book 85 E661) Cog-V bu“?! 215242
Hosts Options 91, 105 eep on OP 0p 1011

Finger option 105 E63305 0132011 108
Ph option 105 e eros op ons
POP account option 105 Keiberos POP3 port field 133
SMTP option 105 Realm field 133
; ~ . ~ Selvice format field 133

15130“ should checking/sending be performed oonn Selvice name field 133
L

Label column 61
Labels 75

Labels Options 122
Basic Colors 123
Custom Colors 123

Leave mail on server option 50, 107
Leave server action 62
Line breaks 31

lmostmp to lmos.dat 100

ignore option 74
Ignoring previously read messages 50
Immediate send option 39, 40, 109
In command 138, 140
In mailbox 46

Include Headers option 81
Include outdated Return-Receipt—To option 135
Include yourself option 56
Incoming message window

Message body 47
Title bar 47 M

Toolbar 47 Mail folders

BLAH,BLAH,BLAH button 47 creating during transfer 71
Fetch button 47 creating in the 16-bit Mailboxes window 66
Pencil button 47 New button 66

Priority popup 47 creating in the 32-bit Mailboxes window 68
Subject field 47 New command 68

Tow Truck icon 47 creating using Mailbox menu 64
Trash button 47 Make if a folder option 64

Incoming option 72 moving in the 16-bit Mailboxes window
Indent In button 22 Move buttons 66

Indent Out button 22 New command 64

IHSCIT RECIPICH’L command 90, 137 relnoving
Installation 13 Remove button 66

Intercept N915931183 mailto URLs option 135 removing in the 16-bit Mailboxes window 66
intersects nickname option 7'4 removing in the 32-bit Mailboxes window 68
1s option 74 renaming in 16-bit Mailboxes window
Italics button 21 Rename button 66

renaming in 32-bit Mailboxes window 68
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Mail Storage 144
Mailboxes 144

Contents 144

Mail Transfer Options dialog 42, 50, 62
Delete all messages on server 53
Delete all messages that have been retrieved
53

Delete messages marked for deletion 52
Fetch all message headers to In mailbox 53
How should checking/sending be performed
53

Retreive messages marked for retrieval option
52

Retrieve messages marked for retrieval 53
Retrieve new mail 52

Send queued messages 52
Mailbox Columns Options 62, 121

Show columns options 121
Mailbox menu 138
Mailboxes

Close messages with mailbox option 135
compacting all 63
compacting one 63
creating during transfer 71
creating in the 16-bit Mailboxes window 66

New button 66

creating in the 32-bit Mailboxes window 68
New command 68

creating using Mailbox menu 64
displaying columns 62
Make it a folder option 64
message summaries 59
moving in the 16-bit Mailboxes window 66

Move buttons 66

moving in the 32-bit Mailboxes window 68
New command 64

number of messages 63
opening 59
opening from the Mailboxes window 65
removing in the 16-bit Mailboxes window 66

Remove button 66

removing in the 32-bit Mailboxes window 68
renaming in the 16-bit Mailboxes window 66

Rename button 66

renaming in the 32-bit Mailboxes window 68
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resizing columns 62
Show columns options 121
size display 63
sorting messages in 77
space messages require 63
space wasted 63
transferring messages among 70

Mailboxes command 65
Mailboxes window

16-bit 65
32-bit 67

Mailing lists
creating a nickname 84
hiding the recipient list 85
with multiple recipients 85

Main Toolbar 93

Make Address Book entry command 87, 88, 89,
14 1

from a mailbox 88

from Directory Services 89
from the Address Book 87

Make it a file option 84, 85
Make it a Folder option 64, 66, 68
Make Label action 75

Make Priority action 75
Make Status action 75

Make Subject action 75
Managing mail on the server

Delete from server option 107
Delete from server when emptied from trash
option 53, 108
Delete server action 51, 62
Fetch & Delete server action 51, 62
Fetch button 51

Fetch server action 51, 62

Leave mail on server option 50, 107
Leave server action 62

Mail Transfer Options dialog 52
Skip messages over ? K in size option 51
Skip messages over ? K option 106
Trash button 5 1

Manual option 72
Map Ctrl+R to “Reply to All” option 111
MAPI 96
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MAPI options
After sending messages, delete MAPI
attachments field 132

Always use MAPI server field 132
Never delete MAPI attachments field 132
Never use server field 132

When Eudora is running, use MAPI server
field 132

When messages are emptied from trash, delete
MAPI attachments field 132

Match Case option 79
May use Quoted-Printable option 110
Message

Deleting
Unread/Queued 135

Incoming
Zooming Windows 117

Outgoing
Zooming Window 117

Message body
in incoming mail 47
in outgoing mail 24

Message header
in incoming mail 47
in outgoing mail 23

Message menu 139

Message Options dialog 24
Message Plugins Settings 96
Message Plugins Settings command 141
Message Plugins submenu 137
Message suimnaries 59

Attachments column 61

changing the subject of 49
Date column 61
Label column 61

Priority column 61
resizing columns 62
selecting 6O
Sender/Recipient column 61
Server Action column 62
Size column 61
Status column 60

Subject column 62
Message Window Height setting 117
Message Window Width setting 116, 117
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MIME 153

Base64 encoding 153
Content-type header 154
Macintosh creators 155

Macintosh types 155
Mapping 155
Quoted-printable encoding 153
Types 155

MIME encoding 32
Miscellaneous Options 134

Allow Drag and Drop Transfers option 135
Close messages with mailbox option 135
Empty Trash on Quit 69
Empty Trash when exiting option 135
Include outdated Retum-Receipt-To option
1 3 5

Intercept Netscape mailto URLs option 135
Turbo redirect by default 58
Turbo redirect by default option 135

Modem selection 128
Move buttons 66

Multiple accounts in Eudora 24
Multiple PCs

checking mail from 50
Multiple recipients

creating a mailing list 84
hiding the recipient list 85

Multipurpose Internet Mail Extensions 153

N

\ame field 85

\eed RCPT (Recipient) 100
\etwork buffer size of ? bytes option 131
\etwork Open timeout after ? seconds option 130
\etwork timeout after ? seconds option 130
\ever option 113
\ew button in Address Book 84, 85
\ew button in Filters 72
\ew button in Personalities 114

\ew command 64, 71, 138, 140

\ew mailbox dialog 64, 71
\ew Message command 19, 139
\ew Message To submenu 90, 139
\ew Message With submenu 139
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New Text File command 136
Next button 79
Next command 79
Next Mailbox button 79
Next Mailbox command 79

Next Message button 79
Next Message command 79
Next message, going to 134
Next time queued messages are sent option 41
Nicknames 85

adding to the Quick Recipient List 86
Automatically expand nicknames option 135
creating in the Address Book 84, 85

None action 75

not option 74
Notification

Generate Filter Report option 124
Open mailbox option 124
Play a sound option 124
Use an alert option 124

Notify Application action 76
Notify User action 76

0

On or After option 41
Online Help 17
Open action 75
Open Attachment command 136
Open Eudora 15
Open mailbox option 46, 124
Open Text file command 136
Options

Advanced Network 130

Dialup 127
Kerberos 133
MAPI 132

Personalities 114

Spell Checking 119
Always suggest 119
Check when message queue/send selected
120

Ignore capitalized words 119
Ignore original text 120
Ignore words with mixed case 119
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Ignore words with numbers 119
Report doubled words 119
Report words with mixed case 119
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Warn me when I queue/send a message
120

Styled Text 118
Options command 102
or option 74
or Queue For Delivery command 139
Out command 138, 140
Out mailbox 41, 70

Outgoing message window
Message body 24
Message header 23

Attachments field 24
Bcc field 23
Cc field 23
From field 23

Subject field 23
To field 23

Title Bar 20
Toolbar 20

Align Center button 22
Align Left button 21
Align Right button 22
Attachment Type popup 20
Bigger button 22
Bold button 21
Clear button 22
Font button 21

Hang Indent In button 22
Hang Indent Out button 22
Indent In button 22
Indent Out button 22
Italics button 21

Keep Copy button 21
Priority popup 20
Queue button 21
Quoted-Printable button 20

Return Receipt button 21
Send button 21

Signature popup 20
Smaller button 22
Text As Document button 20
Underline button 21
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Word Wrap button 20
Outgoing option 72

p

Parity field 128
Password

changing 45
server source code for 147

check when sending mail 101
entering 44
forgetting 45
remembering 45
Saving 45, 107

Passwords option 108
Paste as Quotation command 137
Paste command 137
Pencil button 47

Personal Info Options 104
Personal Information Options

Dialup username option 104
POP account option 104
Real name option 104
Return address option 104

Personalities Options 24
Ph

button 91
command 91

option 105
server source code 147

Ph button 91
Phone field 85
Phone number field 127

Play a sound option 46, 124
Play Sound action 75
Plugins 95
POP 15

POP account option 16, 103, 104, 105, 106
POP server 43, 50, 147, 151

UNIX 147

VAX/VMS 147
VM/CMS 147

POP version 3 151

Popper 147
Post Office Protocol 15
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Postal Address field 85
Print action 75

Print command 95, 136
Print Preview corrnnand 136

Print Setup command 136
Print... command

Font options 116
printing with strange line breaks 101
Priority column 61
Priority Popup

default for replies 29
in incoming mail 47
in outgoing mail 20
levels 29

Put it on the recipient list option 85
Put original To recipients in Cc field option 56
Put text attachments in body of message option 112

Q

Q, in the Status column 40, 41, 60

Queue a message bigger than ? k option 126
Queue a message with no subject option 125
Queue a message with styled text option 125
Queue button 21, 40
Queue mail 39

Change Queueing command 40, 41
Change Queueing dialog 40
Don’t Send option 41
editing before sending 41
for a certain time 40

Immediate send option 39
Next time queued messages are sent option 41
On or after option 41
Queue button 40

Queue Message command 40
Right Now option 41
Send message Right Now option 40
Send Queued Messages command 40
sending queued mail when checking mail 41
taking mail out of the queue 41

Queue Message command 40
Queued (Q) status 40

Quick Recipient List
Adding email address to 90
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Forward To submenu 90

Insert & Expand Recipient command 90
Insert Recipient command 90
New Message To submenu 90
putting nicknames in 86
Recipient List option 90
Redirect To submenu 90

Quit command 17

Empty Trash when exiting option 135
Quit with messages queued to be sent option 126
Quoted text

in replies 55
with styles in replies 55

Quoted-printable
Turning off 155

Quoted-Printable button 20

R

R, in the Status column 55, 60

Real name option 16, 103, 104
Recipient List option 86, 90
Redirect

automatically put new message in the queue 58
Redirect command 57

Turbo redirect by default option 58, 135
Redirect command 57, 139
Redirect To action 76
Redirect To submenu 90

Redirected (D)redirectedus 58

Registration 18
Rejected mail 58
Remove All button 66
Remove button 66
Remove It button 66
Rename button 66

Renaming a mail folder 66, 68
Renaming a mailbox 66, 68
Replied (R) status 55
Reply

Copy original’s priority to reply option 56
in a filter with stationery 27
map Ctrl-R to Reply to All 56
Put original To recipients in Cc field option 56
quoting original text 55
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Reply command 55
with stationery 27, 56

Reply command 55, 139
Reply To All command 56, 139
Reply With action 76
Reply With submenu 139
Reply-To field 73
Replylnclude yourself option 56
Replying

Copy original’s priority to reply option 111
Map Ctrl+R to “Reply to All” option 111
When replying to all option 111

Replying Options 111
Copy original’s priority to reply 29, 56, 111
Include yourself 56
Map Ctrl+R to “Reply to All” option 111
Put original To recipients in Cc field 56
When replying to all option 111

Require confirmation for delete option 135
Requirements 13
Retrieve new mail option 52
Retrieve only message headers 53
Return address option 104, 109
Return key 46
Return Receipt button 21, 30
RFCs 152

Right Now option 41

S

S, in the Status column 42, 60
Save As command 80, 136
Save command 38, 86, 136
Save mail as text

as a single file 81
Guess Paragraphs option 81
Include Headers option 81
Stationery option 81

Save password option 45, 107, 131
Saved (-) status 38, 41

Say OK to alerts after ‘? seconds option 135
Select All command 137

Send Again command 58, 139
Send button 21, 39

Send Immediately command 39
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Send mail
all at once 39
at a certain time 40

Change Queueing dialog 39
Default signature option 110
Default stationery option 110
Immediate send option 39, 40, 109
keeping copies 110
keeping copies of outgoing mail in original
mailbox 1 1 1

Mail Transfer Options dialog 42
May use Quoted-Printable option 110
replies 55
Send button 39

Send Immediately command 39
Send message Right Now option 40
Send on check option 107, 110
Send Queued Messages command 40, 42
sending queued mail when checking mail 41
Tabs in body of message option 110
with a password 101
with server instructions 42

Send message Right Now option 40
Send on check option 41, 107, 110
Send Queued Messages command 40, 42, 136
Send queued messages option 52
Sender/Recipient column 61
Sending Mail Options 109
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Automatically expand nicknames option 135
Automatically Fcc to original mailbox option
1 1 1

Default signature option 110
Default stationery option 110
Domain to add to unqualified names option
109

Immediate send 39

Immediate send option 109
Keep copies of outgoing mail 42
Keep copies option 110
May use Quoted-Printable option 110
Return address option 109
Send on check 41

Send on check option 110
SMTP server option 109
Tabs in body of message option 110
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Word wrap option 110
Sent (S) status 42
Server Action column 62

Server action popup 51
Server button 92

Server Options action 76
Service provider selection 128
Set a changed message back to read-only option
126

Sharing a PC 97
Show category icons option 117
Show columns options 121
Show status bar option 117
Show toolbar option 117
Show toolbar tips option 117
Show trace window option 128
Signature command 27, 28
Signature popup 20
Signatures

creating an additional 28
creating or modifying the standard 27
including in a message 28
including in all messages 28
modifying an additional 28
removing an additional 28

Simple Mail Transfer Protocol 15, 151
Size column 61

Skip messages over ? K in size option 51
Skip messages over ? K option 106
Skip Rest action 77
Smaller button 22

SMTP 15, 151, 152, 153

SMTP server option 109
Sort submenu 77, 137

Sorting 77
Sorting in descending order 77
Space bar 46
Special menu 141
Spell Checking (see Checking Spelling) 33
Spell Checking options 119
Start Eudora and it’s not the default mailer option
126

starts with option 74
Stationery messages

changing 26
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creating a default 27
opening 27
opening with a filter 27, 76
removing 26

Stationery option 26
Status

-, never sent 60

<blank>, read or unsendable 60
D, redirected 58, 60
F, forwarded 57, 60

Q, queued 40, 41, 60
R, replied 60
R, replied to 55
S, sent 42, 60
T, timed 41, 60
-, saved or unread 38, 41, 46, 60

Status column 60

Stop bits field 128
Styled Text options 118
Subject column 62
Subject field

changing in message summaries 49
in Filters 73

in incoming mail 47
in outgoing mail 23

Summaries Only option 79
Switch messages with options 134

T

T, in the status column 41, 60
Tabs

and the Save As command 81

Switching fields with 21
Tabs in Body button 21
Tabs in body of message option 110
Technical support 18

More Help! topic 18
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